
Simplicity
Accuracy

Productivity

Aadva Lab Scanner
with the Unique Intuitive 

Scanflows, Hybrid Scan 
and Smart Occlusion

Software Manual

Software V1.2 - Date of issue January 2022



2

Dear customer,

Thank you for choosing a product from GC!

If you require additional information or if you have any questions about the device, 

please contact your GC local office.

We wish you much joy with your Aadva ALS 2 scanner!

Your Aadva team

Legal notice

FIRST LEVEL SUPPORT FOR GC PRODUCTS

Find a reseller online in your region: 
List of resellers https://www.smartoptics.de/en/dental/reseller-locator/
or via the contact form https://www.smartoptics.de/en/contact/

CHANGES AND SERVICE

GC reserves the right to make changes in the products and this documentation.
Current documentation: www.smartoptics.de (download sections)

BRANDS AND TRADEMARKS

Adesso Split, Artist/arTO - K. Baumann, DE-75210 Keltern
Artex - Amann Girrbach AG, AT-6842 Koblach
Baltic Denture System - Merz Dental GmbH, DE-24321 Lütjenburg
Denar - Whip Mix Corporation, Louisville, KY 40209, USA
exocad - exocad GmbH, DE-64293 Darmstadt
FlyCapture, UpdatorGUI - Point Grey Research, Inc.
Gamma - Gamma medizinisch-wissenschaftliche Fortbildungs-GmbH, A 3400 Klosterneuburg
Twin Tray - Klasse 4 Dental GmbH, DE-86159 Augsburg, DE
OnyxCeph3™ - Image Instruments GmbH, DE-09125 Chemnitz
PROTAR - KaVo Dental GmbH, DE-88400 Biberach/Riß
SAM - SAM Präzisionstechnik GmbH, DE-82131 Gauting
SILADENT, SilaPart®  - SILADENT Dr. Böhme & Schöps GmbH, DE-38644 Goslar
Triple Tray - Premier Dental, Plymouth Meeting, PA 19462, US
Windows, .NET Framework, Visual C++ - Microsoft Corporation

Royalty-free icons and illustrations from the Flaticon.com, Fotolia.com, Freepik.com and Pixabay.com image agencies 
were used in this Operating Manual.
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1.	 About
Please read through this operating manual carefully.
GC accepts no liability for damages due to failure to comply with the operating manual.

Introduction
ALS 2 combines unique scan features with robust scanning hardware that will simplify your daily lab work.

ADVANTAGES

	 Constant & reliable accuracy
	 Full color scanning
	 Speed and quality
	 HD 5 Mpx camera
	 Full exocadR integration
	 Open files (STL and PLY)
	 Complete jaw scanned in 22 s
	 Touchscreen
	 4 μ accuracy according to ISO 12836

TECHNICAL DATA

	 Measurement field (X × Y × Z) 85,2 × 58,1 × 82 mm
	 5 Mpx Camera
	 Blue light LED sensor technology
	 Stripe light triangulation
	 Monochrome texture scan
	 Color texture scan
	 Fully automated Z-axis
	 Articulator scan
	 Multi die scan
	 Triple TrayR scan
	 Impression scan
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Twin Tray scanIllustrations

The device and software images may differ from the actual systems. Screenshots show sample data.

Units of measurement and numbers

Units of measurement	 Units legally in force in Germany
	 International System of Units (SI)
Numbers	 Decimal system with decimal places

Measurement Unit Abbreviation
Mass/weight Kilogram kg

Gram g
Length Meter m

Centimeter cm
Millimeter mm
Micrometer µ

Angle Degree °
Time Hour h

Minute m
Second s

Electrical power Watt W
Electrical voltage Volt V

Alternating current AC
Electrical frequency Hertz Hz

Gigahertz Ghz
Electrical current Ampere A
Protection class International Protection IP

1st digit: solids protection;
2nd digit: fluids protection

Temperature Degree Celsius °
Memory (PC) Random-Access Memory RAM
Data volume Megabyte MB

Gigabyte GB
CAD data format Polygon file format PLY

Standard Triangulation Language STL
American Standard Code for Information Interchange ASCII
Mesh MSH
Point Cloud Measurement PCM

Picture element Pixel Px (monitor)
dpi (print)

Megapixel Mpx
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1.	 About Aadva Scan
Aadva Scan is a software for GC 3D Aadva Scanners.
Aadva Scan scans jaw models and impressions according to dental specifications, orthodontic models and multiCase 
projects. Objects in the size of the scanner measuring field can be scanned by Aadva Scan in the universal mode, 
which is industry independent.

CURRENT VERSION AND MANUALS

www.smartoptics.de
The following can upgrade to Version 3.4:

	 Vinyl series (Vinyl Open Air, Vinyl, Vinyl High Resolution),
	 scanBox

CALIBRATION DATA

Calibration data are a prerequisite: 
	 to start Aadva Scan; 
	 to obtain correctly calculated measurements. 

Every scanner requires individually adjusted calibration data.
	 The calibration data are not transferable to a different scanner. 
	 The installation of Aadva Scan also includes the calibration data.

System requirements

ALS 2 Windows 10/11 (64 Bit) i7 with 6 × 4.7 GHz 32 GB Approx. 100 – 250 GB SSD 6 GB USB 3.0

Vinyl UXD Windows 10 (64 Bit)
i5 mit 4 × 3,8 GHz
i7 mit 6 × 4,7 GHz

32 GB
ca.   40 – 100 GB HDD
ca. 100 – 250 GB SSD

6 GB USB 3.0

Interfaces
You can link Aadva Scan to exocad® DentalCAD and OnyxCeph3™. All interfaces are available at no additional cost 
for all scanners.

The PC must comply with the system requirements of the third party systems. In case of different specifications, the 
highest requirements apply.

System requirements

exocad® DentalCAD (dental CAD-System)*
wiki.exocad.com
“Introduction”

OnyxCeph3™ (prosthetics software)
www.onyxceph.de
“> Home | OnyxCeph3TM |About | System Requirements”

Baltic Denture System® 
www.baltic-denture-system.de
Dental Lab > Requirements 

*	 GC is a reseller of exocad GmbH. If you are interested in exocad® DentalCAD please contact your GC reseller.

dental Scan Software
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2.	 Basic operation

2.1. User interface
Program window division

dental Scan Software

Version: 3.4 10-2021 Error! Use the Home tab to apply Überschrift 1 to the text that you want to appear here.9 

OnyxCeph3™ (prosthetics software) 
www.onyxceph.de 
“> Home | OnyxCeph3TM |About | 
System Requirements” 

Baltic Denture System® 
www.baltic-denture-system.de 
Dental Lab > Requirements  

* GC is a reseller of exocad GmbH. If you are interested in exocad® DentalCAD please
contact your GC reseller.

2 Basic operation 

2.1 User interface 

Program window division 

Standby mode 

2.1.1 Project info 

Project definition information display: 

More 

u Menus 

u Project info 

u 3D viewer 

u Project, Extras, Settings 

u Project management 

		  2.1.1	 Project info 

PROJECT DEFINITION INFORMATION DISPLAY:

Patient or project name

	 In dental projects: first name and surname of the patient.
	 In universal projects: project name.

Dentist

	 Name of the dentist in a dental project started in Aadva Scan.
	 Name of the customer in a dental project started in exocad®.
	 Not used in universal projects.

Project ID (generated automatically)

	 Aadva Scan projects: [YYYY]-[MM]-[DD]-[hhmmss]
	 exocad® projects: [YYYY]-[MM]-[DD]-[exocad-ID]

	 e.g. 2021-09-28_00001-001.

Tooth chart

	 Coloring of the tooth positions with defined reconstruction;
	 Color codes according to Aadva Scan or exocad®.
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Displaying and hiding
 

	 Click the arrow 

dental Scan Software
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Patient or project name 

¾ In dental projects: first name and surname of the patient. 
¾ In universal projects: project name. 

Dentist 

¾ Name of the dentist in a dental project started in Aadva Scan. 
¾ Name of the customer in a dental project started in exocad®. 
¾ Not used in universal projects. 

Project ID (generated automatically) 

¾ Aadva Scan projects: [YYYY]-[MM]-[DD]-[hhmmss] 
¾ exocad® projects: [YYYY]-[MM]-[DD]-[exocad-ID] 

e.g. 2021-09-28_00001-001. 

Tooth chart 

¾ Coloring of the tooth positions with defined reconstruction; 
¾ Color codes according to Aadva Scan or exocad®. 

Displaying and hiding 

w Click the arrow > at the project info. 

� The project info is hidden. 

w Click the arrow < at the edge of the program window. 

� The project info is displayed. 

Project definitions 14 
Project menu 66 

More 

 at the project info.

	 The project info is hidden.
 

	 Click the arrow 

dental Scan Software
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Project definitions 14 
Project menu 66 

More 

 at the edge of the program window.

	 The project info is displayed.

		  2.1.2	 2D viewer

The 2D viewer:

	 shows the jaw model in the scanner as a black and white photo;
	 is intended for dental projects with secondDie presentation.
	 provides exact marking of tooth positions.

dental Scan Software
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2.1.2 2D viewer 

The 2D viewer: 

¾ shows the jaw model in the scanner as a black and white photo; 
¾ is intended for dental projects with secondDie presentation. 
¾ provides exact marking of tooth positions. 

TIP 
2D images are displayed in the project status of exocad® DentalDB. 

2D scans for presentations 42 
Scanning with exocad® DentalCAD 68 

2.1.3 3D viewer 

The 3D viewer: 

¾ Shows the scans from all sides, 
¾ is intended for the processing of workflows, 
¾ is split horizontally for manual registrations/assignments. 

Workflow functions 40 

Mesh processing 51 

View 63 

2.1.4 Project management 

The project is managed via the horizontal bar below the 3D viewer: 

�

More 

More 

Status bar 

Tabs 

Info line 

Actions 

TIP

2D images are displayed in the project status of exocad® DentalDB.

		  2.1.3	 3D viewer

The 3D viewer:

	 Shows the scans from all sides,
	 is intended for the processing of workflows,
	 is split horizontally for manual registrations/assignments.

		  2.1.4	 Project management

The project is managed via the horizontal bar below the 3D viewer:
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Patient or project name 

¾ In dental projects: first name and surname of the patient. 
¾ In universal projects: project name. 

Dentist 

¾ Name of the dentist in a dental project started in Aadva Scan. 
¾ Name of the customer in a dental project started in exocad®. 
¾ Not used in universal projects. 

Project ID (generated automatically) 

¾ Aadva Scan projects: [YYYY]-[MM]-[DD]-[hhmmss] 
¾ exocad® projects: [YYYY]-[MM]-[DD]-[exocad-ID] 

e.g. 2021-09-28_00001-001. 

Tooth chart 

¾ Coloring of the tooth positions with defined reconstruction; 
¾ Color codes according to Aadva Scan or exocad®. 

Displaying and hiding 

w Click the arrow > at the project info. 

� The project info is hidden. 

w Click the arrow < at the edge of the program window. 

� The project info is displayed. 

Project definitions 14 
Project menu 66 

More 
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2.1.2 2D viewer 

The 2D viewer: 

¾ shows the jaw model in the scanner as a black and white photo; 
¾ is intended for dental projects with secondDie presentation. 
¾ provides exact marking of tooth positions. 

TIP 
2D images are displayed in the project status of exocad® DentalDB. 

2D scans for presentations 42 
Scanning with exocad® DentalCAD 68 

2.1.3 3D viewer 

The 3D viewer: 

¾ Shows the scans from all sides, 
¾ is intended for the processing of workflows, 
¾ is split horizontally for manual registrations/assignments. 

Workflow functions 40 

Mesh processing 51 

View 63 

2.1.4 Project management 

The project is managed via the horizontal bar below the 3D viewer: 

�

More 

More 

Status bar 

Tabs 

Info line 

Actions 
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Status bar
	 It displays the current progress of the data processing.

Tabs
	 One tab per scan (number according to the project definition).
	 Some tabs are assigned to another tab at the end of the workflow (additional scan, correction scan, 

multiDie).

Info line
	 Instructions for the next step,
	 Orientation on the procedure.

Actions
	 Possible alternatives to end the processing step (e.g. matching, next, cancel).

		  2.1.5	 Program window in the standby mode

When a project is finalized/closed, Aadva Scan goes into the standby mode (background readiness).
Opening the program window in the standby mode

 
	 LT Pro Double click the desktop icon of Aadva Scan.

OR:
	 Open the program window from the Windows taskbar:

1. Click on ^̂ to open the hidden icons again.

2. Click on  to open Aadva Scan.

1. Click on ^̂ to open the hidden icons again.

2. Click on  to open Aadva Scan.

TIP
Opening from the taskbar is faster if you pin the icon of Aadva Scan to the taskbar in the Windows settings.

Ending the standby mode

1.	 Right click the icon of Aadva Scan for in the system tray.

 
2.	 Select Close in the context menu.
	 Æ	 Aadva Scan is closed.

Allow 
standby mode
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2.2	 Workflows
	 A workflow is a defined sequence of work steps (scans, matching and, if necessary, registrations) based on 

the project definition (divided into individual tabs in the project management).

Aadva Scan arranges the necessary tabs in a meaningful order according to the project settings.

Guided workflows

There is a guided workflow for every project. The work steps are processed and completed in a specified, 
meaningful sequence.

The guided workflow is mandatory for the following scan modes: 
Baltic Denture, Triple Tray®, Twin Tray.

Free workflows (“IndepenDent mode”)

Depending on the selected scan mode, a guided workflow (“IndepenDent”) can be modified. A different 
scanning sequence is possible.

1.	 Click on the tab that you want to fill (even if only one is available, e.g. with multiCase).

2.	 Click on “Next”.

	 Æ	 A tab dialog asks for the insertion of a scan object.

	 Tab processing symbol

 

dental Scan Software
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Tab processing symbol 

No symbol ¾ No scan data available 
¾ Scan data available, but not matched 
¾ Scan data available and matched 

Tab dialogs 28 

Workflow functions 40 

3 Project definitions 

A project definition specifies what and how to scan.  
Aadva Scan saves the data in the project management file (SOP): 

¾ Patient 
Comprehensive dental project definition for all indications (jaw models, 
impressions). 

¾ multiCase 
Dental project definition for individual stumps. 

¾ Orthodontics 
Dental project definition for orthodontic indications (jaw models). 

¾ Universal 
General project definition for many objects. 

The project definition Patient is proposed by default. 
The default value can be changed. 

Alternatively, scan projects can be defined in a CAD system, e.g. exocad® 
DentalCAD. 

Patient project definition (dental) 17 

multiCase project definition 26 

Orthodontics project definition 27 

Universal project definition 27 

Scanning with exocad® DentalCAD 68 

Standard project mode 76 

More 

More 

No symbol	 	 No scan data available
 	 	 Scan data available, but not matched
 	 	 Scan data available and matched

dental Scan Software
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2. Select Close in the context menu.

� Aadva Scan is closed. 

2.2 Workflows 

A workflow is a defined sequence of work steps (scans, matching and, if 
necessary, registrations) based on the project definition (divided into 
individual tabs in the project management). 

Aadva Scan arranges the necessary tabs in a meaningful order according 
to the project settings. 

Guided workflows 

There is a guided workflow for every project. The work steps are processed 
and completed in a specified, meaningful sequence. 

The guided workflow is mandatory for the following scan modes: 
Baltic Denture, Triple Tray®, Twin Tray. 

Triple Tray 22 
Twin Tray 23 
Baltic Denture 23 
Note on Triple Tray®, Twin Tray and Baltic Denture 23 

Free workflows (“IndepenDent mode”) 

Depending on the selected scan mode, a guided workflow (“IndepenDent”) 
can be modified. A different scanning sequence is possible. 

1. Click on the tab that you want to fill (even if only one is available, e.g.
with multiCase).

2. Click on “Next”.

� A tab dialog asks for the insertion of a scan object. 

More 

u 
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Tab processing symbol 

No symbol ¾ No scan data available 
¾ Scan data available, but not matched 
¾ Scan data available and matched 

Tab dialogs 28 

Workflow functions 40 

3 Project definitions 

A project definition specifies what and how to scan.  
Aadva Scan saves the data in the project management file (SOP): 

¾ Patient 
Comprehensive dental project definition for all indications (jaw models, 
impressions). 

¾ multiCase 
Dental project definition for individual stumps. 

¾ Orthodontics 
Dental project definition for orthodontic indications (jaw models). 

¾ Universal 
General project definition for many objects. 

The project definition Patient is proposed by default. 
The default value can be changed. 

Alternatively, scan projects can be defined in a CAD system, e.g. exocad® 
DentalCAD. 

Patient project definition (dental) 17 

multiCase project definition 26 

Orthodontics project definition 27 

Universal project definition 27 

Scanning with exocad® DentalCAD 68 

Standard project mode 76 

More 

More 
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3	 Project definitions
A project definition specifies what and how to scan. 
Aadva Scan saves the data in the project management file (SOP):

	 Patient
Comprehensive dental project definition for all indications (jaw models, impressions).

	 multiCase
Dental project definition for individual stumps.

	 Orthodontics
Dental project definition for orthodontic indications (jaw models).

	 Universal
General project definition for many objects.
The project definition Patient is proposed by default. 
The default value can be changed.

Alternatively, scan projects can be defined in a CAD system, e.g. exocad® DentalCAD.

3.1	 Basic data
The basic data are entered when the project is set up and cannot be modified afterwards.

Basic data (dental)
 

dental Scan Software
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3.1 Basic data 

The basic data are entered when the project is set up and cannot be 
modified afterwards. 

Basic data (dental) 

Basic data from exocad 

In Aadva Scan, the basic data of an exocad® project must remain 
unchanged to keep the consistency with the exocad® data. 

Project ID 

Aadva Scan automatically assigns a unique, non-changeable project ID. 

Format 
YYYY-MM-DD-hhmmss (time stamp consisting of year-month-day-time). 
The project ID can be expanded to include the patient name or project 
name. 
In exocad® projects, the exocad® ID is added instead of the time, e.g. 
87612-001_Smith-John. 

Dentist and patient 

In dental projects, dentist and patient are optional data used to assign the 
project to a treatment case.  

Project definitions 
Patient 

multiCase 
Orthodontics 

� 89

Basic data from exocad
 
In Aadva Scan, the basic data of an exocad® project must remain unchanged to keep the consistency with 
the exocad® data.
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Tab processing symbol 

No symbol ¾ No scan data available 
¾ Scan data available, but not matched 
¾ Scan data available and matched 

Tab dialogs 28 

Workflow functions 40 

3 Project definitions 

A project definition specifies what and how to scan.  
Aadva Scan saves the data in the project management file (SOP): 

¾ Patient 
Comprehensive dental project definition for all indications (jaw models, 
impressions). 

¾ multiCase 
Dental project definition for individual stumps. 

¾ Orthodontics 
Dental project definition for orthodontic indications (jaw models). 

¾ Universal 
General project definition for many objects. 

The project definition Patient is proposed by default. 
The default value can be changed. 

Alternatively, scan projects can be defined in a CAD system, e.g. exocad® 
DentalCAD. 

Patient project definition (dental) 17 

multiCase project definition 26 

Orthodontics project definition 27 

Universal project definition 27 

Scanning with exocad® DentalCAD 68 

Standard project mode 76 

More 

More 

Project definitions
Patient

multiCase
Orthodontics
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Project ID

Aadva Scan automatically assigns a unique, non-changeable project ID.

Format

YYYY-MM-DD-hhmmss (time stamp consisting of year-month-day-time).
The project ID can be expanded to include the patient name or project name.
In exocad® projects, the exocad® ID is added instead of the time, e.g. 87612-001_Smith-John.

Dentist and patient

In dental projects, dentist and patient are optional data used to assign the project to a treatment case. 

The fields are not divided so that you can structure the names as you wish, e.g.:
	 [Title] [First name] [Surname].
	 [Surname] [First name].

 
Names from ® projects are adopted according to defaultsettingsDB.

Comment

The comment can contain discretionary processing instructions or additional information (≈ 30,000 
characters).
Example	 multiCase project with tooth models belonging to several patients
	 Comment: Number–Name–Tooth position:
 
In the exocad® DentalDB, the corresponding field is called “Comments”.

Project name (universal projects)

A project name must be entered (maximum 204 characters, letters, numbers, special characters).

3.2	 Texture scan
Texture scans are used to add markings to the surface of a scan object in a scan. A model cast prosthesis, 
for example, can be precisely designed along a scanned contour line using the SilaPart® CAD system.

Depiction of textures in the 3D viewer:

monochrome	 colored
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The fields are not divided so that you can structure the names as you wish, 
e.g.: 

¾ [Title] [First name] [Surname]. 
¾ [Surname] [First name]. 

Names from ® projects are adopted according to defaultsettingsDB. 

Comment 

The comment can contain discretionary processing instructions or 
additional information (≈ 30,000 characters). 

multiCase project with tooth models belonging to several patients 
Comment: Number–Name–Tooth position: 

In the exocad® DentalDB, the corresponding field is called “Comments”. 

Project name (universal projects) 

A project name must be entered (maximum 204 characters, letters, 
numbers, special characters). 

3.2 Texture scan 

Texture scans are used to add markings to the surface of a scan object in a 
scan. A model cast prosthesis, for example, can be precisely designed 
along a scanned contour line using the SilaPart® CAD system. 

Depiction of textures in the 3D viewer: 
monochrome colored 

The monochrome or colored texture scan can be enabled in the project 
definition as a suggested value, as well as in the tab dialogs. 

Example 

Project definitions: 
Patient 

multiCase 
Universal 

Orthodontics 

� Error! Bookmark not defined.

 	  
The monochrome or colored texture scan can be enabled in the project definition as a suggested value, as 
well as in the tab dialogs.

 

NOTICE

	 Markings on preparation lines affect the measurement accuracy. Only place marks in areas that 
are not relevant to the fit.

	 Optimized texture scans generally have the effect of smoothing the edges, for example of 
fissures and ridges. To obtain full edge definition, GC recommends non-optimised texture 
scans.
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Tab processing symbol 

No symbol ¾ No scan data available 
¾ Scan data available, but not matched 
¾ Scan data available and matched 

Tab dialogs 28 

Workflow functions 40 

3 Project definitions 

A project definition specifies what and how to scan.  
Aadva Scan saves the data in the project management file (SOP): 

¾ Patient 
Comprehensive dental project definition for all indications (jaw models, 
impressions). 

¾ multiCase 
Dental project definition for individual stumps. 

¾ Orthodontics 
Dental project definition for orthodontic indications (jaw models). 

¾ Universal 
General project definition for many objects. 

The project definition Patient is proposed by default. 
The default value can be changed. 

Alternatively, scan projects can be defined in a CAD system, e.g. exocad® 
DentalCAD. 

Patient project definition (dental) 17 

multiCase project definition 26 

Orthodontics project definition 27 

Universal project definition 27 

Scanning with exocad® DentalCAD 68 

Standard project mode 76 

More 

More 
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Project definitions:
Patient

multiCase
Universal

Orthodontics
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3.3	 Starting a project
Before starting a scan, the project definition must be entered fully and correctly.

	 Click on Start.

Æ	 The project definition can no longer be modified.

3.4	 Patient project definition
The Patient project definition is suitable for all upper and lower jaw dental technical indications. It is 
characterized by the combination of indications for individual tooth positions, scan mode and presentation 
mode.

		  3.4.1	 Indications for tooth positions in the upper and lower jaw

Dental indications are a prerequisite for the design of a dental prosthesis. You must select the preparations 
and options necessary for scanning.
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3.4.1 Indications for tooth positions in the upper and lower jaw 

Dental indications are a prerequisite for the design of a dental prosthesis. 
You must select the preparations and options necessary for scanning. 

Displaying and hiding 

w Click on any tooth position/a place outside the tooth chart. 

� Preparations and Options are alternatively displayed and hidden. 

Assigning the indication to a tooth position 

w Click on the tooth position to which you want to assign an indication 
and on the desired indication. 

� The tooth position is colored in the color of the indication, e.g.: 

w To initiate a scan of an aesthetic template, situation model, gingiva or 
wax-up, click on one or several options. 

Aadva Scan color codes 

Displaying and hiding

	 Click on any tooth position/a place outside the tooth chart.

Æ	 Preparations and Options are alternatively displayed and hidden.

Assigning the indication to a tooth position

	 Click on the tooth position to which you want to assign an indication and on the desired indication.

Æ	 The tooth position is colored in the color of the indication, e.g.: 
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3.4.1 Indications for tooth positions in the upper and lower jaw 

Dental indications are a prerequisite for the design of a dental prosthesis. 
You must select the preparations and options necessary for scanning. 

Displaying and hiding 

w Click on any tooth position/a place outside the tooth chart. 

� Preparations and Options are alternatively displayed and hidden. 

Assigning the indication to a tooth position 

w Click on the tooth position to which you want to assign an indication 
and on the desired indication. 

� The tooth position is colored in the color of the indication, e.g.: 

w To initiate a scan of an aesthetic template, situation model, gingiva or 
wax-up, click on one or several options. 

Aadva Scan color codes 

	 To initiate a scan of an aesthetic template, situation model, gingiva or wax-up, 
	 click on one or several options.
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NOTICE 

w Markings on preparation lines affect the measurement accuracy. Only 
place marks in areas that are not relevant to the fit. 

w Optimized texture scans generally have the effect of smoothing the 
edges, for example of fissures and ridges. To obtain full edge 
definition, GC recommends non-optimised texture scans. 

Tab dialog 29 
Texture mode 83 

3.3 Starting a project 

Before starting a scan, the project definition must be entered fully and 
correctly. 

w Click on Start. 

� The project definition can no longer be modified. 

Tab dialog 28 

Workflow functions 40 

Scanning with exocad® DentalCAD 68 

Settings 75 

3.4 Patient project definition 

The Patient project definition is suitable for all upper and lower jaw dental 
technical indications. It is characterized by the combination of indications 
for individual tooth positions, scan mode and presentation mode. 

Basic data (ID, dentist, patient) 15 

Texture scan 16 

Starting a project 17 

Settings 75 

More 

� Start 

More 

More 

Stump

Pontic

Inlay/Onlay

Veneer

Implant

Neighbouring 
tooth

Opposing jaw

Missing tooth

Color codes Option symbols

x	 Aesthetic template
*	 Situ
°	 Gingava
=	 Wax-Up

Aadva Scan 
color codes
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Æ	 The option symbols appear next to the position number, e.g.:
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� The option symbols appear next to the position number, e.g.: 

Individual copying of an indication

1.	 Assign an indication.

2.	 Hold the CTRL key.

3.	 Click on the next tooth position.

Æ	 The tooth position is colored and marked like the first one, e.g.:
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Individual copying of an indication 

1. Assign an indication.

2. Hold the CTRL key.

3. Click on the next tooth position.

� The tooth position is colored and marked like the first one, e.g.: 

Copying an indication to several positions 

1. Assign an indication.

2. Hold the SHIFT key.

3. Click on the last tooth position in the series.

� All tooth positions in the series is colored and identified in the same 
way, e.g.: 

Deleting an indication 

1. Click on the tooth position whose indication you wish to delete.

2. Click on the “Recycle Bin”.

� The indication and the options are deleted from the tooth position. 

 
Copying an indication to several positions

1.	 Assign an indication.
  
2.	 Hold the SHIFT key.

3.	 Click on the last tooth position in the series.

Æ	 All tooth positions in the series is colored and identified in the same way, e.g.:
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Individual copying of an indication 

1. Assign an indication.

2. Hold the CTRL key.

3. Click on the next tooth position.

� The tooth position is colored and marked like the first one, e.g.: 

Copying an indication to several positions 

1. Assign an indication.

2. Hold the SHIFT key.

3. Click on the last tooth position in the series.

� All tooth positions in the series is colored and identified in the same 
way, e.g.: 

Deleting an indication 

1. Click on the tooth position whose indication you wish to delete.

2. Click on the “Recycle Bin”.

� The indication and the options are deleted from the tooth position. 

 
Deleting an indication

1.	 Click on the tooth position whose indication you wish to delete.
 
2.	 Click on the “Recycle Bin”.

Æ	 The indication and the options are deleted from the tooth position.

3.	 To delete only the indication and not the option (or the other way round), click on the current indication, 
e.g. “Implant”, or on the option, e.g. “Situ”.

Example: Deleting the “Situ” option from tooth position 16

Ctrl

shift

Tooth 16
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3. To delete only the indication and not the option (or the other way
round), click on the current indication, e.g. “Implant”, or on the option,
e.g. “Situ”.

Example: Deleting the “Situ” option from tooth position 16 

4. To delete the indication/option from another tooth position, hold the
CTRL key and click on the next tooth position.

5. To delete the indication/option from a series of tooth positions, hold
the SHIFT key and click on the next tooth position in the series.

Modifying an indication 

1. Click on the tooth position.

2. Click on the new indication.

� The color and marking of the tooth position changes accordingly. 

� An option is adopted for the new indication. 
If necessary, delete the option manually. 

3.4.2 Scan modes of the “patient” project definition 

The scan mode defines the workflow of the data to be recorded based on 
the indications. 

  
4.	 To delete the indication/option from another tooth position, hold the CTRL key and click on the next 

tooth position.
  
5.	 To delete the indication/option from a series of tooth positions, hold the SHIFT key and click on the next 

tooth position in the series.

Modifying an indication

1.	 Click on the tooth position.

2.	 Click on the new indication.

Æ	 The color and marking of the tooth position changes accordingly. 

Æ	 An option is adopted for the new indication. 

If necessary, delete the option manually.

3.4.2	 Scan modes of the “patient” project definition

The scan mode defines the workflow of the data to be recorded based on the indications.

Single model
Indications must exist for one jaw. The indication “Opposing Jaw” is possible for the other jaw to add a 
squeeze bite scan.

Two models in occlusion

Scan mode for models that are not articulated (vestibular scan without condylar reference).
Articulator […]

An articulator can be used for the vestibular scan of articulated models. The scan mode must be suitable 
for the articulator. The scan of the physical articulator can be replaced by smart occlusion.
The following articulators are scanned with a condylar reference:
ARTEX®; ARTEX® CN; PROTAR®; SAM® 1+2; SAM® 3+NEO; REFERENCE®; ARTIST/ARTO®; DENAR®.
Those articulators that have been specifically configured for your system in Aadva Scan can be selected. 
The scan mode “Articulator” (medium-quality scan) should be used for non-configured articulators.
To add an articulator, please contact your GC reseller.
 

NOTICE

	 If the scan mode does not match the articulator, the results of the measurement is inaccurate. 
Select the articulator you are using or “Articulator” (medium-quality) as the scan mode.

Ctrl

shift
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Impression – two impressions in occlusion 

The scan mode “Impression” is for single impressions; “Two impressions in occlusion” is for a workflow with 
a vestibular scan.
The “Impression” presentation mode must be assigned to at least one jaw.
An impression scan is not possible with the indication “Implant”.
 
exocad® projects with indications in the posterior region and the scan mode “Digital impression” can be 
scanned in Aadva Scan with the scan modes “Impression” or “Triple Tray®”.

Triple Tray® (impression)

The Triple Tray® module (activated) and the Triple Tray® impression holder are required.
An impression scan is not possible with the indication “Implant”.
Indications (with the exception of Implant) can be for the posterior or anterior region. It is not possible to 
select a presentation mode

Twin Tray

Scan mode for Twin Tray models from the manufacturer Klasse 4 Dental® with an indication in the posterior 
region for the upper and lower jaw (maximum 5 positions, except for Implant).

You need the universal plate and the 4 teeth bar to isolate segments.
It is not possible to select a presentation mode. The upper and lower jaw as well as individual, presented 
segments are scanned in a single step. 

Baltic Denture

Scan mode for the production of full prostheses with the full solution Baltic Denture System®.

You need a BDKey® with press fastening (Baltic Denture accessory) and a BDKey® holder with a bottom 
impression holder (scanner accessory).

The indication “Missing Tooth” must be assigned to at least one tooth position in the upper and lower jaw. 
It is not possible to select a presentation mode.

The workflow with the scan mode Baltic Denture is not suitable for other full denture systems.
 
Design of a full dental prosthesis with the exocad® module Full Denture

	 Combine the indication “Full Denture” with an articulator scan mode in exocad® DentalCAD. 

The exocad scan modes “Two Plaster Models, in Occlusion” or “Digital Impression” are not suitable for 
exocad® Full Denture.
Note on Triple Tray®, Twin Tray and Baltic  Denture

 

NOTICE

	 The scan modes Triple Tray®, Twin Tray and Baltic Denture require a lot of computing power 
and memory. The PC must comply with the recommended system requirements for Aadva 
Scan.

Processing	

IndepenDent Mode:	 	 Not possible: Scans must be processed in the specified order.
Load project:	 	 Not possible: Projects must be processed and finalized without interruption.
Automatic cutting plane:	 	 Not possible, only manual cutting.
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Tab processing symbol 

No symbol ¾ No scan data available 
¾ Scan data available, but not matched 
¾ Scan data available and matched 

Tab dialogs 28 

Workflow functions 40 

3 Project definitions 

A project definition specifies what and how to scan.  
Aadva Scan saves the data in the project management file (SOP): 

¾ Patient 
Comprehensive dental project definition for all indications (jaw models, 
impressions). 

¾ multiCase 
Dental project definition for individual stumps. 

¾ Orthodontics 
Dental project definition for orthodontic indications (jaw models). 

¾ Universal 
General project definition for many objects. 

The project definition Patient is proposed by default. 
The default value can be changed. 

Alternatively, scan projects can be defined in a CAD system, e.g. exocad® 
DentalCAD. 

Patient project definition (dental) 17 

multiCase project definition 26 

Orthodontics project definition 27 

Universal project definition 27 

Scanning with exocad® DentalCAD 68 

Standard project mode 76 

More 

More 

www.baltic-denture-
system.de
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General note on full dentures

There is no scan mode available for full denture systems other than Baltic Denture. The following project 
definition is possible:

Preparation:	 Missing tooth (one tooth suffices)
Option:	 Aesthetic template (optional)
Scan mode:	 	 Impression
		  	 Jaw model
		  	 Articulator
	 	 Two impressions in occlusion
	 	 Two models in occlusion

The option Aesthetic template changes the order in the guided workflow: Aesthetic template, vestibular 
scan, upper jaw, lower jaw.

		  3.4.3	 Upper jaw/lower jaw presentation “patient” project definition

The presentation mode is the method with which individual segments from the upper and lower jaw are 
presented.

secondDie is suggested by default. The preferred presentation mode can be set and changed individually 
when a jaw model is inserted.

singleDie

	 Presentation mode for each individual segment in the jaw model.
	 Requires several scans.

secondDie

	 Standard presentation mode in Aadva Scan.
	 Scans every second segment in the jaw model.
	 A maximum of two scans is required.
	 With 2D scan.

multiDie

	 Presentation mode for a maximum of 16 stumps per jaw (with two presentations).
	 Scan of the segments without model base.
	 Accessories: multiDie adapter.
	 Activated module “multiDie/multiCase”.

Complete jaw/complete jaw fast

	 Presentation mode for jaw models without segment presentation.
	 Suitable for opposing jaws, situ models, archiving.
	 “Complete jaw fast”: fewer single images (PCM), reduced quality, higher scanning speed.

Impression

	 Special presentation mode for impressions.
	 Expansion for the scan mode “Impression”.
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3.5	 multiCase project definition
The multiCase project definition is used to scan individual segments without a model base. The segments 
(1 – 12) can belong to different treatment cases.

A multiDie adapter is required for multiCase projects. The “multiDie/multiCase” module must be activated.
The slots of the multiDie adapter are numbered:
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multiDie 

¾ Presentation mode for a maximum of 16 stumps per jaw (with two 
presentations). 

¾ Scan of the segments without model base. 
¾ Accessories: multiDie adapter. 
¾ Activated module “multiDie/multiCase”. 

Complete jaw/complete jaw fast 

¾ Presentation mode for jaw models without segment presentation. 
¾ Suitable for opposing jaws, situ models, archiving. 
¾ “Complete jaw fast”: fewer single images (PCM), reduced quality, higher 

scanning speed. 

Impression 

¾ Special presentation mode for impressions. 
¾ Expansion for the scan mode “Impression”. 

3.5 multiCase project definition 

The multiCase project definition is used to scan individual segments 
without a model base. The segments (1 – 12) can belong to different 
treatment cases. 

A multiDie adapter is required for multiCase projects. 
The “multiDie/multiCase” module must be activated. 
The slots of the multiDie adapter are numbered: 

w Click on the slots that you want to occupy in whatever order you wish. 
You can click them again to clear a mark. 

� The marked slots turn dark grey.  

The following applies to exocad® projects: 

�
� Error! Bookmark not

defined., 73 

�
� Error! Bookmark not

defined., 73 

 
	 Click on the slots that you want to occupy in whatever order you wish. 

	 You can click them again to clear a mark.

Æ	 The marked slots turn dark grey. 
 
The following applies to exocad® projects:

	 “multiDie Practice” is displayed in the field Dentist.
	 No exocad® slot labels are displayed (data is saved in the project file (*.SOP)).

3.6	 Universal project definition
The Universal project definition is intended for solid, opaque objects the size of the measuring field,  
e.g. tools, jewels, toys or figures.
Universal scans do not have a defined workflow. At least two scans are required for a complete 3D model 
(360° representation). Additional scans can be created individually and combined with the first scan.

3.7	 Orthodontics project definition
The orthodontics project definition is intended for orthodontic indications and is therefore limited to 
complete jaw scans (individually or in occlusion).
Impressions cannot be scanned in orthodontics projects.
“Complete jaw” is specified as the presentation mode and cannot be changed in the project definition.

		  3.7.1	 Orthodontics project definition scan modes

The scan mode determines an orthodontics project.

1.	 Start by selecting a button Upper Jaw, Lower Jaw or Upper and Lower Jaw.
2.	 For Upper and Lower Jaw: 
	 Specify the occlusion method in the Scan Mode field.

Single model

	 The only scan mode for Upper Jaw or Lower Jaw without occlusion.

Two models in occlusions

	 Suggestion for Upper and Lower Jaw,
	 Suitable for non-articulated models (without condylar reference).

Articulator […]

See “Patient” project definition, scan mode Articulator […]
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Dental project definition for orthodontic indications (jaw models). 

¾ Universal 
General project definition for many objects. 

The project definition Patient is proposed by default. 
The default value can be changed. 

Alternatively, scan projects can be defined in a CAD system, e.g. exocad® 
DentalCAD. 

Patient project definition (dental) 17 

multiCase project definition 26 

Orthodontics project definition 27 

Universal project definition 27 

Scanning with exocad® DentalCAD 68 

Standard project mode 76 

More 

More 

scanBox: 
No option

4	 Tab dialogs
When starting a workflow or when selecting a tab (“IndepenDent Mode”), Aadva Scan asks you to insert a scan object 
into the scanner.

4.1	 General functions in the tab dialogs
All tab dialogs have the same structure:

1. 	 scan object: What is to be scanned?

2. 	 Instruction: What should you do with the scan object?

3. 	 Project information: What indication was defined?

4. 	 Project properties:
4.1 Should textures be scanned on the scan object?
4.2 How should the presentation be done?

5. 	 Determination of the scan height: 
	 What is the optimal height of the scan object in the measuring field?

6. 	 Scanner control:
	 Settings, service position, global scan strategy, HR mode.

7. 	 Dialog control: How do you wish to proceed?

Texture mode

	 Suggested value adjustable, can be selected for each scan.

	 Monochrome (single color) is always possible; Color (polychrome), texture scans with certain scanners.

Presentation

	 Can be selected in dental tab dialogs.
	 Scanning without presentation with “Complete Jaw” or “Complete Jaw Fast”.

Settings
 

	 Open the settings to change relevant values before the current scan, e.g. the type of plaster, the scan 
quality for a specific dental indication or the cutting filters.
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Texture mode 

¾ Suggested value adjustable, can be selected for each scan. 

¾ Monochrome (single color) is always possible; Color (polychrome), 
texture scans with certain scanners. 

Presentation 

¾ Can be selected in dental tab dialogs. 
¾ Scanning without presentation with “Complete Jaw” or 

“Complete Jaw Fast”. 

Settings 

¾ Open the settings to change relevant values before the current scan, 
e.g. the type of plaster, the scan quality for a specific dental indication 
or the cutting filters. 

Service position 

¾ Execution of the “Service position” (resetting the axes) function. 

Globalscan strategy (“Enhanced mode”) 

Toggle switch in dental or orthodontic tab dialogs: 

¾ determines the number and perspective of the camera images 
(PCM files) 

¾ simple enhanced mode strategy (“OFF”), e.g. 13 images (PCM files) for a 
complete jaw, 

¾ extended enhanced mode strategy (“ON”), e.g. 24 images (PCM files) 
for a complete jaw. 

¾ Simple (OFF) is enabled by default. 
¾ Extended (ON) is useful for complex scan object and dental indications. 

Procedure 

1. Click the OFF icon.

2. Start the scan.

� The scan is carried out once with an extended enhanced mode 
strategy. “ON” is not saved. 

� 83

�  Error! Bookmark not

defined. 

� 75

� 66

�
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4	 Tab dialogs
When starting a workflow or when selecting a tab (“IndepenDent Mode”), Aadva Scan asks you to insert a scan object 
into the scanner.

4.1	 General functions in the tab dialogs
All tab dialogs have the same structure:

1. 	 scan object: What is to be scanned?

2. 	 Instruction: What should you do with the scan object?

3. 	 Project information: What indication was defined?

4. 	 Project properties:
4.1 Should textures be scanned on the scan object?
4.2 How should the presentation be done?

5. 	 Determination of the scan height: 
	 What is the optimal height of the scan object in the measuring field?

6. 	 Scanner control:
	 Settings, service position, global scan strategy, HR mode.

7. 	 Dialog control: How do you wish to proceed?

Texture mode

	 Suggested value adjustable, can be selected for each scan.

	 Monochrome (single color) is always possible; Color (polychrome), texture scans with certain scanners.

Presentation

	 Can be selected in dental tab dialogs.
	 Scanning without presentation with “Complete Jaw” or “Complete Jaw Fast”.

Settings
 

	 Open the settings to change relevant values before the current scan, e.g. the type of plaster, the scan 
quality for a specific dental indication or the cutting filters.
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Texture mode 

¾ Suggested value adjustable, can be selected for each scan. 

¾ Monochrome (single color) is always possible; Color (polychrome), 
texture scans with certain scanners. 

Presentation 

¾ Can be selected in dental tab dialogs. 
¾ Scanning without presentation with “Complete Jaw” or 

“Complete Jaw Fast”. 

Settings 

¾ Open the settings to change relevant values before the current scan, 
e.g. the type of plaster, the scan quality for a specific dental indication 
or the cutting filters. 

Service position 

¾ Execution of the “Service position” (resetting the axes) function. 

Globalscan strategy (“Enhanced mode”) 

Toggle switch in dental or orthodontic tab dialogs: 

¾ determines the number and perspective of the camera images 
(PCM files) 

¾ simple enhanced mode strategy (“OFF”), e.g. 13 images (PCM files) for a 
complete jaw, 

¾ extended enhanced mode strategy (“ON”), e.g. 24 images (PCM files) 
for a complete jaw. 

¾ Simple (OFF) is enabled by default. 
¾ Extended (ON) is useful for complex scan object and dental indications. 

Procedure 

1. Click the OFF icon.

2. Start the scan.

� The scan is carried out once with an extended enhanced mode 
strategy. “ON” is not saved. 

� 83

�  Error! Bookmark not

defined. 

� 75

� 66

�
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Service position
 

	 Execution of the “Service position” (resetting the axes) function.
	 Globalscan strategy (“Enhanced mode”)
	 Toggle switch in dental or orthodontic tab dialogs:

	 determines the number and perspective of the camera images (PCM files)
	 simple enhanced mode strategy (“OFF”), e.g. 13 images (PCM files) for a complete jaw,
	 extended enhanced mode strategy (“ON”), e.g. 24 images (PCM files) for a complete jaw.
	 Simple (OFF) is enabled by default.
	 Extended (ON) is useful for complex scan object and dental indications.

Procedure
 
1.	 Click the OFF icon.

2.	 Start the scan.
	 Æ	 The scan is carried out once with an extended enhanced mode strategy. “ON” is not saved.

TIP
The file names in Aadva Scan projects indicate which Globalscan strategy was used to scan, 
e.g.: 2019-07-03-101351-upperjaw_#A190703101459_GlobalEnhanced_w90h-60.pcm

HR mode
   
ON / OFF

	 Toggle switch, available on scanners with high-resolution cameras
	 HR enabled (ON): highest resolution of the scanner camera, more precise results, longer scan times.

Procedure
 

1.	 Click the OFF icon.

2.	 Start the scan.
Æ	 The scan is carried out once with a lower camera resolution and a shorter scan time. “OFF” is not saved.

 

NOTICE

	 The HR mode requires a lot of computing power and memory. 

Use a PC that meets the recommended system requirements for Aadva Scan.

Start | Cancel

A tab dialog can be confirmed with Start or Next if the scan object is positioned inside the scanner and the 
settings are correct. The result is displayed in the 3D viewer of the tab.

A tab dialog can be cancelled without editing the task (scanning, presentation). 
The tab remains empty. 
You can cancel the scan if, for example, the project definition was created incorrectly.

Skip | Repeat scan | Check and rescan

Actions for singleDie and secondDie presentations:

	 Proceed to the next step without presentation. 
	 This results in a lack of 3D data.

	 Rescan the last scanned segments.
	 View the last scanned segments in the 3D viewer and rescan if necessary.
	 Not possible after the last presentation. 
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Texture mode 

¾ Suggested value adjustable, can be selected for each scan. 

¾ Monochrome (single color) is always possible; Color (polychrome), 
texture scans with certain scanners. 

Presentation 

¾ Can be selected in dental tab dialogs. 
¾ Scanning without presentation with “Complete Jaw” or 

“Complete Jaw Fast”. 

Settings 

¾ Open the settings to change relevant values before the current scan, 
e.g. the type of plaster, the scan quality for a specific dental indication 
or the cutting filters. 

Service position 

¾ Execution of the “Service position” (resetting the axes) function. 

Globalscan strategy (“Enhanced mode”) 

Toggle switch in dental or orthodontic tab dialogs: 

¾ determines the number and perspective of the camera images 
(PCM files) 

¾ simple enhanced mode strategy (“OFF”), e.g. 13 images (PCM files) for a 
complete jaw, 

¾ extended enhanced mode strategy (“ON”), e.g. 24 images (PCM files) 
for a complete jaw. 

¾ Simple (OFF) is enabled by default. 
¾ Extended (ON) is useful for complex scan object and dental indications. 

Procedure 

1. Click the OFF icon.

2. Start the scan.

� The scan is carried out once with an extended enhanced mode 
strategy. “ON” is not saved. 

� 83

�  Error! Bookmark not

defined. 

� 75

� 66

�
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Texture mode 

¾ Suggested value adjustable, can be selected for each scan. 

¾ Monochrome (single color) is always possible; Color (polychrome), 
texture scans with certain scanners. 

Presentation 

¾ Can be selected in dental tab dialogs. 
¾ Scanning without presentation with “Complete Jaw” or 

“Complete Jaw Fast”. 

Settings 

¾ Open the settings to change relevant values before the current scan, 
e.g. the type of plaster, the scan quality for a specific dental indication 
or the cutting filters. 

Service position 

¾ Execution of the “Service position” (resetting the axes) function. 

Globalscan strategy (“Enhanced mode”) 

Toggle switch in dental or orthodontic tab dialogs: 

¾ determines the number and perspective of the camera images 
(PCM files) 

¾ simple enhanced mode strategy (“OFF”), e.g. 13 images (PCM files) for a 
complete jaw, 

¾ extended enhanced mode strategy (“ON”), e.g. 24 images (PCM files) 
for a complete jaw. 

¾ Simple (OFF) is enabled by default. 
¾ Extended (ON) is useful for complex scan object and dental indications. 

Procedure 

1. Click the OFF icon.

2. Start the scan.

� The scan is carried out once with an extended enhanced mode 
strategy. “ON” is not saved. 

� 83

�  Error! Bookmark not

defined. 

� 75

� 66

�
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TIP 
The file names in Aadva Scan projects indicate which Globalscan strategy 
was used to scan, e.g.: 2019-07-03-101351-
upperjaw_#A190703101459_GlobalEnhanced_w90h-60.pcm 

HR mode 

¾ Toggle switch, available on scanners with high-resolution cameras 
¾ HR enabled (ON): highest resolution of the scanner camera, more 

precise results, longer scan times. 

Procedure 

1. Click the OFF icon.

2. Start the scan.

� The scan is carried out once with a lower camera resolution and a 
shorter scan time. “OFF” is not saved. 

NOTICE 

w The HR mode requires a lot of computing power and memory. 
Use a PC that meets the recommended system requirements for 
Aadva Scan. 

Start | Cancel 

A tab dialog can be confirmed with Start or Next if the scan object is 
positioned inside the scanner and the settings are correct. The result is 
displayed in the 3D viewer of the tab. 

A tab dialog can be cancelled without editing the task (scanning, 
presentation). The tab remains empty. You can cancel the scan if, for 
example, the project definition was created incorrectly. 

� Error! Bookmark not defined.

ON / OFF 

u 

r

ON / OFF

ON / OFF 

Skip

Repeat scan

Check and rescan



23

Aadva Scan

4.2	 Determination of the scan height

Scanners with automatic Z axis

The Z axis is moved to an average height depending on the object. 
You can determine the scan height individually by means of the live image.

You can repeat the following process as often as you like:

1.	 In the live image, click on Start scan height determination.
	
	 Æ	 The scanner moves the Z axis 45° towards the camera.
		  The live image now shows the front of the scan object. 
		  A dashed white contour line marks the standard Z focus plane. 
		  This line cannot be moved and always lies in the centre of the image.
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Skip | Repeat scan | Check and rescan 

Actions for singleDie and secondDie presentations: 

¾ Proceed to the next step without presentation. 
This results in a lack of 3D data. 

¾ Rescan the last scanned segments. 
¾ View the last scanned segments in the 3D viewer and rescan if 

necessary. 
¾ Not possible after the last presentation. 

4.2 Determination of the scan height 

Scanners with automatic Z axis 

The Z axis is moved to an average height depending on the object. You can 
determine the scan height individually by means of the live image. 

You can repeat the following process as often as you like: 

1. In the live image, click on Start scan height determination.

� The scanner moves the Z axis 45° towards the camera. 

The live image now shows the front of the scan object. A dashed white 
contour line marks the standard Z focus plane. This line cannot be 
moved and always lies in the centre of the image. 

2. To change the scan height, move the mouse over the image.

� A purple line follows the mouse. Outside of the measuring field, the 
line turns red (= position not possible). 

3. Click when the purple line is in the centre of the area to be scanned.

4. The scanner moves the scan object to the new height. The dashed
white line now is at the desired height.

� Skip 

� Repeat 

� Rescan 

�� 

 
2.	 To change the scan height, move the mouse over the image.
	 Æ	 A purple line follows the mouse. Outside of the measuring field, the line turns red 
		  (= position not possible). 
3.	 Click when the purple line is in the centre of the area to be scanned.

4.	 The scanner moves the scan object to the new height. 
	 The dashed white line now is at the desired height.
 	  
5.	 To turn the scan object 90° to the left or right, click on the 90° icons.
	 Æ	 The dashed white line must be perfectly centred in the area to be scanned.
 
6.	 To reset the scan height to the default, click “Undo”.

4.3	 Inserting a jaw model
After selecting a tab, Aadva Scan asks you to insert the corresponding jaw model. 
The tooth chart is displayed according to the project definition.

Information on inserting can be found in the Operating Manual.

4.4	 Inserting models in occlusion
The tab dialog depends on the scan mode and the scanner. 
A vestibular scan follows for bite registration purposes follows in all cases.

		  4.4.1	 Two models in occlusion
 	
Scan mode: “Two models in occlusion”

After selecting the tab, Aadva Scan asks you to insert the non-articulated models together.

Information on positioning can be found in the Operating Manual.
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5. To turn the scan object 90° to the left or right, click on the 90° icons.

� The dashed white line must be perfectly centred in the area to be 
scanned. 

6. To reset the scan height to the default, click “Undo”.

4.3 Inserting a jaw model 

After selecting a tab, Aadva Scan asks you to insert the corresponding jaw 
model. The tooth chart is displayed according to the project definition. 

Information on inserting can be found in the Operating Manual. 

General functions in the tab dialogs 28 
Determination of the scan height 31 

4.4 Inserting models in occlusion 

The tab dialog depends on the scan mode and the scanner. A vestibular 
scan follows for bite registration purposes follows in all cases. 

4.4.1 Two models in occlusion 

Scan mode: “Two models in occlusion” 

After selecting the tab, Aadva Scan asks you to insert the non-articulated 
models together. 

Information on positioning can be found in the Operating Manual. 

4.4.2 Articulator 

Scan mode: “Articulator […]” 

The articulator scan with a physical articulator requires a scanner from the 
Vinyl series and achieves a result with a condylar reference. 

The scan mode “Articulator” achieves an average-quality result. 

Upper jaw  

Lower jaw  

More 

Vestibular

Smart occlusion � Error!

Bookmark not defined. 
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5. To turn the scan object 90° to the left or right, click on the 90° icons.

� The dashed white line must be perfectly centred in the area to be 
scanned. 

6. To reset the scan height to the default, click “Undo”.

4.3 Inserting a jaw model 

After selecting a tab, Aadva Scan asks you to insert the corresponding jaw 
model. The tooth chart is displayed according to the project definition. 

Information on inserting can be found in the Operating Manual. 

General functions in the tab dialogs 28 
Determination of the scan height 31 

4.4 Inserting models in occlusion 

The tab dialog depends on the scan mode and the scanner. A vestibular 
scan follows for bite registration purposes follows in all cases. 

4.4.1 Two models in occlusion 

Scan mode: “Two models in occlusion” 

After selecting the tab, Aadva Scan asks you to insert the non-articulated 
models together. 

Information on positioning can be found in the Operating Manual. 

4.4.2 Articulator 

Scan mode: “Articulator […]” 

The articulator scan with a physical articulator requires a scanner from the 
Vinyl series and achieves a result with a condylar reference. 

The scan mode “Articulator” achieves an average-quality result. 

Upper jaw  

Lower jaw  

More 

Vestibular

Smart occlusion � Error!

Bookmark not defined. 
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5. To turn the scan object 90° to the left or right, click on the 90° icons.

� The dashed white line must be perfectly centred in the area to be 
scanned. 

6. To reset the scan height to the default, click “Undo”.

4.3 Inserting a jaw model 

After selecting a tab, Aadva Scan asks you to insert the corresponding jaw 
model. The tooth chart is displayed according to the project definition. 

Information on inserting can be found in the Operating Manual. 

General functions in the tab dialogs 28 
Determination of the scan height 31 

4.4 Inserting models in occlusion 

The tab dialog depends on the scan mode and the scanner. A vestibular 
scan follows for bite registration purposes follows in all cases. 

4.4.1 Two models in occlusion 

Scan mode: “Two models in occlusion” 

After selecting the tab, Aadva Scan asks you to insert the non-articulated 
models together. 

Information on positioning can be found in the Operating Manual. 

4.4.2 Articulator 

Scan mode: “Articulator […]” 

The articulator scan with a physical articulator requires a scanner from the 
Vinyl series and achieves a result with a condylar reference. 

The scan mode “Articulator” achieves an average-quality result. 

Upper jaw  

Lower jaw  

More 

Vestibular

Smart occlusion � Error!

Bookmark not defined. 
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5. To turn the scan object 90° to the left or right, click on the 90° icons.

� The dashed white line must be perfectly centred in the area to be 
scanned. 

6. To reset the scan height to the default, click “Undo”.

4.3 Inserting a jaw model 

After selecting a tab, Aadva Scan asks you to insert the corresponding jaw 
model. The tooth chart is displayed according to the project definition. 

Information on inserting can be found in the Operating Manual. 

General functions in the tab dialogs 28 
Determination of the scan height 31 

4.4 Inserting models in occlusion 

The tab dialog depends on the scan mode and the scanner. A vestibular 
scan follows for bite registration purposes follows in all cases. 

4.4.1 Two models in occlusion 

Scan mode: “Two models in occlusion” 

After selecting the tab, Aadva Scan asks you to insert the non-articulated 
models together. 

Information on positioning can be found in the Operating Manual. 

4.4.2 Articulator 

Scan mode: “Articulator […]” 

The articulator scan with a physical articulator requires a scanner from the 
Vinyl series and achieves a result with a condylar reference. 

The scan mode “Articulator” achieves an average-quality result. 

Upper jaw  

Lower jaw  

More 

Vestibular

Smart occlusion � Error!

Bookmark not defined. 

Auto-articulation
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		  4.4.2	 Articulator

Scan mode: “Articulator […]”
The articulator scan with a physical articulator requires a scanner from the Vinyl series and achieves a result 
with a condylar reference.
The scan mode “Articulator” achieves an average-quality result.

TIP

A different articulator system than in the project definition can be selected in the tab dialog.

Insert the articulator

After selecting the tab, Aadva Scan asks you to insert the articulator.

Scanning
1.	 Follow the software instructions.
	 Æ	 After the articulator scan, Aadva Scan asks you to remove the articulator.

2.	 Comply immediately with this instruction.

NOTICE

	 Incorrectly positioned articulators can slip off the system plate and cause damage to the device 
or the scan object. Insert and remove the articulator immediately when prompted.

		  4.4.3	 Smart occlusion

The smart occlusion is:
	 a calculation of the vestibular scan based on the scans of the upper and lower jaw
	 possible with models and full impressions
	 Indications: single crown, facings, inlays, onlays, birdges up to 4 units implant or tooth born.

The upper and lower jaw must have been scanned previously. A scan of the occlusal model or articulator is 
not necessary. 

Prerequisites

Scans:	 The scan of the upper and lower jaw has been performed.
Occlusion:	 Occlusion is suitable for smart occlusion.

1.	 Start the smart occlusion.
	 Æ	 Aadva Scan matches all tabs and calculates the occlusion.

2.	 Please check whether the occlusion was calculated correctly. If not, cancel the process and repeat the 
smart occlusion. A manual alignment is not possible.

Possible causes of errors
	 The occlusion is not suitable for smart occlusion. Carry out a vestibular scan (with an occlusal model or 

an articulator).
	 The wrong articulator was selected as scan mode. Define a new project.
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TIP 
The file names in Aadva Scan projects indicate which Globalscan strategy 
was used to scan, e.g.: 2019-07-03-101351-
upperjaw_#A190703101459_GlobalEnhanced_w90h-60.pcm 

HR mode 

¾ Toggle switch, available on scanners with high-resolution cameras 
¾ HR enabled (ON): highest resolution of the scanner camera, more 

precise results, longer scan times. 

Procedure 

1. Click the OFF icon.

2. Start the scan.

� The scan is carried out once with a lower camera resolution and a 
shorter scan time. “OFF” is not saved. 

NOTICE 

w The HR mode requires a lot of computing power and memory. 
Use a PC that meets the recommended system requirements for 
Aadva Scan. 

Start | Cancel 

A tab dialog can be confirmed with Start or Next if the scan object is 
positioned inside the scanner and the settings are correct. The result is 
displayed in the 3D viewer of the tab. 

A tab dialog can be cancelled without editing the task (scanning, 
presentation). The tab remains empty. You can cancel the scan if, for 
example, the project definition was created incorrectly. 

� Error! Bookmark not defined.

ON / OFF 

u 

r
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TIP 
The file names in Aadva Scan projects indicate which Globalscan strategy 
was used to scan, e.g.: 2019-07-03-101351-
upperjaw_#A190703101459_GlobalEnhanced_w90h-60.pcm 

HR mode 

¾ Toggle switch, available on scanners with high-resolution cameras 
¾ HR enabled (ON): highest resolution of the scanner camera, more 

precise results, longer scan times. 

Procedure 

1. Click the OFF icon.

2. Start the scan.

� The scan is carried out once with a lower camera resolution and a 
shorter scan time. “OFF” is not saved. 

NOTICE 

w The HR mode requires a lot of computing power and memory. 
Use a PC that meets the recommended system requirements for 
Aadva Scan. 

Start | Cancel 

A tab dialog can be confirmed with Start or Next if the scan object is 
positioned inside the scanner and the settings are correct. The result is 
displayed in the 3D viewer of the tab. 

A tab dialog can be cancelled without editing the task (scanning, 
presentation). The tab remains empty. You can cancel the scan if, for 
example, the project definition was created incorrectly. 

� Error! Bookmark not defined.

ON / OFF 
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TIP 
The file names in Aadva Scan projects indicate which Globalscan strategy 
was used to scan, e.g.: 2019-07-03-101351-
upperjaw_#A190703101459_GlobalEnhanced_w90h-60.pcm 

HR mode 

¾ Toggle switch, available on scanners with high-resolution cameras 
¾ HR enabled (ON): highest resolution of the scanner camera, more 

precise results, longer scan times. 

Procedure 

1. Click the OFF icon.

2. Start the scan.

� The scan is carried out once with a lower camera resolution and a 
shorter scan time. “OFF” is not saved. 

NOTICE 

w The HR mode requires a lot of computing power and memory. 
Use a PC that meets the recommended system requirements for 
Aadva Scan. 

Start | Cancel 

A tab dialog can be confirmed with Start or Next if the scan object is 
positioned inside the scanner and the settings are correct. The result is 
displayed in the 3D viewer of the tab. 

A tab dialog can be cancelled without editing the task (scanning, 
presentation). The tab remains empty. You can cancel the scan if, for 
example, the project definition was created incorrectly. 

� Error! Bookmark not defined.
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4.5	 Presentation segments (singleDie or secondDie)
A presentation of individual segments (including implant segments) is used to scan the interdental areas. 
The presentation starts automatically after the jaw scan or scan body scan.

singleDie:	 Scan of every single tooth position
secondDie:	 Scan of every other tooth position, a maximum of two scans for one jaw

1.	 Remove any teeth that are not listed or color-coded.

2.	 With Next, the presented stumps is scanned and added to the scan of the jaw model.

4.6	 Presentation segments (multiDie)
A presentation of individual segments is used to scan the interdental areas (not possible for scan body 
segments). The presentation starts automatically after the jaw scan.
 	
multiDie  
A new multiDie tab is displayed in the project.

Scanner accessories: multiDie adapter.

	 Insert the required segments into the multiDie adapter:
	 1 - 3 segments:	 Slots 2, 5 and 8
	 > 3 segments:	 You can select the slots freely

TIP
Recognizing the positions of the slots on the multiDie adapter: 
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TIP 
Recognizing the positions of the slots on the multiDie adapter:

General functions in the tab dialogs 28 
Determination of the scan height 31 
Presentation with multiDie 47 

4.7 Inserting multiCase segments 

When starting a multiCase project, Aadva Scan requests the insertion of 
the multiCase adapter. 

Scanner accessories: multiDie adapter 

w Use the slots marked in dark grey. You can arrange the segments in 
any order you like. Leave space between the segments. 

� Slots marked in light grey are not scanned. 

4.8 Inserting an impression 

Scan mode: “Impression”; “Two impressions in occlusion” 

Presentation: “Impression” for one or both jaws 
“Impression”, “complete jaw” or “complete jaw fast” is possible for the 
opposing jaw. A jaw scan with the presentation of individual segments is 
not possible. 

Scanner accessories: universal plate 

After selecting the tab, Aadva Scan asks you to insert the universal plate. 

Workflows 13 

General functions in the tab dialogs 28 

Determination of the scan height 31 

Registration/assignment (alignment) 44 

�

More 

 Insertion of tooth models 

Upper jaw

Lower jaw 

 Inserting the impression 

More 

4.7	 Inserting multiCase segments
When starting a multiCase project, Aadva Scan requests the insertion of the multiCase adapter.
Insertion of tooth models

Scanner accessories: multiDie adapter

	 Use the slots marked in dark grey. You can arrange the segments in any order you like. Leave space 
between the segments.

	 Æ	 Slots marked in light grey are not scanned. 

4.8	 Inserting an impression
 	

Scan mode: “Impression”; “Two impressions in occlusion”

Presentation: “Impression” for one or both jaws

“Impression”, “complete jaw” or “complete jaw fast” is possible for the opposing jaw. 
A jaw scan with the presentation of individual segments is not possible.

Scanner accessories: universal plate
After selecting the tab, Aadva Scan asks you to insert the universal plate.
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TIP 
The file names in Aadva Scan projects indicate which Globalscan strategy 
was used to scan, e.g.: 2019-07-03-101351-
upperjaw_#A190703101459_GlobalEnhanced_w90h-60.pcm 

HR mode 

¾ Toggle switch, available on scanners with high-resolution cameras 
¾ HR enabled (ON): highest resolution of the scanner camera, more 

precise results, longer scan times. 

Procedure 

1. Click the OFF icon.

2. Start the scan.

� The scan is carried out once with a lower camera resolution and a 
shorter scan time. “OFF” is not saved. 

NOTICE 

w The HR mode requires a lot of computing power and memory. 
Use a PC that meets the recommended system requirements for 
Aadva Scan. 

Start | Cancel 

A tab dialog can be confirmed with Start or Next if the scan object is 
positioned inside the scanner and the settings are correct. The result is 
displayed in the 3D viewer of the tab. 

A tab dialog can be cancelled without editing the task (scanning, 
presentation). The tab remains empty. You can cancel the scan if, for 
example, the project definition was created incorrectly. 

� Error! Bookmark not defined.

ON / OFF 

u 

r
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2. Please check whether the occlusion was calculated correctly. If not,
cancel the process and repeat the smart occlusion. A manual alignment
is not possible.

Possible causes of errors 

¾ The occlusion is not suitable for smart occlusion. Carry out a vestibular 
scan (with an occlusal model or an articulator). 

¾ The wrong articulator was selected as scan mode. Define a new project. 

General functions in the tab dialogs 28 
Determination of the scan height 31 

4.5 Presentation segments (singleDie or secondDie) 

A presentation of individual segments (including implant segments) is used 
to scan the interdental areas. The presentation starts automatically after 
the jaw scan or scan body scan. 

singleDie: Scan of every single tooth position 
secondDie: Scan of every other tooth position, a maximum of two 

scans for one jaw 

1. Remove any teeth that are not listed or color-coded.

2. With Next, the presented stumps is scanned and added to the scan of
the jaw model.

4.6 Presentation segments (multiDie) 

A presentation of individual segments is used to scan the interdental areas 
(not possible for scan body segments). The presentation starts 
automatically after the jaw scan. 

A new multiDie tab is displayed in the project. 

Scanner accessories: multiDie adapter. 

w Insert the required segments into the multiDie adapter: 

¾ 1 - 3 segments: Slots 2, 5 and 8 
¾ > 3 segments: You can select the slots freely 

r

More 

�u 

multiDie  

 Insertion of tooth models 

 Insertion 
of tooth models
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TIP 
Recognizing the positions of the slots on the multiDie adapter:

General functions in the tab dialogs 28 
Determination of the scan height 31 
Presentation with multiDie 47 

4.7 Inserting multiCase segments 

When starting a multiCase project, Aadva Scan requests the insertion of 
the multiCase adapter. 

Scanner accessories: multiDie adapter 

w Use the slots marked in dark grey. You can arrange the segments in 
any order you like. Leave space between the segments. 

� Slots marked in light grey are not scanned. 

4.8 Inserting an impression 

Scan mode: “Impression”; “Two impressions in occlusion” 

Presentation: “Impression” for one or both jaws 
“Impression”, “complete jaw” or “complete jaw fast” is possible for the 
opposing jaw. A jaw scan with the presentation of individual segments is 
not possible. 

Scanner accessories: universal plate 

After selecting the tab, Aadva Scan asks you to insert the universal plate. 

Workflows 13 

General functions in the tab dialogs 28 

Determination of the scan height 31 

Registration/assignment (alignment) 44 

�

More 

 Insertion of tooth models 

Upper jaw

Lower jaw 

 Inserting the impression 

More 

Inserting 
the impression
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4.9	 Inserting a Triple Tray® impression
When starting a project with the scan mode Triple Tray®, Aadva Scan asks you to insert the impression of 
the upper jaw.

Scanner accessories: Triple Tray® impression holder

1.	 Insert the requested impression facing up.
	 Æ	 The top is scanned.

For the opposing jaw, Aadva Scan asks for the other side of the Triple Tray® impression.
The workflow is guided (predefined sequence, mandatory completion).

NOTICE

	 The scan mode Triple Tray® requires a lot of computing power and memory. 
Use a PC that meets the recommended system requirements for Aadva Scan.

4.10	 Insertion of a BDKey®
When starting a project with the scan mode Baltic Denture, Aadva Scan asks you to insert the BDKey®.

Scanner accessories: BDKey® holder, impression holder Triple Tray® (bottom part)

1.	 Attach the BDKey® with the BDKey® Lock (Baltic Denture accessory).

2.	 Fasten the BDKey® inside the BDKey® holder on the bottom part of the impression holder, 
	 with the upper jaw side up.
	 Æ	 The top is scanned.

3.	 When Aadva Scan asks for the lower jaw, turn the BDKey® holder.
	 The workflow is guided (predefined sequence, mandatory completion).

4.11	 Inserting a Twin Tray model
When starting a project with the scan mode Twin Tray, Aadva Scan requests the insertion of the closed twin 
tray model to proceed with the vestibular scan.
 Inserting a Twin Tray Model

 
Scanner accessories: 4 teeth bar, universal plate

1.	 Fasten the Twin Tray model crosswise on the universal plate. This allows you to adjust the scan height 
better.

	 Æ	 After the vestibular scan, Aadva Scan requests the insertion of the open model and the segments.
 
2.	 Fasten all parts lengthways on the universal plate. Place the 4 teeth bar in the middle, even if there is no 

segment to be presented.

The workflow is guided (predefined sequence, mandatory completion). Rescans are possible, bur 	
cutting only after registration and matching.

NOTICE
The scan mode Twin Tray requires a lot of computing power and memory. Use a PC that meets the 
recommended system requirements for Aadva Scan.

Inserting  
the BDKey

Inserting 
the impression
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General functions in the tab dialogs 28 
Registration/assignment (alignment) 44 

4.11 Inserting a Twin Tray model 

When starting a project with the scan mode Twin Tray, Aadva Scan 
requests the insertion of the closed twin tray model to proceed with the 
vestibular scan. 

Scanner accessories: 4 teeth bar, universal plate 

1. Fasten the Twin Tray model crosswise on the universal plate. This
allows you to adjust the scan height better.

� After the vestibular scan, Aadva Scan requests the insertion of the open 
model and the segments. 

2. Fasten all parts lengthways on the universal plate. Place the 4 teeth bar
in the middle, even if there is no segment to be presented.

The workflow is guided (predefined sequence, mandatory completion). 
Rescans are possible, bur cutting only after registration and matching. 

NOTICE 

w The scan mode Twin Tray requires a lot of computing power and 
memory. Use a PC that meets the recommended system requirements 
for Aadva Scan. 

General functions in the tab dialogs 28 
Determination of the scan height 31 
Registration/assignment (alignment) 44 

Rescan 56 

4.12 Squeeze bite, gingiva, wax-up, situ, scanbody 

In addition to a jaw scan, further tabs are displayed in the project for the 
corresponding indications. 

¾ Aesthetic template 
for toothless jaws 

¾ Squeeze bite 
as a representative of the opposing jaw in the scan mode “Single Jaw” 

¾ Gingiva, Wax-up and Situ 
for segments with the corresponding identification 

 Inserting a Twin Tray Model 

More 

Project definition 
Patient 

Gingiva  

Gingiva
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General functions in the tab dialogs 28 
Registration/assignment (alignment) 44 

4.11 Inserting a Twin Tray model 

When starting a project with the scan mode Twin Tray, Aadva Scan 
requests the insertion of the closed twin tray model to proceed with the 
vestibular scan. 

Scanner accessories: 4 teeth bar, universal plate 

1. Fasten the Twin Tray model crosswise on the universal plate. This
allows you to adjust the scan height better.

� After the vestibular scan, Aadva Scan requests the insertion of the open 
model and the segments. 

2. Fasten all parts lengthways on the universal plate. Place the 4 teeth bar
in the middle, even if there is no segment to be presented.

The workflow is guided (predefined sequence, mandatory completion). 
Rescans are possible, bur cutting only after registration and matching. 

NOTICE 

w The scan mode Twin Tray requires a lot of computing power and 
memory. Use a PC that meets the recommended system requirements 
for Aadva Scan. 

General functions in the tab dialogs 28 
Determination of the scan height 31 
Registration/assignment (alignment) 44 

Rescan 56 

4.12 Squeeze bite, gingiva, wax-up, situ, scanbody 

In addition to a jaw scan, further tabs are displayed in the project for the 
corresponding indications. 

¾ Aesthetic template 
for toothless jaws 

¾ Squeeze bite 
as a representative of the opposing jaw in the scan mode “Single Jaw” 

¾ Gingiva, Wax-up and Situ 
for segments with the corresponding identification 

 Inserting a Twin Tray Model 

More 

Project definition 
Patient 

Gingiva  

Gingiva
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4.12	 Squeeze bite, gingiva, wax-up, situ, scanbody
In addition to a jaw scan, further tabs are displayed in the project for the corresponding indications.

	 Aesthetic template
	 for toothless jaws

	 Squeeze bite
	 as a representative of the opposing jaw in the scan mode “Single Jaw”

	 Gingiva, Wax-up and Situ
	 for segments with the corresponding identification

After selecting the tab, Aadva Scan asks you to insert the jaw model with the appropriate addition.

Scanbody scans

For the preparation “Implant”, Aadva Scan requests an additional jaw scan (with scan bodies) 
and a presentation of the implant segments with scan body.

	 Attach the scan bodies according to the instructions of the manufacturer.

4.13	 Inserting a universal object
When starting a universal scan, Aadva Scan asks you to insert an object (item).
Title of the tab dialog = Project name

Scanner accessories: Universal plate

	 Fasten the universal object securely and motionless on the universal plate.
Æ	 The universal object must lie completely within the measuring field, the side to be scanned facing up.

4.14	 Inserting a correction model
When starting a correction scan, Aadva Scan asks you to insert a correction model. 

	 Remove all those segments that are not needed for the correction from the correction model.
	 Æ	 The purpose of the correction scan is to replace defective parts of another scan.
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General functions in the tab dialogs 28 
Registration/assignment (alignment) 44 

4.11 Inserting a Twin Tray model 

When starting a project with the scan mode Twin Tray, Aadva Scan 
requests the insertion of the closed twin tray model to proceed with the 
vestibular scan. 

Scanner accessories: 4 teeth bar, universal plate 

1. Fasten the Twin Tray model crosswise on the universal plate. This
allows you to adjust the scan height better.

� After the vestibular scan, Aadva Scan requests the insertion of the open 
model and the segments. 

2. Fasten all parts lengthways on the universal plate. Place the 4 teeth bar
in the middle, even if there is no segment to be presented.

The workflow is guided (predefined sequence, mandatory completion). 
Rescans are possible, bur cutting only after registration and matching. 

NOTICE 

w The scan mode Twin Tray requires a lot of computing power and 
memory. Use a PC that meets the recommended system requirements 
for Aadva Scan. 

General functions in the tab dialogs 28 
Determination of the scan height 31 
Registration/assignment (alignment) 44 

Rescan 56 

4.12 Squeeze bite, gingiva, wax-up, situ, scanbody 

In addition to a jaw scan, further tabs are displayed in the project for the 
corresponding indications. 

¾ Aesthetic template 
for toothless jaws 

¾ Squeeze bite 
as a representative of the opposing jaw in the scan mode “Single Jaw” 

¾ Gingiva, Wax-up and Situ 
for segments with the corresponding identification 

 Inserting a Twin Tray Model 

More 

Project definition 
Patient 

Gingiva  

Gingiva

Project definition
Patient

 Insertion 
of tooth models

Inserting Objects 
(Universal Mode)
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5	 Hybrid Scan
Model scanning tends to miss crucial areas of detail – typically the interproximal regions but also the retracted gingival 
sulcus around a crown preparation. To solve this, the model is physically trimmed and sectioned, allowing individual 
crown preparations to be scanned and re-aligned to the original model. However, model sectioning is undesirable as 
it adds time and cost and introduces errors such as shaving through contact points and loose pins in the model. It 
would be preferable to merge scans of the impression (scanned when received by the dental laboratory) and the 
subsequent scan of the poured model. This negates the need for model sectioning or trimming. For these reasons, the 
Hybrid scan was developed.

1.	 To start the hybrid scan, “one stone model” must be set as the scan mode. The “Hybrid Scan” option now appears 
as Presentation mode. Of course, this feature can be used for the upper and lower jaw at the same time.

      Example for upper jaw:
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5 Hybrid Scan 

Model scanning tends to miss crucial areas of detail – typically the 
interproximal regions but also the retracted gingival sulcus around a 
crown preparation. To solve this, the model is physically trimmed and 
sectioned, allowing individual crown preparations to be scanned and 
re-aligned to the original model. However, model sectioning is 
undesirable as it adds time and cost and introduces errors such as 
shaving through contact points and loose pins in the model. It would 
be preferable to merge scans of the impression (scanned when 
received by the dental laboratory) and the subsequent scan of the 
poured model. This negates the need for model sectioning or 
trimming. For these reasons, the Hybrid scan was developed. 

1. To start the hybrid scan, “one stone model” must be set as the scan
mode. The "Hybrid Scan" option now appears as Presentation
mode. Of course, this feature can be used for the upper and lower
jaw at the same time.

Example for upper jaw:

2. Start with the scan of the impression

3. Now cast the model and then scan it.

u 

 

2.	 Start with the scan of the impression 

3.	 Now cast the model and then scan it.
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5 Hybrid Scan 

Model scanning tends to miss crucial areas of detail – typically the 
interproximal regions but also the retracted gingival sulcus around a 
crown preparation. To solve this, the model is physically trimmed and 
sectioned, allowing individual crown preparations to be scanned and 
re-aligned to the original model. However, model sectioning is 
undesirable as it adds time and cost and introduces errors such as 
shaving through contact points and loose pins in the model. It would 
be preferable to merge scans of the impression (scanned when 
received by the dental laboratory) and the subsequent scan of the 
poured model. This negates the need for model sectioning or 
trimming. For these reasons, the Hybrid scan was developed. 

1. To start the hybrid scan, “one stone model” must be set as the scan
mode. The "Hybrid Scan" option now appears as Presentation
mode. Of course, this feature can be used for the upper and lower
jaw at the same time.

Example for upper jaw:

2. Start with the scan of the impression

3. Now cast the model and then scan it.

u 

 
4.	 Manual positioning: Align both objects in identical viewing direction. 
	 Place one point per object at the same position with a “left click”. 
	 Further points can be added with “Ctrl” + “left click”. Click “Continue” to check the result.

5.	 Please verify the registration. In case of misalignment, click the impression to restart the registration process. Start 
the hybrid Scan Processing with the continue button.

6.	 Please review the result. 
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4. Manual positioning: Align both objects in identical viewing
direction.

Place one point per object at the same position with a “left click”.
Further points can be added with “Ctrl” + “left click”. Click “Continue”
to check the result.

5. Please verify the registration. In case of misalignment, click the
impression to restart the registration process. Start the hybrid Scan
Processing with the continue button.

6. Please review the result.
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TIP 
The file names in Aadva Scan projects indicate which Globalscan strategy 
was used to scan, e.g.: 2019-07-03-101351-
upperjaw_#A190703101459_GlobalEnhanced_w90h-60.pcm 

HR mode 

¾ Toggle switch, available on scanners with high-resolution cameras 
¾ HR enabled (ON): highest resolution of the scanner camera, more 

precise results, longer scan times. 

Procedure 

1. Click the OFF icon.

2. Start the scan.

� The scan is carried out once with a lower camera resolution and a 
shorter scan time. “OFF” is not saved. 

NOTICE 

w The HR mode requires a lot of computing power and memory. 
Use a PC that meets the recommended system requirements for 
Aadva Scan. 

Start | Cancel 

A tab dialog can be confirmed with Start or Next if the scan object is 
positioned inside the scanner and the settings are correct. The result is 
displayed in the 3D viewer of the tab. 

A tab dialog can be cancelled without editing the task (scanning, 
presentation). The tab remains empty. You can cancel the scan if, for 
example, the project definition was created incorrectly. 

� Error! Bookmark not defined.

ON / OFF 

u 

r

Inserting a 
Triple Tray® impression
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6	 Workflow functions
6.1	 2D scans for presentations

A 2D scan is a black and white photo seen from above. The 2D scan is used to mark the exact position of all 
indexed teeth. Aadva Scan requires a 2D scan for the preparation of 3D jaw scans (presentation mode 
secondDie, singleDie).

2D scan with markers

In the photo, boxes mark the estimated position (colors according to the indication, neighbouring segments 
connected by a line).
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6 Workflow functions 

6.1 2D scans for presentations 

A 2D scan is a black and white photo seen from above. The 2D scan is used 
to mark the exact position of all indexed teeth. Aadva Scan requires a 
2D scan for the preparation of 3D jaw scans (presentation mode 
secondDie, singleDie). 

2D scan with markers 

In the photo, boxes mark the estimated position (colors according to the 
indication, neighbouring segments connected by a line). 

TIP 
Allow the tooth numbers to be displayed as a guide. 
The boxes allow you to see which stump needs to be presented 
(filled = presented; not filled = not presented). 

If you change the setting with the 2D viewer open, click the photo to 
refresh the view. 

�
� 75

TIP
Allow the tooth numbers to be displayed as a guide.
The boxes allow you to see which stump needs to be presented 
(filled = presented; not filled = not presented).
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6 Workflow functions 

6.1 2D scans for presentations 

A 2D scan is a black and white photo seen from above. The 2D scan is used 
to mark the exact position of all indexed teeth. Aadva Scan requires a 
2D scan for the preparation of 3D jaw scans (presentation mode 
secondDie, singleDie). 

2D scan with markers 

In the photo, boxes mark the estimated position (colors according to the 
indication, neighbouring segments connected by a line). 

TIP 
Allow the tooth numbers to be displayed as a guide. 
The boxes allow you to see which stump needs to be presented 
(filled = presented; not filled = not presented). 

If you change the setting with the 2D viewer open, click the photo to 
refresh the view. 

�
� 75

If you change the setting with the 2D viewer open, click the photo to refresh the view.

Moving all markers

This method is used for the rough alignment of the entire positioning.
 
1.	 Click with the right and left mouse button together on any box and keep both mouse buttons pressed.

2.	 Drag the markers to the correct position in the photo.

dental Scan Software

Version: 3.4 10-2021 Error! Use the Home tab to apply Überschrift 1 to the text that you want to appear here.43 

Moving all markers 

This method is used for the rough alignment of the entire positioning. 

1. Click with the right and left mouse button together on any box and
keep both mouse buttons pressed.

2. Drag the markers to the correct position in the photo.

3. Release the mouse button when the target position has been reached.

� All markers are moved. 

Moving individual markers 

This method is used for the precision alignment of individual markers. 

1. Click with the left mouse button on a marker and keep it pressed.

2. Drag the marker to the correct position in the photo.

3. Release the mouse button when the marker in the photo is on the
centre of the tooth.
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3.	 Release the mouse button when the target position has been reached.
	 Æ	 All markers are moved.

Moving individual markers

This method is used for the precision alignment of individual markers.
 
1.	 Click with the left mouse button on a marker and keep it pressed.

2.	 Drag the marker to the correct position in the photo.
 

3.	 Release the mouse button when the marker in the photo is on the centre of the tooth.

	 6.2	 Registration and alignment
Alignment (combination)

Several scans can be wholly or partially combined, e.g. a universal scan can be combined with an additional 
scan to form a complete 3D model.

Registration

The relative position of two scans to each other is determined, e.g. the position of the upper and lower jaw 
with a vestibular scan (bite registration).

Automatic calculation

If there is enough data available, Aadva Scan calculates the registration or alignment/assignment 
automatically. 
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Manual alignment

If there is not enough data available for an automatic calculation or if the automatic calculation needs to be 
corrected, manual alignment is carried out.

		  6.2.1	 “Assignment” tabs for registration and alignment

Tab Function Automatic Manual
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6.2 Registration and alignment 

Alignment (combination) 

Several scans can be wholly or partially combined, e.g. a universal scan can 
be combined with an additional scan to form a complete 3D model. 

Registration 

The relative position of two scans to each other is determined, e.g. the 
position of the upper and lower jaw with a vestibular scan (bite 
registration). 

Automatic calculation 

If there is enough data available, Aadva Scan calculates the registration or 
alignment/assignment automatically.  

Manual alignment 

If there is not enough data available for an automatic calculation or if the 
automatic calculation needs to be corrected, manual alignment is carried 
out. 

6.2.1 “Assignment” tabs for registration and alignment 

Tab Function Automatic Manual 

Vestibular Vestibular scan (bite) � �

Registration Scan mode 
Baltic Denture (bite) � ➖"# 

Registration Scan mode 
Triple Tray® � ➖"# 

Registration Scan mode 
Twin Tray � � 

multiDie multiDie 
presentation � �

Correction Correction scan ➖"# �

Mesh combination 
(additional scan) ➖"# �

Method 

� possible

➖"# not possible
Vestibular scan (bite)
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6.2 Registration and alignment 

Alignment (combination) 

Several scans can be wholly or partially combined, e.g. a universal scan can 
be combined with an additional scan to form a complete 3D model. 

Registration 

The relative position of two scans to each other is determined, e.g. the 
position of the upper and lower jaw with a vestibular scan (bite 
registration). 

Automatic calculation 

If there is enough data available, Aadva Scan calculates the registration or 
alignment/assignment automatically.  

Manual alignment 

If there is not enough data available for an automatic calculation or if the 
automatic calculation needs to be corrected, manual alignment is carried 
out. 

6.2.1 “Assignment” tabs for registration and alignment 

Tab Function Automatic Manual 

Vestibular Vestibular scan (bite) � �

Registration Scan mode 
Baltic Denture (bite) � ➖"# 

Registration Scan mode 
Triple Tray® � ➖"# 

Registration Scan mode 
Twin Tray � � 

multiDie multiDie 
presentation � �

Correction Correction scan ➖"# �

Mesh combination 
(additional scan) ➖"# �

Method 

� possible

➖"# not possible

Scan mode Baltic 
Denture (bite)
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6.2 Registration and alignment 

Alignment (combination) 

Several scans can be wholly or partially combined, e.g. a universal scan can 
be combined with an additional scan to form a complete 3D model. 

Registration 

The relative position of two scans to each other is determined, e.g. the 
position of the upper and lower jaw with a vestibular scan (bite 
registration). 

Automatic calculation 

If there is enough data available, Aadva Scan calculates the registration or 
alignment/assignment automatically.  

Manual alignment 

If there is not enough data available for an automatic calculation or if the 
automatic calculation needs to be corrected, manual alignment is carried 
out. 

6.2.1 “Assignment” tabs for registration and alignment 

Tab Function Automatic Manual 

Vestibular Vestibular scan (bite) � �

Registration Scan mode 
Baltic Denture (bite) � ➖"# 

Registration Scan mode 
Triple Tray® � ➖"# 

Registration Scan mode 
Twin Tray � � 

multiDie multiDie 
presentation � �

Correction Correction scan ➖"# �

Mesh combination 
(additional scan) ➖"# �

Method 

� possible

➖"# not possible

Scan mode Triple 
Tray®
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6.2 Registration and alignment 

Alignment (combination) 

Several scans can be wholly or partially combined, e.g. a universal scan can 
be combined with an additional scan to form a complete 3D model. 

Registration 

The relative position of two scans to each other is determined, e.g. the 
position of the upper and lower jaw with a vestibular scan (bite 
registration). 

Automatic calculation 

If there is enough data available, Aadva Scan calculates the registration or 
alignment/assignment automatically.  

Manual alignment 

If there is not enough data available for an automatic calculation or if the 
automatic calculation needs to be corrected, manual alignment is carried 
out. 

6.2.1 “Assignment” tabs for registration and alignment 

Tab Function Automatic Manual 

Vestibular Vestibular scan (bite) � �

Registration Scan mode 
Baltic Denture (bite) � ➖"# 

Registration Scan mode 
Triple Tray® � ➖"# 

Registration Scan mode 
Twin Tray � � 

multiDie multiDie 
presentation � �

Correction Correction scan ➖"# �

Mesh combination 
(additional scan) ➖"# �

Method 

� possible

➖"# not possible

Scan mode Twin Tray
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6.2 Registration and alignment 

Alignment (combination) 

Several scans can be wholly or partially combined, e.g. a universal scan can 
be combined with an additional scan to form a complete 3D model. 

Registration 

The relative position of two scans to each other is determined, e.g. the 
position of the upper and lower jaw with a vestibular scan (bite 
registration). 

Automatic calculation 

If there is enough data available, Aadva Scan calculates the registration or 
alignment/assignment automatically.  

Manual alignment 

If there is not enough data available for an automatic calculation or if the 
automatic calculation needs to be corrected, manual alignment is carried 
out. 

6.2.1 “Assignment” tabs for registration and alignment 

Tab Function Automatic Manual 

Vestibular Vestibular scan (bite) � �

Registration Scan mode 
Baltic Denture (bite) � ➖"# 

Registration Scan mode 
Triple Tray® � ➖"# 

Registration Scan mode 
Twin Tray � � 

multiDie multiDie 
presentation � �

Correction Correction scan ➖"# �

Mesh combination 
(additional scan) ➖"# �

Method 

� possible

➖"# not possible

multiDie
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6.2 Registration and alignment 

Alignment (combination) 

Several scans can be wholly or partially combined, e.g. a universal scan can 
be combined with an additional scan to form a complete 3D model. 

Registration 

The relative position of two scans to each other is determined, e.g. the 
position of the upper and lower jaw with a vestibular scan (bite 
registration). 

Automatic calculation 

If there is enough data available, Aadva Scan calculates the registration or 
alignment/assignment automatically.  

Manual alignment 

If there is not enough data available for an automatic calculation or if the 
automatic calculation needs to be corrected, manual alignment is carried 
out. 

6.2.1 “Assignment” tabs for registration and alignment 

Tab Function Automatic Manual 

Vestibular Vestibular scan (bite) � �

Registration Scan mode 
Baltic Denture (bite) � ➖"# 

Registration Scan mode 
Triple Tray® � ➖"# 

Registration Scan mode 
Twin Tray � � 

multiDie multiDie 
presentation � �

Correction Correction scan ➖"# �

Mesh combination 
(additional scan) ➖"# �

Method 

� possible

➖"# not possible

Correction scan
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6.2 Registration and alignment 

Alignment (combination) 

Several scans can be wholly or partially combined, e.g. a universal scan can 
be combined with an additional scan to form a complete 3D model. 

Registration 

The relative position of two scans to each other is determined, e.g. the 
position of the upper and lower jaw with a vestibular scan (bite 
registration). 

Automatic calculation 

If there is enough data available, Aadva Scan calculates the registration or 
alignment/assignment automatically.  

Manual alignment 

If there is not enough data available for an automatic calculation or if the 
automatic calculation needs to be corrected, manual alignment is carried 
out. 

6.2.1 “Assignment” tabs for registration and alignment 

Tab Function Automatic Manual 

Vestibular Vestibular scan (bite) � �

Registration Scan mode 
Baltic Denture (bite) � ➖"# 

Registration Scan mode 
Triple Tray® � ➖"# 

Registration Scan mode 
Twin Tray � � 

multiDie multiDie 
presentation � �

Correction Correction scan ➖"# �

Mesh combination 
(additional scan) ➖"# �

Method 

� possible

➖"# not possible

Mesh combination 
(additional scan)

		  6.2.2	 Auto registration

All relevant scans of the project must be created in order to be able to start the auto registration, e.g. those 
of the upper and lower jaw in the vestibular scan (info line in the 3D viewer).

1.	 The scans are automatically registered with Next. A color pattern shows whether the auto registration 
was successful.

	 Example: Vestibular scan with and without single jaws
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6.2.2 Auto registration 

All relevant scans of the project must be created in order to be able to start 
the auto registration, e.g. those of the upper and lower jaw in the 
vestibular scan (� info line in the 3D viewer). 

1. The scans are automatically registered with Next. A color pattern
shows whether the auto registration was successful.

Example: Vestibular scan with and without single jaws

2. Check all sides

3. The auto registration is saved with Next. All scans are matched.

Error 

The auto registration/assignment is incorrect if the preview shows an 
offset. 

1. Correct it manually.

2. With vestibular scans you can repeat the auto registration (delete
matching, then start again).

Delete matching 49 

6.2.3 Manual alignment 

Aadva Scan places both scans in the 3D viewer for manual alignment 
(assignment). Points common to both scans must be marked with a click of 
the mouse. After this, Aadva Scan recalculates the registration. 

TIP 
If the functions of the mouse buttons have been changed, the following 
applies: Double click instead of a single left click. 

1. To correct an auto registration, left click on the scan in the preview (e.g.
jaw in orange).

�u 

� 64

�u 

� 45

More 

�

�
� 77

2.	 Check all sides

3.	 The auto registration is saved with Next. All scans are matched.

Error
The auto registration/assignment is incorrect if the preview shows an offset.

1.	 Correct it manually.

2.	 With vestibular scans you can repeat the auto registration (delete matching, then start again).

		

Method 
 possible

➖ not possible
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TIP 
The file names in Aadva Scan projects indicate which Globalscan strategy 
was used to scan, e.g.: 2019-07-03-101351-
upperjaw_#A190703101459_GlobalEnhanced_w90h-60.pcm 

HR mode 

¾ Toggle switch, available on scanners with high-resolution cameras 
¾ HR enabled (ON): highest resolution of the scanner camera, more 

precise results, longer scan times. 

Procedure 

1. Click the OFF icon.

2. Start the scan.

� The scan is carried out once with a lower camera resolution and a 
shorter scan time. “OFF” is not saved. 

NOTICE 

w The HR mode requires a lot of computing power and memory. 
Use a PC that meets the recommended system requirements for 
Aadva Scan. 

Start | Cancel 

A tab dialog can be confirmed with Start or Next if the scan object is 
positioned inside the scanner and the settings are correct. The result is 
displayed in the 3D viewer of the tab. 

A tab dialog can be cancelled without editing the task (scanning, 
presentation). The tab remains empty. You can cancel the scan if, for 
example, the project definition was created incorrectly. 

� Error! Bookmark not defined.

ON / OFF 

u 

r
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TIP 
The file names in Aadva Scan projects indicate which Globalscan strategy 
was used to scan, e.g.: 2019-07-03-101351-
upperjaw_#A190703101459_GlobalEnhanced_w90h-60.pcm 

HR mode 

¾ Toggle switch, available on scanners with high-resolution cameras 
¾ HR enabled (ON): highest resolution of the scanner camera, more 

precise results, longer scan times. 

Procedure 

1. Click the OFF icon.

2. Start the scan.

� The scan is carried out once with a lower camera resolution and a 
shorter scan time. “OFF” is not saved. 

NOTICE 

w The HR mode requires a lot of computing power and memory. 
Use a PC that meets the recommended system requirements for 
Aadva Scan. 

Start | Cancel 

A tab dialog can be confirmed with Start or Next if the scan object is 
positioned inside the scanner and the settings are correct. The result is 
displayed in the 3D viewer of the tab. 

A tab dialog can be cancelled without editing the task (scanning, 
presentation). The tab remains empty. You can cancel the scan if, for 
example, the project definition was created incorrectly. 

� Error! Bookmark not defined.

ON / OFF 

u 

r
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6.2.3	 Manual alignment

Aadva Scan places both scans in the 3D viewer for manual alignment (assignment). Points common to both 
scans must be marked with a click of the mouse. After this, Aadva Scan recalculates the registration.

 

TIP
If the functions of the mouse buttons have been changed, the following applies: Double click instead of a 
single left click.

1.	 To correct an auto registration, left click on the scan in the preview (e.g. jaw in orange).
	 Æ	 The 3D viewer is split horizontally. 
		  The vestibular scan, for example, is displayed at the top, 
		  the jaw scan or the correction scan at the bottom.

TIP
You can enlarge the upper or lower area of the viewer by moving the dividing line while holding down the 
left mouse button.
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� The 3D viewer is split horizontally. The vestibular scan, for example, is 
displayed at the top, the jaw scan or the correction scan at the bottom. 

TIP 
You can enlarge the upper or lower area of the viewer by moving the 
dividing line while holding down the left mouse button. 

2. Rotate the scans so that the perspectives match:

¾ both together via the View menu 
¾ individually with the mouse (click next to the scan, not on it) 

3. Mark the same point above and below with the left mouse button.

� The points appear marked in color. Pay attention to precise positioning. 

4. You can refine the alignment:

¾ CTRL key + left mouse button for further markings (maximum six in 
other colors) 

¾ Click once on a position to move the closest marker there 
¾ Press the DEL key to delete the mark 

5. Click on Next.

� After the calculation, the 3D viewer shows a two color preview. Repeat 
the steps to make corrections. 

6. Click on Next.

� All scans in the project are matched and the result displayed. The 
manual assignment is done. 

Manual registration multiDie presentation 49 

Correction scan procedure 61 

Mesh combination 64 

�

� 66

u 
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2.	 Rotate the scans so that the perspectives match:
	 both together via the View menu
	 individually with the mouse (click next to the scan, not on it)

 
3.	 Mark the same point above and below with the left mouse button.

Æ	 The points appear marked in color. Pay attention to precise positioning.
4.	 You can refine the alignment:
  

	 CTRL key + left mouse button for further markings (maximum six in other colors)
	 Click once on a position to move the closest marker there

	 	 Press the DEL key to delete the mark
	
5.	 Click on Next.
	 	 	 After the calculation, the 3D viewer shows a two color preview. 
		  Repeat the steps to make corrections.

6.	 Click on Next.
	 	 All scans in the project are matched and the result displayed. 
		  The manual assignment is done.

multiDie 
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TIP 
The file names in Aadva Scan projects indicate which Globalscan strategy 
was used to scan, e.g.: 2019-07-03-101351-
upperjaw_#A190703101459_GlobalEnhanced_w90h-60.pcm 

HR mode 

¾ Toggle switch, available on scanners with high-resolution cameras 
¾ HR enabled (ON): highest resolution of the scanner camera, more 

precise results, longer scan times. 

Procedure 

1. Click the OFF icon.

2. Start the scan.

� The scan is carried out once with a lower camera resolution and a 
shorter scan time. “OFF” is not saved. 

NOTICE 

w The HR mode requires a lot of computing power and memory. 
Use a PC that meets the recommended system requirements for 
Aadva Scan. 

Start | Cancel 

A tab dialog can be confirmed with Start or Next if the scan object is 
positioned inside the scanner and the settings are correct. The result is 
displayed in the 3D viewer of the tab. 

A tab dialog can be cancelled without editing the task (scanning, 
presentation). The tab remains empty. You can cancel the scan if, for 
example, the project definition was created incorrectly. 

� Error! Bookmark not defined.

ON / OFF 

u 
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TIP 
The file names in Aadva Scan projects indicate which Globalscan strategy 
was used to scan, e.g.: 2019-07-03-101351-
upperjaw_#A190703101459_GlobalEnhanced_w90h-60.pcm 

HR mode 

¾ Toggle switch, available on scanners with high-resolution cameras 
¾ HR enabled (ON): highest resolution of the scanner camera, more 

precise results, longer scan times. 

Procedure 

1. Click the OFF icon.

2. Start the scan.

� The scan is carried out once with a lower camera resolution and a 
shorter scan time. “OFF” is not saved. 

NOTICE 

w The HR mode requires a lot of computing power and memory. 
Use a PC that meets the recommended system requirements for 
Aadva Scan. 

Start | Cancel 

A tab dialog can be confirmed with Start or Next if the scan object is 
positioned inside the scanner and the settings are correct. The result is 
displayed in the 3D viewer of the tab. 

A tab dialog can be cancelled without editing the task (scanning, 
presentation). The tab remains empty. You can cancel the scan if, for 
example, the project definition was created incorrectly. 

� Error! Bookmark not defined.

ON / OFF 

u 
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6.3	 Presentation with multiDie
 	
multiDie 

Aadva Scan requests the presentation after the jaw scan and temporarily adds the multiDie tab. Insert the 
segments into the adapter:

If more than twelve segments have to be presented, Aadva Scan requests two multiDie presentations, one 
after the other.

1.	 Insert the requested segments into the multiDie adapter:

2.	 Start the scan.

3.	 Check whether all segments were scanned correctly. If not, you can:
	 	 make corrections (mesh processing functions)
	 	 cancel and repeat the process.

4.	 Start the automatic alignment of the segments on the jaw model.

5.	 Check the result from all sides. Pay attention to the colors.

6.	 Make manual corrections if necessary.

7.	 The jaw scan is recalculated with Next. The multiDie is closed. The presentation is ready.
	 Manual registration multiDie presentation
	 Manual registration can improve the auto registration of the multiDie presentation per segment.

1.	 Click on the segment to be registered manually.

2.	 The 3D viewer is split (jaw scan above, segment below).

3.	 Rotate the jaw scan and the segment so that the perspectives match:
 	 	 both together via the View menu,
	 	 individually with the mouse (click next to the scan, not on it).
 
4.	 Mark the same point above and below with the left mouse button.
	 	 The points appear marked in color. Pay attention to precise positioning.

5.	 You can refine the registration:
  	 	 CTRL key + left mouse button for further markings (maximum six in other colors),
	 	 Click once on a position to move the closest marker there,
	 	 Press the DEL key to delete the mark.

First marking in segment (1) and jaw scan (2):
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First marking in segment (1) and jaw scan (2): 

1 2

� Confirm the registration by clicking on Next. You can: 

¾ register the next presented segment manually, 
¾ end the registration with Next. 

6.4 Matching and project finalization 

Matching is a calculation that uses individual recordings and measured 
values to generate a data set in 3D data format. Matched scans display a 
green tick mark in the tab; unmatched scans display the matching icon. 

Upper jaw   � Upper jaw   

There are several setting options for matching. By default, all scans are 
automatically matched during scanning and when the project is finalized. 

6.4.1 Manual matching 

You can carry out all routine work without manual matching. For special 
work, e.g. an additional scan or a correction scan, you have to match the 
corresponding scan manually. 

In workflows with a vestibular scan, you can only match after the entire 
workflow has been completed. Then all scans are matched together. 

1. Click on the tab whose scan you wish to match.

2. Click on “Matching” in the project control.

� Matching is calculated and the result displayed in the 3D viewer. The 
tab gets a green tick. 

u 

� 85

Upper jaw
�

	 Confirm the registration by clicking on Next. You can:
	 	 register the next presented segment manually,
	 	 end the registration with Next.

	

�u 

multiDie  

 Insertion of tooth models 
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TIP 
The file names in Aadva Scan projects indicate which Globalscan strategy 
was used to scan, e.g.: 2019-07-03-101351-
upperjaw_#A190703101459_GlobalEnhanced_w90h-60.pcm 

HR mode 

¾ Toggle switch, available on scanners with high-resolution cameras 
¾ HR enabled (ON): highest resolution of the scanner camera, more 

precise results, longer scan times. 

Procedure 

1. Click the OFF icon.

2. Start the scan.

� The scan is carried out once with a lower camera resolution and a 
shorter scan time. “OFF” is not saved. 

NOTICE 

w The HR mode requires a lot of computing power and memory. 
Use a PC that meets the recommended system requirements for 
Aadva Scan. 

Start | Cancel 

A tab dialog can be confirmed with Start or Next if the scan object is 
positioned inside the scanner and the settings are correct. The result is 
displayed in the 3D viewer of the tab. 

A tab dialog can be cancelled without editing the task (scanning, 
presentation). The tab remains empty. You can cancel the scan if, for 
example, the project definition was created incorrectly. 

� Error! Bookmark not defined.

ON / OFF 

u 
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TIP 
The file names in Aadva Scan projects indicate which Globalscan strategy 
was used to scan, e.g.: 2019-07-03-101351-
upperjaw_#A190703101459_GlobalEnhanced_w90h-60.pcm 

HR mode 

¾ Toggle switch, available on scanners with high-resolution cameras 
¾ HR enabled (ON): highest resolution of the scanner camera, more 

precise results, longer scan times. 

Procedure 

1. Click the OFF icon.

2. Start the scan.

� The scan is carried out once with a lower camera resolution and a 
shorter scan time. “OFF” is not saved. 

NOTICE 

w The HR mode requires a lot of computing power and memory. 
Use a PC that meets the recommended system requirements for 
Aadva Scan. 

Start | Cancel 

A tab dialog can be confirmed with Start or Next if the scan object is 
positioned inside the scanner and the settings are correct. The result is 
displayed in the 3D viewer of the tab. 

A tab dialog can be cancelled without editing the task (scanning, 
presentation). The tab remains empty. You can cancel the scan if, for 
example, the project definition was created incorrectly. 

� Error! Bookmark not defined.

ON / OFF 
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TIP 
The file names in Aadva Scan projects indicate which Globalscan strategy 
was used to scan, e.g.: 2019-07-03-101351-
upperjaw_#A190703101459_GlobalEnhanced_w90h-60.pcm 

HR mode 

¾ Toggle switch, available on scanners with high-resolution cameras 
¾ HR enabled (ON): highest resolution of the scanner camera, more 

precise results, longer scan times. 

Procedure 

1. Click the OFF icon.

2. Start the scan.

� The scan is carried out once with a lower camera resolution and a 
shorter scan time. “OFF” is not saved. 

NOTICE 

w The HR mode requires a lot of computing power and memory. 
Use a PC that meets the recommended system requirements for 
Aadva Scan. 

Start | Cancel 

A tab dialog can be confirmed with Start or Next if the scan object is 
positioned inside the scanner and the settings are correct. The result is 
displayed in the 3D viewer of the tab. 

A tab dialog can be cancelled without editing the task (scanning, 
presentation). The tab remains empty. You can cancel the scan if, for 
example, the project definition was created incorrectly. 

� Error! Bookmark not defined.

ON / OFF 
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6.3 Presentation with multiDie 

Aadva Scan requests the presentation after the jaw scan and temporarily 
adds the multiDie tab. Insert the segments into the adapter: 

If more than twelve segments have to be presented, Aadva Scan requests 
two multiDie presentations, one after the other. 

1. Insert the requested segments into the multiDie adapter:

2. Start the scan.

3. Check whether all segments were scanned correctly. If not, you can:

¾ make corrections (mesh processing functions) 

¾ cancel and repeat the process. 

4. Start the automatic alignment of the segments on the jaw model.

5. Check the result from all sides. Pay attention to the colors.

6. Make manual corrections if necessary.

7. The jaw scan is recalculated with Next. The multiDie is closed. The
presentation is ready.

Manual registration multiDie presentation 

Manual registration can improve the auto registration of the multiDie 
presentation per segment. 

1. Click on the segment to be registered manually.

2. The 3D viewer is split (jaw scan above, segment below).

3. Rotate the jaw scan and the segment so that the perspectives match:

¾ both together via the View menu, 
¾ individually with the mouse (click next to the scan, not on it). 

4. Mark the same point above and below with the left mouse button.

� The points appear marked in color. Pay attention to precise positioning. 

5. You can refine the registration:

¾ CTRL key + left mouse button for further markings (maximum six in 
other colors), 

¾ Click once on a position to move the closest marker there, 
¾ Press the DEL key to delete the mark. 

multiDie 
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TIP 
The file names in Aadva Scan projects indicate which Globalscan strategy 
was used to scan, e.g.: 2019-07-03-101351-
upperjaw_#A190703101459_GlobalEnhanced_w90h-60.pcm 

HR mode 

¾ Toggle switch, available on scanners with high-resolution cameras 
¾ HR enabled (ON): highest resolution of the scanner camera, more 

precise results, longer scan times. 

Procedure 

1. Click the OFF icon.

2. Start the scan.

� The scan is carried out once with a lower camera resolution and a 
shorter scan time. “OFF” is not saved. 

NOTICE 

w The HR mode requires a lot of computing power and memory. 
Use a PC that meets the recommended system requirements for 
Aadva Scan. 

Start | Cancel 

A tab dialog can be confirmed with Start or Next if the scan object is 
positioned inside the scanner and the settings are correct. The result is 
displayed in the 3D viewer of the tab. 

A tab dialog can be cancelled without editing the task (scanning, 
presentation). The tab remains empty. You can cancel the scan if, for 
example, the project definition was created incorrectly. 

� Error! Bookmark not defined.

ON / OFF 

u 
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6.4	 Presentation with multiDie
 	
multiDie 

multiDie and multiDie+ are presentation modes, alternative to
singleDie and secondDie. When isolating, the interdental areas of a jaw
are scanned.

With multiDie and multiDie+, it is possible to isolate up to 16 segments
(stumps) per jaw (in 2 presentations; one presentation allows to
isolate up to 12 segments).

Prerequisites 

 The multiDie/multiCase module is activated within the software.
 A multiDie adapter is available.
 The jaw model is segmented.

Procedure

1. Create the “Patient” project definition:
 Mark at least one position for one or both jaws, e.g. as a stump.
 All indications except opposing jaw and missing tooth are possible.

2. Select the presentation mode multiDie or multiDie+.

3. Start scanning. The jaw is scanned first. The presentation mode can still be changed at this time.

4. The jaw scan is followed by the multiDie scan.
 1 - 3 segments must be placed in slots 2, 5 and 8 in the multiDie adapter.
 4 - 12 segments can be distributed arbitrarily in the slots.

5. Occupy the slots:
 Fill holes with adhesive pads, smooth the surface.
 Insert segments into the putty material.
 The area to be scanned must be visible.

�u 
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6. Start multiDie.

7. Start the automatic registration.
 Wait for the calculation and check the result.
 Is something placed incorrectly?

Align the segment manually and start the process with a left click.
 Create up to 6 reference points on the jaw and the segment alternating left click and CTRL + left click.

8. Complete the multiDie scan with precision registration.

9. Wait for the calculation, the matching process and continue with the project.

Comparison multiDie - multiDie+
multiDie+ multiDie

Calculation (data from jaw and segment scans) Subtraction Addition

Model types

Saw cut model ✔ ✔

Geller model ✔ —

Master model ✔ —

Model types

Transitions ✔ —

Veneers ✔ —

Soft tissues ✔ —

Better quality 

multiDie+ scans transitions and edges in a loss-free manner. The scope
of application has been extended to master and Geller models.

Time saving

When scanning Geller models, there is no need for an additional scan of a gingival mask.

Due to the identical way of proceeding, multiDie+ can be used 
immediately and without previous practice.

Ctrl
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6.5	 Matching and project finalization
Matching is a calculation that uses individual recordings and measured values to generate a data set in 3D 
data format. Matched scans display a green tick mark in the tab; unmatched scans display the matching 
icon.
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First marking in segment (1) and jaw scan (2): 

1 2

� Confirm the registration by clicking on Next. You can: 

¾ register the next presented segment manually, 
¾ end the registration with Next. 

6.4 Matching and project finalization 

Matching is a calculation that uses individual recordings and measured 
values to generate a data set in 3D data format. Matched scans display a 
green tick mark in the tab; unmatched scans display the matching icon. 

Upper jaw   � Upper jaw   

There are several setting options for matching. By default, all scans are 
automatically matched during scanning and when the project is finalized. 

6.4.1 Manual matching 

You can carry out all routine work without manual matching. For special 
work, e.g. an additional scan or a correction scan, you have to match the 
corresponding scan manually. 

In workflows with a vestibular scan, you can only match after the entire 
workflow has been completed. Then all scans are matched together. 

1. Click on the tab whose scan you wish to match.

2. Click on “Matching” in the project control.

� Matching is calculated and the result displayed in the 3D viewer. The 
tab gets a green tick. 

u 
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Upper jaw
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There are several setting options for matching. By default, all scans are automatically matched during 
scanning and when the project is finalized.

		  6.5.1	 Manual matching

You can carry out all routine work without manual matching. For special work, e.g. an additional scan or a 
correction scan, you have to match the corresponding scan manually.
In workflows with a vestibular scan, you can only match after the entire workflow has been completed. Then 
all scans are matched together.

1.	 Click on the tab whose scan you wish to match.
 
2.	 Click on “Matching” in the project control.
 	 Upper jaw
	 Æ	 Matching is calculated and the result displayed in the 3D viewer. The tab gets a green tick.

		  6.5.2	 Delete matching

You can undo the matching of individual scans in a project.
1.	 Select the tab whose matching you want to delete.
 
2.	 Click on Edit mesh | Delete matching (active if the selected scan is matched and deletion is allowed).
 	 Upper jaw  

Æ	 Now you are able to edit the unmatched data. Data that has been cut after matching is restored by 
Delete matching.

Æ	 You can repeat the registration in a dental project with a vestibular scan.

		  6.5.3	 Check matching (3D)

At the end of the dental workflow (Patient project definition with option), you can visually check the result 
of several matching processes in the 3D viewer.
 
1.	 Click on “Show result” in the project control. The button is displayed when all scans have been matched.

	 Æ	 The 3D viewer loads all results and displays them in contrasting colors. 
		  Vestibular scan and jaw scan are separated. 
		  The colors are configurable and indicate which scan the data originate from.

2.	 Check the results of the matching process from all sides.
 
3.	 To exit the checking view, click again on “Show result”.

4.	 To change a matching, click on the relevant tab. Correct or replace the scan.

	 Æ	 If everything is OK, you can finalize the project.
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First marking in segment (1) and jaw scan (2): 

1 2

� Confirm the registration by clicking on Next. You can: 

¾ register the next presented segment manually, 
¾ end the registration with Next. 

6.4 Matching and project finalization 

Matching is a calculation that uses individual recordings and measured 
values to generate a data set in 3D data format. Matched scans display a 
green tick mark in the tab; unmatched scans display the matching icon. 

Upper jaw   � Upper jaw   

There are several setting options for matching. By default, all scans are 
automatically matched during scanning and when the project is finalized. 

6.4.1 Manual matching 

You can carry out all routine work without manual matching. For special 
work, e.g. an additional scan or a correction scan, you have to match the 
corresponding scan manually. 

In workflows with a vestibular scan, you can only match after the entire 
workflow has been completed. Then all scans are matched together. 

1. Click on the tab whose scan you wish to match.

2. Click on “Matching” in the project control.

� Matching is calculated and the result displayed in the 3D viewer. The 
tab gets a green tick. 
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6.4.2 Delete matching 

You can undo the matching of individual scans in a project. 

1. Select the tab whose matching you want to delete.

2. Click on Edit mesh | Delete matching (active if the selected scan is
matched and deletion is allowed).

� Now you are able to edit the unmatched data. Data that has been cut 
after matching is restored by Delete matching. 

� You can repeat the registration in a dental project with a vestibular 
scan. 

6.4.3 Check matching (3D) 

At the end of the dental workflow (Patient project definition with option), 
you can visually check the result of several matching processes in the 3D 
viewer. 

1. Click on “Show result” in the project control. The button is displayed
when all scans have been matched.

� The 3D viewer loads all results and displays them in contrasting colors. 
Vestibular scan and jaw scan are separated. The colors are configurable 
and indicate which scan the data originate from. 

2. Check the results of the matching process from all sides.

3. To exit the checking view, click again on “Show result”.

4. To change a matching, click on the relevant tab. Correct or replace the
scan.

� If everything is OK, you can finalize the project. 

Finalizing the project 50 

Scan substitution 50 

View 63 

Upper jaw

Tab with matching symbol 
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		  6.5.4	 Finalizing the project
 

The completion of the project after a workflow completes all data for subsequent use in a CAD system, 
e.g. exocad® Dental CAD. Depending on the scan quality, the amount of data is reduced (“thinned”).

 
1.	 Click on “Finalize the project”.
	 Æ	 If there are still unmatched scans, you will receive a message.

2.	 To finalize the project, click on Start matching and close the software. 
	 Start matching matches without completing the project.
	 Æ	 All scans are matched, a 3D data file (PLY, STL (optional)) saved and the project closed. 
		  Aadva Scan goes into the standby mode.

 
If Aadva Scan is closed without completing the project, the scan data is not thinned. 
Matched data can still be used for a construction.

	 6.6	 Replacing a scan
In free workflows, you can replace incorrect scans, e.g. a lower jaw on an upper jaw tab.  
All other scans are kept.

TIP
Replacement is not possible in guided workflows.
The project has to be started anew. The scan modes affected are:
Baltic Denture, Triple Tray®, Twin Tray (all “Patient” project definitions).

1.	 Click on:
	 	 the tab you wish to replace,

	 	 Cancel (project control),

	 	 Yes in the Restart message.

	 Æ	 The existing scan is deleted. You cannot undo this action.
	 Æ	 Aadva Scan asks you to insert the scan object.

2.	 Follow the instructions to replace the deleted scan.

		  6.6.1	 Replacing a vestibular scan

In the case of a vestibular scan, the scan itself may be incorrect (e.g. due to a swapped model) or also the 
alignment of the jaw scan with the vestibular scan.
Repeating the alignment

1.	 Click on Cancel:
	 	 after the automatic alignment,
	 	 after or during manual alignment.
	 Æ	 The alignment is removed and the original vestibular scan displayed again.

2.	 To repeat the alignment, click on Next.
	 Repeating a vestibular scan

1.	 Click on Cancel repeatedly until the message Restart is displayed.

2.	 The vestibular scan restarts when you click on Yes 
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TIP 
The file names in Aadva Scan projects indicate which Globalscan strategy 
was used to scan, e.g.: 2019-07-03-101351-
upperjaw_#A190703101459_GlobalEnhanced_w90h-60.pcm 

HR mode 

¾ Toggle switch, available on scanners with high-resolution cameras 
¾ HR enabled (ON): highest resolution of the scanner camera, more 

precise results, longer scan times. 

Procedure 

1. Click the OFF icon.

2. Start the scan.

� The scan is carried out once with a lower camera resolution and a 
shorter scan time. “OFF” is not saved. 

NOTICE 

w The HR mode requires a lot of computing power and memory. 
Use a PC that meets the recommended system requirements for 
Aadva Scan. 

Start | Cancel 

A tab dialog can be confirmed with Start or Next if the scan object is 
positioned inside the scanner and the settings are correct. The result is 
displayed in the 3D viewer of the tab. 

A tab dialog can be cancelled without editing the task (scanning, 
presentation). The tab remains empty. You can cancel the scan if, for 
example, the project definition was created incorrectly. 

� Error! Bookmark not defined.

ON / OFF 

u 

r
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7	 Mesh processing
 

The Mesh processing menu contains correction and cutting functions for editing the 3D data networks 
(“Mesh”). Mesh processing opens automatically at any point in time in a workflow. Appropriate functions 
are active, depending on the context.

7.1	 Automatic cutting plane
In the case of dental models, the model base is also scanned; in the case of universal objects, the fastening 
material. These components are unnecessary and must be cut. The automatic cutting plane simplifies this 
process.
After scanning, the cutting plane is displayed as a frame with purple points and arrows.
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7.1 Automatic cutting plane 

In the case of dental models, the model base is also scanned; in the case of 
universal objects, the fastening material. These components are 
unnecessary and must be cut. The automatic cutting plane simplifies this 
process. 

After scanning, the cutting plane is displayed as a frame with purple points 
and arrows. 

Saving the cut 

Before matching 

¾ Scan components below the cutting plane are hidden (not deleted). 

¾ The position of the cutting plane can be reset: 
Press the CTRL key + the mouse wheel at the same time. 

After matching 

¾ The cut components are automatically removed and cannot be 
restored. 

Choosing a suitable perspective 

The operation of the automatic cutting plane depends on the view in the 
3D viewer. After scanning, the top of the scanned object is displayed (Top 
view). 

w Change the view so that the 3D viewer shows: 

¾ the cutting plane as a trapezoid (oblique), 
¾ the height regulator (arrows), 
¾ the superfluous components. 

Å Æ

� 63

� Height regulator

� Horizontal rotation axis 

Vertical rotation axis � Vertical rotation axis

Horizontal rotation axis Height regulator

Saving the cut

Before matching
	 Scan components below the cutting plane are hidden (not deleted).

  
	 The position of the cutting plane can be reset:

	 Press the CTRL key + the mouse wheel at the same time.

After matching
	 The cut components are automatically removed and cannot be restored.

Choosing a suitable perspective

The operation of the automatic cutting plane depends on the view in the 3D viewer. After scanning, the top 
of the scanned object is displayed (Top view).

	 Change the view so that the 3D viewer shows:

	 the cutting plane as a trapezoid (oblique),
	 the height regulator (arrows),
	 the superfluous components.

Changing the cutting plane

After scanning, the automatic cutting plane cuts the model base horizontally. 
The lower part of the scan is hidden.

The automatic cutting plane can be:
	 lifted (to cut more),
	 Lowered (to cut less),
	 rotated horizontally and vertically to change the angle of the cutting plane.

 
Keyboard operation

	 Press the arrow keys to move the cutting plane up or down.

Ctrl
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Changing the cutting plane 

After scanning, the automatic cutting plane cuts the model base 
horizontally. The lower part of the scan is hidden. 

The automatic cutting plane can be: 

¾ lifted (to cut more), 
¾ Lowered (to cut less), 
¾ rotated horizontally and vertically to change the angle of the cutting 

plane. 

Keyboard operation 

w Press the arrow keys to move the cutting plane up or down. 

Mouse operation 

1. Click the arrows. Hold the mouse button down.

2. Move the mouse until the cutting plane is at the desired height.

Rotating the cutting plane 

The cutting plane can be rotated vertically and horizontally. This allows you 
to straighten scans, e.g. if the model was mounted at an angle. 

When the mouse hovers over a handle, the axes of rotation are displayed 
as circular auxiliary lines. 

Tilted view 

Å Æ

View of the right side 

Ctrl
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Mouse operation
 

1.	 Click the arrows. Hold the mouse button down.
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Changing the cutting plane 

After scanning, the automatic cutting plane cuts the model base 
horizontally. The lower part of the scan is hidden. 

The automatic cutting plane can be: 

¾ lifted (to cut more), 
¾ Lowered (to cut less), 
¾ rotated horizontally and vertically to change the angle of the cutting 

plane. 

Keyboard operation 

w Press the arrow keys to move the cutting plane up or down. 

Mouse operation 

1. Click the arrows. Hold the mouse button down.

2. Move the mouse until the cutting plane is at the desired height.

Rotating the cutting plane 

The cutting plane can be rotated vertically and horizontally. This allows you 
to straighten scans, e.g. if the model was mounted at an angle. 

When the mouse hovers over a handle, the axes of rotation are displayed 
as circular auxiliary lines. 

Tilted view 

Å Æ

View of the right side 

2.	 Move the mouse until the cutting plane is at the desired height.
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Changing the cutting plane 

After scanning, the automatic cutting plane cuts the model base 
horizontally. The lower part of the scan is hidden. 

The automatic cutting plane can be: 

¾ lifted (to cut more), 
¾ Lowered (to cut less), 
¾ rotated horizontally and vertically to change the angle of the cutting 

plane. 

Keyboard operation 

w Press the arrow keys to move the cutting plane up or down. 

Mouse operation 

1. Click the arrows. Hold the mouse button down.

2. Move the mouse until the cutting plane is at the desired height.

Rotating the cutting plane 

The cutting plane can be rotated vertically and horizontally. This allows you 
to straighten scans, e.g. if the model was mounted at an angle. 

When the mouse hovers over a handle, the axes of rotation are displayed 
as circular auxiliary lines. 

Tilted view 
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View of the right side 

Rotating the cutting plane

The cutting plane can be rotated vertically and horizontally. 
This allows you to straighten scans, e.g. if the model was mounted at an angle.

When the mouse hovers over a handle, the axes of rotation are displayed as circular auxiliary lines.

dental Scan Software

Version: 3.4 10-2021 Error! Use the Home tab to apply Überschrift 1 to the text that you want to appear here.54 

1. Click on the desired handle. Hold the mouse button down.

2. Move the mouse along the axis of rotation.

3. Release the mouse button when the cutting plane has been rotated
sufficiently to cut the scan correctly. You can now change the height.

A scan can be divided by rotating the cutting plane, e.g. a whole jaw to a 
partial jaw. 

TIP 

¾ CTRL + mouse wheel � Reset the cutting plane to its initial position. 

7.2 Cutting 

Cutting scans: 

¾ removes unnecessary scan components, 
¾ accelerates the processing time, 
¾ reduces data size. 

Automatic cutting plane 52 

Rescan 56 
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1.	 Click on the desired handle. Hold the mouse button down.

2.	 Move the mouse along the axis of rotation.

3.	 Release the mouse button when the cutting plane has been rotated sufficiently to cut the scan correctly. 
You can now change the height.

Tilted view
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A scan can be divided by rotating the cutting plane, e.g. a whole jaw to a partial jaw.
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1. Click on the desired handle. Hold the mouse button down.

2. Move the mouse along the axis of rotation.

3. Release the mouse button when the cutting plane has been rotated
sufficiently to cut the scan correctly. You can now change the height.

A scan can be divided by rotating the cutting plane, e.g. a whole jaw to a 
partial jaw. 

TIP 

¾ CTRL + mouse wheel � Reset the cutting plane to its initial position. 

7.2 Cutting 

Cutting scans: 

¾ removes unnecessary scan components, 
¾ accelerates the processing time, 
¾ reduces data size. 

Automatic cutting plane 52 

Rescan 56 
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TIP

	 CTRL + mouse wheel Reset the cutting plane to its initial position.

	 7.2	 Cutting
Cutting scans:

	 removes unnecessary scan components,
	 accelerates the processing time,
	 reduces data size.

		  7.2.1	 Cutting inside, cutting outside, cutting the surface

Cutting inside
 

	 deletes all data inside the cutting line,
	 through all levels (3D).

 

Cutting outside
 

	 deletes all data outside the cutting line,
	 through all levels (3D).

 

Cutting the surface
 

	 deletes surface data inside the cutting line,
	 special application: preparation of a correction scan,

Ctrl
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7.2.1 Cutting inside, cutting outside, cutting the surface 

Cutting inside 

¾ deletes all data inside the cutting line, 
¾ through all levels (3D). 

Cutting outside 

¾ deletes all data outside the cutting line, 
¾ through all levels (3D). 

Cutting the surface 

¾ deletes surface data inside the cutting line, 
¾ special application: preparation of a correction scan, 
¾ lower levels (3D) remain in place. 

7.2.2 Cutting procedure 

1. Activate a cutting function.

2. Click around the desired area. The more often, the more precise is the
cutting line:

� 58
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2. Click around the desired area. The more often, the more precise is the
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7.2.1 Cutting inside, cutting outside, cutting the surface 

Cutting inside 
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7.2.1 Cutting inside, cutting outside, cutting the surface 
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	 lower levels (3D) remain in place.

 

		  7.2.2	 Cutting procedure

1.	 Activate a cutting function.
 
2.	 Click around the desired area. The more often, the more precise is the cutting line:
    
You can also hold the left mouse button and drag around the desired area.
 
3.	 Finish with the right mouse button.

 
You can cut multiple areas, one after the other.

Saving is only necessary if:
	 a rescan follows,
	 the previous cuts should not be undone.

Additional functions:
 

	 delete the cutting line with ESC.
 

	 undo last action (possible several times).

	 7.3	 Rescan
The Rescan correction function is used to “close holes” in scans. Holes appear because narrow points in the 
scan object (e.g. interdental spaces in jaw models) or reflective surfaces cannot be fully measured. 
The correction of holes is important for subsequent designs made in a CAD system.

TIP
The result is better if the neighbouring segments are removed before the rescan.
The function Close holes suffices for the documentation of complete jaw models.

The appropriate moment for a rescan is:
	 previous to cutting (Mesh processing menu),
	 previous to matching,
	 previous to a correction scan.

		  7.3.1	 Rescan procedure
 

The function includes Rescan [activate], Launch scan and Launch scan sequence.

1.	 Select Mesh processing | Rescan to activate the function.

	 Æ	 An arrow and a crosshair is displayed in the 3D viewer. 
		  Blue areas cannot be measured from the camera perspective.
 

“Lasso”
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You can also hold the left mouse button and drag around the 
desired area. 

3. Finish with the right mouse button.

You can cut multiple areas, one after the other. 
Saving is only necessary if: 

¾ a rescan follows, 
¾ the previous cuts should not be undone. 

Additional functions: 

¾ delete the cutting line with ESC. 

¾ undo last action (possible several times). 

7.3 Rescan 

The Rescan correction function is used to “close holes” in scans. Holes 
appear because narrow points in the scan object (e.g. interdental spaces in 
jaw models) or reflective surfaces cannot be fully measured. The correction 
of holes is important for subsequent designs made in a CAD system. 

TIP 
The result is better if the neighbouring segments are removed before the 
rescan. 
The function Close holes suffices for the documentation of complete jaw 
models. 

The appropriate moment for a rescan is: 

¾ previous to cutting (Mesh processing menu), 
¾ previous to matching, 
¾ previous to a correction scan. 

“Lasso” 

�
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You can also hold the left mouse button and drag around the 
desired area. 

3. Finish with the right mouse button.

You can cut multiple areas, one after the other. 
Saving is only necessary if: 

¾ a rescan follows, 
¾ the previous cuts should not be undone. 

Additional functions: 

¾ delete the cutting line with ESC. 

¾ undo last action (possible several times). 

7.3 Rescan 

The Rescan correction function is used to “close holes” in scans. Holes 
appear because narrow points in the scan object (e.g. interdental spaces in 
jaw models) or reflective surfaces cannot be fully measured. The correction 
of holes is important for subsequent designs made in a CAD system. 

TIP 
The result is better if the neighbouring segments are removed before the 
rescan. 
The function Close holes suffices for the documentation of complete jaw 
models. 

The appropriate moment for a rescan is: 

¾ previous to cutting (Mesh processing menu), 
¾ previous to matching, 
¾ previous to a correction scan. 

“Lasso” 
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7.3.1 Rescan procedure 

The function includes Rescan [activate], Launch scan and Launch scan 
sequence. 

1. Select Mesh processing | Rescan to activate the function.

� An arrow and a crosshair is displayed in the 3D viewer. Blue areas 
cannot be measured from the camera perspective. 

2. Rotate the scan until the desired perspective is reached (View menu,
right mouse button). The crosshair turns red if a rescan is not possible
in the displayed position.

� The rescan area must be visible (not invisible or blue). 

3. Click on Launch scan or Launch scan sequence (three images from a
slightly offset perspective).

� The rescan starts (axis movement of the scanner). All visible, non-blue 
areas are measured. 

The results of the rescan is displayed in color. The rescan mode 
remains active. 

4. Repeat this process until all areas have been rescanned.
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2.	 Rotate the scan until the desired perspective is reached (View menu, right mouse button). 
	 The crosshair turns red if a rescan is not possible in the displayed position.

	 Æ	 The rescan area must be visible (not invisible or blue).
 
3.	 Click on Launch scan or Launch scan sequence (three images from a slightly offset perspective).

	 Æ	 The rescan starts (axis movement of the scanner). All visible, non-blue areas are measured.
 

The results of the rescan is displayed in color. The rescan mode remains active.

4.	 Repeat this process until all areas have been rescanned.
 
5.	 Click on Rescan.

	 Æ	 Scan and rescan data are combined.

6.	 To end this process and continue, click on Next.

Additional functions:
 

	 Undo last action (possible several times).

	 7.4	 Close holes
Narrow points in the scan object, interdental spaces in jaw models or reflective surfaces cannot be fully 
measured. Those areas not measured are displayed as “holes” in the 3D viewer.
The function Close holes fills small, flat areas in matched scans automatically. Close holes is suitable for low 
accuracy requirements, e.g. for documentation (not for designs with a CAD system).
Close holes procedure
 
1.	 Select Mesh processing | Close holes (active after matching).

2.	 Enter the maximum size of the holes to be filled in square millimetres (suggested value 10 mm2). 
	 The higher the value, the less precise the result.
	 Æ	 All holes on flat surfaces up to the maximum size are closed. 
		  Undoing is not possible. A changed value is saved until Aadva Scan is closed.
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7.3.1 Rescan procedure 

The function includes Rescan [activate], Launch scan and Launch scan 
sequence. 

1. Select Mesh processing | Rescan to activate the function.

� An arrow and a crosshair is displayed in the 3D viewer. Blue areas 
cannot be measured from the camera perspective. 

2. Rotate the scan until the desired perspective is reached (View menu,
right mouse button). The crosshair turns red if a rescan is not possible
in the displayed position.

� The rescan area must be visible (not invisible or blue). 

3. Click on Launch scan or Launch scan sequence (three images from a
slightly offset perspective).

� The rescan starts (axis movement of the scanner). All visible, non-blue 
areas are measured. 

The results of the rescan is displayed in color. The rescan mode 
remains active. 

4. Repeat this process until all areas have been rescanned.
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7.3.1 Rescan procedure 

The function includes Rescan [activate], Launch scan and Launch scan 
sequence. 

1. Select Mesh processing | Rescan to activate the function.

� An arrow and a crosshair is displayed in the 3D viewer. Blue areas 
cannot be measured from the camera perspective. 

2. Rotate the scan until the desired perspective is reached (View menu,
right mouse button). The crosshair turns red if a rescan is not possible
in the displayed position.

� The rescan area must be visible (not invisible or blue). 

3. Click on Launch scan or Launch scan sequence (three images from a
slightly offset perspective).

� The rescan starts (axis movement of the scanner). All visible, non-blue 
areas are measured. 

The results of the rescan is displayed in color. The rescan mode 
remains active. 

4. Repeat this process until all areas have been rescanned.
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TIP 
The file names in Aadva Scan projects indicate which Globalscan strategy 
was used to scan, e.g.: 2019-07-03-101351-
upperjaw_#A190703101459_GlobalEnhanced_w90h-60.pcm 

HR mode 

¾ Toggle switch, available on scanners with high-resolution cameras 
¾ HR enabled (ON): highest resolution of the scanner camera, more 

precise results, longer scan times. 

Procedure 

1. Click the OFF icon.

2. Start the scan.

� The scan is carried out once with a lower camera resolution and a 
shorter scan time. “OFF” is not saved. 

NOTICE 

w The HR mode requires a lot of computing power and memory. 
Use a PC that meets the recommended system requirements for 
Aadva Scan. 

Start | Cancel 

A tab dialog can be confirmed with Start or Next if the scan object is 
positioned inside the scanner and the settings are correct. The result is 
displayed in the 3D viewer of the tab. 

A tab dialog can be cancelled without editing the task (scanning, 
presentation). The tab remains empty. You can cancel the scan if, for 
example, the project definition was created incorrectly. 

� Error! Bookmark not defined.

ON / OFF 

u 

r
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5. Click on Rescan.

� Scan and rescan data are combined. 

6. To end this process and continue, click on Next.

Additional functions: 

¾ Undo last action (possible several times). 

View 63 

Object color rescan 79 

Shadows in the rescan mode 80 

7.4 Close holes 

Narrow points in the scan object, interdental spaces in jaw models or 
reflective surfaces cannot be fully measured. Those areas not measured 
are displayed as “holes” in the 3D viewer. 

The function Close holes fills small, flat areas in matched scans 
automatically. Close holes is suitable for low accuracy requirements, e.g. 
for documentation (not for designs with a CAD system). 

Close holes procedure 

1. Select Mesh processing | Close holes (active after matching).

2. Enter the maximum size of the holes to be filled in square millimetres
(suggested value 10 mm2). The higher the value, the less precise the
result.

� All holes on flat surfaces up to the maximum size are closed. Undoing 
is not possible. A changed value is saved until Aadva Scan is closed. 

7.5 Correction scan 

Subsequent changes to the indication or deficiencies in a scan object 
(e.g. bubbles, distortions) cause defective areas in a scan. Such errors 
cannot be corrected with the same scan object. The defective part can 
be replaced with a second scan object, e.g. a tooth position. 

u 
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5. Click on Rescan.

� Scan and rescan data are combined. 

6. To end this process and continue, click on Next.

Additional functions: 

¾ Undo last action (possible several times). 

View 63 

Object color rescan 79 

Shadows in the rescan mode 80 

7.4 Close holes 

Narrow points in the scan object, interdental spaces in jaw models or 
reflective surfaces cannot be fully measured. Those areas not measured 
are displayed as “holes” in the 3D viewer. 

The function Close holes fills small, flat areas in matched scans 
automatically. Close holes is suitable for low accuracy requirements, e.g. 
for documentation (not for designs with a CAD system). 

Close holes procedure 

1. Select Mesh processing | Close holes (active after matching).

2. Enter the maximum size of the holes to be filled in square millimetres
(suggested value 10 mm2). The higher the value, the less precise the
result.

� All holes on flat surfaces up to the maximum size are closed. Undoing 
is not possible. A changed value is saved until Aadva Scan is closed. 

7.5 Correction scan 

Subsequent changes to the indication or deficiencies in a scan object 
(e.g. bubbles, distortions) cause defective areas in a scan. Such errors 
cannot be corrected with the same scan object. The defective part can 
be replaced with a second scan object, e.g. a tooth position. 
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� Aadva Scan asks you to insert the scan object. 

2. Follow the instructions to replace the deleted scan.

Rescan 56 

Closing holes 58 

Correction scan 58 

6.5.1 Replacing a vestibular scan 

In the case of a vestibular scan, the scan itself may be incorrect (e.g. due to 
a swapped model) or also the alignment of the jaw scan with the vestibular 
scan. 

Repeating the alignment 

1. Click on Cancel:

¾ after the automatic alignment, 
¾ after or during manual alignment. 

� The alignment is removed and the original vestibular scan displayed 
again. 

2. To repeat the alignment, click on Next.

Repeating a vestibular scan 

1. Click on Cancel repeatedly until the message Restart is displayed.

2. The vestibular scan restarts when you click on Yes

7 Mesh processing 

The Mesh processing menu contains correction and cutting functions for 
editing the 3D data networks (“Mesh”). 

Mesh processing opens automatically at any point in time in a workflow. 
Appropriate functions are active, depending on the context. 

More 
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7.5	 Correction scan
Subsequent changes to the indication or deficiencies in a scan object (e.g. bubbles, distortions) cause 
defective areas in a scan. Such errors cannot be corrected with the same scan object. 
The defective part can be replaced with a second scan object, e.g. a tooth position.

		  7.5.1	 Correction scan procedure
 
 
1.	 Follow the original workflow. Match all tabs.

2.	 Start the correction scan workflow in the corresponding tab with Mesh processing | Correction scan.

3.	 In the scan to be corrected, cut the surface of the defective area.

4.	 Start the scan of the correction model by clicking on Next.

	 Æ	 Aadva Scan adds a correction tab.

5.	 Cut the correction scan to fit the correction area and the neighbouring areas.

6.	 When you click on Next, Aadva Scan splits the 3D viewer horizontally  
(scan to be corrected above, correction scan below).

	 Æ	 Aadva Scan requests a manual assignment so that the correction scan can be inserted 
		  into the scan to be corrected.

7.	 Rotate the scans so that the perspectives match:
	 	 both together via the View menu,
	 	 individually with the mouse (click next to the scan, not on it).
 
8.	 Mark the same point above and below with the left mouse button.
	 Æ	 The points appears marked in color. Pay attention to precise positioning.

9.	 You can refine the alignment:
	 	 CTRL key + left mouse button for further markings (maximum six in other colors),
	 	 click once on a position to move the closest marker there,
	 	 press the DEL key to delete the mark.

10.	Confirm the registration by clicking on Next.
	 Æ	 The Correction scan tab is closed. The original scan is corrected now.
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7.5.1 Correction scan procedure 

1. Follow the original workflow. Match all tabs.

2. Start the correction scan workflow in the corresponding tab with
Mesh processing | Correction scan.

3. In the scan to be corrected, cut the surface of the defective area.

4. Start the scan of the correction model by clicking on Next.

� Aadva Scan adds a correction tab. 

5. Cut the correction scan to fit the correction area and the neighbouring
areas.

6. When you click on Next, Aadva Scan splits the 3D viewer horizontally
(scan to be corrected above, correction scan below).

� Aadva Scan requests a manual assignment so that the correction scan 
can be inserted into the scan to be corrected. 

7. Rotate the scans so that the perspectives match:

¾ both together via the View menu, 
¾ individually with the mouse (click next to the scan, not on it). 

8. Mark the same point above and below with the left mouse button.

� The points appears marked in color. Pay attention to precise 
positioning. 

9. You can refine the alignment:

¾ CTRL key + left mouse button for further markings (maximum six in 
other colors), 

¾ click once on a position to move the closest marker there, 
¾ press the DEL key to delete the mark. 

10. Confirm the registration by clicking on Next.

� The Correction scan tab is closed. The original scan is corrected now. 

Inserting a correction model 38 

Registration/assignment (alignment) 44 

Cutting 54 

Cut the surface 
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Correction  

Cut outside/inside 
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2. Start the correction scan workflow in the corresponding tab with
Mesh processing | Correction scan.

3. In the scan to be corrected, cut the surface of the defective area.

4. Start the scan of the correction model by clicking on Next.

� Aadva Scan adds a correction tab. 

5. Cut the correction scan to fit the correction area and the neighbouring
areas.

6. When you click on Next, Aadva Scan splits the 3D viewer horizontally
(scan to be corrected above, correction scan below).

� Aadva Scan requests a manual assignment so that the correction scan 
can be inserted into the scan to be corrected. 

7. Rotate the scans so that the perspectives match:

¾ both together via the View menu, 
¾ individually with the mouse (click next to the scan, not on it). 

8. Mark the same point above and below with the left mouse button.

� The points appears marked in color. Pay attention to precise 
positioning. 

9. You can refine the alignment:

¾ CTRL key + left mouse button for further markings (maximum six in 
other colors), 

¾ click once on a position to move the closest marker there, 
¾ press the DEL key to delete the mark. 

10. Confirm the registration by clicking on Next.

� The Correction scan tab is closed. The original scan is corrected now. 
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7.5.1 Correction scan procedure 

1. Follow the original workflow. Match all tabs.

2. Start the correction scan workflow in the corresponding tab with
Mesh processing | Correction scan.

3. In the scan to be corrected, cut the surface of the defective area.

4. Start the scan of the correction model by clicking on Next.
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7.5.1 Correction scan procedure 

1. Follow the original workflow. Match all tabs.

2. Start the correction scan workflow in the corresponding tab with
Mesh processing | Correction scan.

3. In the scan to be corrected, cut the surface of the defective area.

4. Start the scan of the correction model by clicking on Next.

� Aadva Scan adds a correction tab. 

5. Cut the correction scan to fit the correction area and the neighbouring
areas.

6. When you click on Next, Aadva Scan splits the 3D viewer horizontally
(scan to be corrected above, correction scan below).

� Aadva Scan requests a manual assignment so that the correction scan 
can be inserted into the scan to be corrected. 

7. Rotate the scans so that the perspectives match:

¾ both together via the View menu, 
¾ individually with the mouse (click next to the scan, not on it). 

8. Mark the same point above and below with the left mouse button.

� The points appears marked in color. Pay attention to precise 
positioning. 
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7.5.1 Correction scan procedure 

1. Follow the original workflow. Match all tabs.

2. Start the correction scan workflow in the corresponding tab with
Mesh processing | Correction scan.

3. In the scan to be corrected, cut the surface of the defective area.

4. Start the scan of the correction model by clicking on Next.

� Aadva Scan adds a correction tab. 

5. Cut the correction scan to fit the correction area and the neighbouring
areas.

6. When you click on Next, Aadva Scan splits the 3D viewer horizontally
(scan to be corrected above, correction scan below).

� Aadva Scan requests a manual assignment so that the correction scan 
can be inserted into the scan to be corrected. 

7. Rotate the scans so that the perspectives match:

¾ both together via the View menu, 
¾ individually with the mouse (click next to the scan, not on it). 

8. Mark the same point above and below with the left mouse button.

� The points appears marked in color. Pay attention to precise 
positioning. 

9. You can refine the alignment:

¾ CTRL key + left mouse button for further markings (maximum six in 
other colors), 

¾ click once on a position to move the closest marker there, 
¾ press the DEL key to delete the mark. 

10. Confirm the registration by clicking on Next.
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7.5.1 Correction scan procedure 

1. Follow the original workflow. Match all tabs.

2. Start the correction scan workflow in the corresponding tab with
Mesh processing | Correction scan.

3. In the scan to be corrected, cut the surface of the defective area.

4. Start the scan of the correction model by clicking on Next.

� Aadva Scan adds a correction tab. 

5. Cut the correction scan to fit the correction area and the neighbouring
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7.5.1 Correction scan procedure 
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7. Rotate the scans so that the perspectives match:

¾ both together via the View menu, 
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8	 Adding a scan
An additional scan is:

	 a global scan,
	 independent of the workflow.

In a project, the additional scan can:
	 be left as is (additional tab),
	 be combined with another scan.

Universal projects

In universal projects, additional scans are the only way to scan additional perspectives of the universal object. 
The combination of two scans creates a complete 3D model.

Patient and orthodontics projects

An alternative jaw model can be scanned in dental projects with a free workflow. 
An occlusion scan or an articulator scan can be completed.

Prerequisites

Universal project:	 The first scan has been created and matched.
Dental project:	 All scans (workflow) were created and match.

Additional scan types
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8 Adding a scan 

An additional scan is: 
¾ a global scan, 
¾ independent of the workflow. 

In a project, the additional scan can: 
¾ be left as is (additional tab), 
¾ be combined with another scan. 

Universal projects 

In universal projects, additional scans are the only way to scan additional 
perspectives of the universal object. The combination of two scans creates 
a complete 3D model. 

Patient and orthodontics projects 

An alternative jaw model can be scanned in dental projects with a free 
workflow. An occlusion scan or an articulator scan can be completed. 

Prerequisites 

Universal project: The first scan has been created and matched. 

Dental project: All scans (workflow) were created and match. 

Additional scan types 

Which object holder is 
necessary? 

Can the additional scan be 
combined (scan from the 
workflow)? 

Single object Universal plate/object holder Yes 

Several objects multiDie adapter No 

Occlusion Object holder with knurled screw No 

Articulator Articulator No 

TIP 
Alternative methods: 
¾ replace tab (scan again), 

�

Which object holder is necessary? Can the additional scan be combined 
(scan from the workflow)?

Single object Universal plate/object holder Yes
Several objects multiDie adapter No
Occlusion Object holder with knurled screw No
Articulator Articulator No

TIP
Op Alternative methods:

	 replace tab (scan again),
	 correct (replace) a part of a scan. ening from the taskbar is faster if you pin the icon of Aadva Scan to 

the taskbar in the Windows settings.

	 8.1	 Procedure
1.	 Select the desired type from Add scan.

For all project types:
	 Single object
	 Multiple objects (with multiDie adapter)

For dental projects:
	 Occlusion
	 Articulator

2.	 A name is suggested: [Type] #. Add a meaningful, clear, short description.

3.	 Insert the scan object.
4.	 Click on Start.
	
Æ	The scan object is scanned and the result is displayed in a new tab.

 
5.	 Edit the scan if necessary (Mesh Processing tools). Match manually.
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¾ correct (replace) a part of a scan. 

Universal project definition 27 

Scan substitution 50 

Correction scan 58 

Mesh combination 62 

8.1 Procedure 

1. Select the desired type from Add scan.

For all project types: 

¾ Single object 
¾ Multiple objects (with multiDie adapter) 

For dental projects: 

¾ Occlusion 
¾ Articulator 

2. A name is suggested: [Type] #. Add a meaningful, clear, short
description.

3. Insert the scan object.

4. Click on Start.

� The scan object is scanned and the result is displayed in a new tab. 

5. Edit the scan if necessary (Mesh Processing tools). Match manually.

� The additional scan is ready. 

Now you can: 

¾ combine the additional scan with another scan, 
¾ finalize the project. 

Insert jaw model 32 

Insert universal object 38 

Manual matching 48 

Finalizing the project 50 

Mesh processing 51 

More 
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3. Insert the scan object.
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� The scan object is scanned and the result is displayed in a new tab. 

5. Edit the scan if necessary (Mesh Processing tools). Match manually.
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¾ finalize the project. 
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	 Æ	 The additional scan is ready.

Now you can:
	 combine the additional scan with another scan,
	 finalize the project.

8.2	 Combine mesh
A matched additional scan can be combined with another scan of the project if the following applies:

	 additional scan type: Single object;
	 the Aadva Scan itself does not consist of combined data such as a vestibular scan.

Combine mesh is also possible after loading a project.

1.	 Click on the Tab with the additional scan.
 
2.	 Select Mesh Processing | Combine Mesh.

3.	 In the Combine dialog, select the tab you wish to process. Only tabs that can be combined can be 
selected.

4.	 Click on OK.
 
	 Æ	 A tab with a split 3D viewer is displayed in the project (additional scan below, selected scan above).

5.	 Assign the scans manually.

6.	 Finally click on Next.

	 Æ	 The scans are combined: they cannot be separated again. 
		  Aadva Scan calculates a complete 3D model.

TIP
	 Before combining: “Mesh Processing” (cutting, rescan).
	 Before the manual assignment: Rotate the scans

	 Dental projects: same perspective
	 Universal projects: mirrored (if the opposite side was scanned).
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8.2 Combine mesh 

A matched additional scan can be combined with another scan of the 
project if the following applies: 

¾ additional scan type: Single object; 
¾ the Aadva Scan itself does not consist of combined data such as a 

vestibular scan. 

Combine mesh is also possible after loading a project. 

1. Click on the Tab with the additional scan.

2. Select Mesh Processing | Combine Mesh.

3. In the Combine dialog, select the tab you wish to process. Only tabs
that can be combined can be selected.

4. Click on OK.

� A tab with a split 3D viewer is displayed in the project (additional scan 
below, selected scan above). 

5. Assign the scans manually.

6. Finally click on Next.

� The scans are combined: they cannot be separated again. Aadva Scan 
calculates a complete 3D model. 

Tip 
¾ Before combining: “Mesh Processing” (cutting, rescan). 
¾ Before the manual assignment: Rotate the scans 

Dental projects: same perspective 
Universal projects: mirrored (if the opposite side was scanned). 

� OK 

� 44

u 
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9	 View
Under View, you find functions for controlling the view in the 3D viewer.

9.1	 Perspective
           

The cube icons determine from which perspective the scan is displayed in the 3D viewer.

	 The default is the Top perspective (bird’s eye view). 
	 Other perspectives are temporarily activated and not saved.
	 Changing the perspective is useful for visual control, cutting, and assigning.

9.2	 Representation
     

The sphere icons determine the representation of the 3D data model.

	 A change applies to all tabs as long as Aadva Scan is open or in standby mode.
	 Points and Triangles show the geometric structures that make up the 3D representation. These 

representations help to analyse a 3D measurement.
	 The best representation for scanning and editing is Gouraud shading (active by default when the 

software starts).

The geometric structures (points and triangles):
	 are displayed correctly in matched scans, since Aadva Scan only calculates the 3D data model during 

matching,
	 are very delicate and can only be seen with a high magnification (zoom).
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9 View 

Under View, you find functions for controlling the view in the 3D viewer. 

9.1 Perspective 

The cube icons determine from which perspective the scan is displayed in 
the 3D viewer. 

¾ The default is the Top perspective (bird’s eye view).  
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mode. 

¾ Points and Triangles show the geometric structures that make up the 
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measurement. 

¾ The best representation for scanning and editing is Gouraud shading 
(active by default when the software starts). 

The geometric structures (points and triangles): 

¾ are displayed correctly in matched scans, since Aadva Scan only 
calculates the 3D data model during matching, 

¾ are very delicate and can only be seen with a high magnification 
(zoom). 

Points Triangles (networks) Gouraud shading(default) Points	 Triangles (networks) Gouraud shading (default)

 	  	  

9.3	 Rotating, moving, zooming
You can use the mouse to move, rotate, and zoom scans for checking or editing them.
Movements are slightly faster if the 3D objects are displayed by pixels while they are being moved (setting).
The functions of the mouse buttons can be changed.

		  9.3.1	 Selecting the axis of rotation
       

Functions for determining the axis of rotation when the mouse is moved

	 Select View and the desired axis of rotation.
X (longitudinal, horizontal, abscissa),
Y (perpendicular, vertical, ordinate),
Z axis (vertical relative to the X and Y axis, 3rd dimension, applicate).

Æ	 Scans are rotated via the activated axis (otherwise All Axes).

dental Scan Software

Version: 3.4 10-2021 Error! Use the Home tab to apply Überschrift 1 to the text that you want to appear here.63 

9 View 

Under View, you find functions for controlling the view in the 3D viewer. 

9.1 Perspective 

The cube icons determine from which perspective the scan is displayed in 
the 3D viewer. 

¾ The default is the Top perspective (bird’s eye view).  
¾ Other perspectives are temporarily activated and not saved. 
¾ Changing the perspective is useful for visual control, cutting, and 

assigning. 

9.2 Representation 

The sphere icons determine the representation of the 3D data model. 

¾ A change applies to all tabs as long as Aadva Scan is open or in standby 
mode. 

¾ Points and Triangles show the geometric structures that make up the 
3D representation. These representations help to analyse a 3D 
measurement. 

¾ The best representation for scanning and editing is Gouraud shading 
(active by default when the software starts). 

The geometric structures (points and triangles): 

¾ are displayed correctly in matched scans, since Aadva Scan only 
calculates the 3D data model during matching, 

¾ are very delicate and can only be seen with a high magnification 
(zoom). 

Points Triangles (networks) Gouraud shading(default) 

dental Scan Software

Version: 3.4 10-2021 Error! Use the Home tab to apply Überschrift 1 to the text that you want to appear here.63 

9 View 

Under View, you find functions for controlling the view in the 3D viewer. 

9.1 Perspective 

The cube icons determine from which perspective the scan is displayed in 
the 3D viewer. 

¾ The default is the Top perspective (bird’s eye view).  
¾ Other perspectives are temporarily activated and not saved. 
¾ Changing the perspective is useful for visual control, cutting, and 

assigning. 

9.2 Representation 

The sphere icons determine the representation of the 3D data model. 

¾ A change applies to all tabs as long as Aadva Scan is open or in standby 
mode. 

¾ Points and Triangles show the geometric structures that make up the 
3D representation. These representations help to analyse a 3D 
measurement. 

¾ The best representation for scanning and editing is Gouraud shading 
(active by default when the software starts). 

The geometric structures (points and triangles): 

¾ are displayed correctly in matched scans, since Aadva Scan only 
calculates the 3D data model during matching, 

¾ are very delicate and can only be seen with a high magnification 
(zoom). 

Points Triangles (networks) Gouraud shading(default) 

dental Scan Software

Version: 3.4 10-2021 Error! Use the Home tab to apply Überschrift 1 to the text that you want to appear here.64 

9.3 Rotating, moving, zooming 

You can use the mouse to move, rotate, and zoom scans for checking or 
editing them. 

Movements are slightly faster if the 3D objects are displayed by pixels while 
they are being moved (setting). 

The functions of the mouse buttons can be changed. 

9.3.1 Selecting the axis of rotation 

Functions for determining the axis of rotation when the mouse is 
moved 

w Select View and the desired axis of rotation. 

X (longitudinal, horizontal, abscissa), 
Y (perpendicular, vertical, ordinate), 
Z axis (vertical relative to the X and Y axis, 3rd dimension, applicate). 

� Scans are rotated via the activated axis (otherwise All Axes). 

9.3.2 Rotating the scan with the mouse 

1. Right click the central point of the planned rotation (inside or outside
the scan).

2. Hold the mouse button down and move the mouse.

� The scan rotates – depending on the central point – around the 
activated axis. 

3. Release the mouse button to finish.

� The rotation has finished. 

TIP 
Free rotation (with standard mouse button assignment): 

¾ SHIFT key + mouse click � fastens the scan to the mouse. 
¾ Release the SHIFT key, move the mouse (also zooming, moving) 

� The scan rotates. 

Å Æ

� 
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		  9.3.2	 Rotating the scan with the mouse

1.	 Right click the central point of the planned rotation (inside or outside the scan).

2.	 Hold the mouse button down and move the mouse.
	 Æ The scan rotates – depending on the central point – around the activated axis.

3.	 Release the mouse button to finish.
	 Æ The rotation has finished.

  

TIP
Free rotation (with standard mouse button assignment):

	 SHIFT key + mouse click  fastens the scan to the mouse.
	 Release the SHIFT key, move the mouse (also zooming, moving)
	 The scan rotates.
	 Double click to finish.

Example: Rotation around the Y axis
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¾ Double click to finish. 

Example: Rotation around the Y axis 

9.3.3 Moving the scan with the mouse 

1. Click with both mouse buttons on the starting point of the planned
movement (inside or outside the scan).

2. Hold both mouse buttons down and move the mouse.

� The scan follows the motion of the mouse. 

3. Release the mouse buttons when the desired position has been
reached.

� The scan has been moved. 

Å Æ

1 

2 

3 

		
	 9.3.3	 Moving the scan with the mouse

1.	 Click with both mouse buttons on the starting point of the planned movement (inside or outside the 
scan).

2.	 Hold both mouse buttons down and move the mouse.
	 Æ The scan follows the motion of the mouse.

3.	 Release the mouse buttons when the desired position has been reached.
	 Æ The scan has been moved.

shift

Ctrl
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		  9.3.4	 Zooming the scan with the mouse

You can zoom smoothly in and out up to a maximum or minimum size.
	 Point the mouse to any area of the software window.

To enlarge:
	 Turn the scroll wheel towards your hand.

To reduce:
	 Turn the scroll wheel away from your hand.

	 ÆRelease the mouse wheel when you reach the targeted size.
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10	Service position
 

You find Service position in the menu bar and in the context, e.g. in the tab dialog when starting a scan.

When inserting or removing scan objects, the axes of the scanner can move or the position of the scan 
object inside the scanner can change. As a result of such movements, the actual position of the axes no 
longer corresponds to the position that was last saved by Aadva Scan.

Service position corrects the position of the axes and moves them to the home position.
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9.3.4 Zooming the scan with the mouse 

You can zoom smoothly in and out up to a maximum or minimum size. 

w Point the mouse to any area of the software window. 

To enlarge: 

w Turn the scroll wheel towards your hand. 

To reduce: 

w Turn the scroll wheel away from your hand. 

� Release the mouse wheel when you reach the targeted size. 

10 Service position 

You find Service position in the menu bar and in the context, e.g. in the 
tab dialog when starting a scan. 

When inserting or removing scan objects, the axes of the scanner can 
move or the position of the scan object inside the scanner can change. As a 
result of such movements, the actual position of the axes no longer 
corresponds to the position that was last saved by Aadva Scan. 

Service position corrects the position of the axes and moves them to the 
home position. 

11 Projects 

Many files are part of a scan (together: project). Under Projects, you find 
functions for managing projects. 

Projects are saved in the work folder: 
C:\Users\[Username]\Documents\3D-Scanner\Work\[year]. 

11.1 New project 

After the standby mode or with the software open, a new project must be 
created manually. If a project is open, it is saved and closed when a new 
project is created. 

$

#

� 87
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11	Projects
  
Many files are part of a scan (together: project). Under Projects, you find functions for managing projects.

Projects are saved in the work folder: C:\Users\[Username]\Documents\3D-Scanner\Work\[year].

11.1	 New project
 

After the standby mode or with the software open, a new project must be created manually. If a project is 
open, it is saved and closed when a new project is created.
When the software starts, Aadva Scan requests a new project.
	 15

11.2	 Load project
 
Projects can be loaded and edited, e.g. to cut scans. Aadva Scan saves each project in a folder under the 
current work folder.
Folder and project names consist of the creation date and optionally the patient or project name.

	 Open the desired project folder and then the project file (.SOP). Other file formats (e.g. .PCM) cannot 
be loaded.

Æ	 Aadva Scan asks whether work on the project should be resumed or restarted (depending on the 
project; dental projects with the scan modes Baltic Denture, Triple Tray® and Twin Tray must be 
restarted):

Resume

	 All files are kept.
	 Scans can be edited.

Restart

	 All files except for the project file (.SOP) are deleted. 
	 All scans must be repeated.

Load exocad® project:

In Aadva Scan you can also load exocad® projects.

Changes to the project are possible if you open it in exocad® DentalDB. 
In most cases the scans have to be repeated.

exocad® projects with scans contain two project files (.SOP and .dentalproject (exocad® project type)).
1.	 Open the exocad® folder, by default C:\CAD-Data, and then the project folder.
2.	 Select the desired file format (by default.dentalproject).
	 Æ	 The scan data is loaded.

11.3	 Save project as
 
Finalized projects can be archived as ZIP files.

1.	 Load the project that you want to archive. All scans must have been matched.

2.	 Select Save project as.
	 Æ	 A ZIP file is saved in the project folder.

3.	 Check the ZIP file. You can then delete the the scan data (PCM) to free up disk space.
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When the software starts, Aadva Scan requests a new project. 

Project definitions 14 

11.2 Load project 

Projects can be loaded and edited, e.g. to cut scans. Aadva Scan saves each 
project in a folder under the current work folder. 

Folder and project names consist of the creation date and optionally the 
patient or project name. 

w Open the desired project folder and then the project file (.SOP). Other 
file formats (e.g. .PCM) cannot be loaded. 

� Aadva Scan asks whether work on the project should be resumed or 
restarted (depending on the project; dental projects with the scan 
modes Baltic Denture, Triple Tray® and Twin Tray must be restarted): 

Resume 

¾ All files are kept. 
¾ Scans can be edited. 

Restart 

¾ All files except for the project file (.SOP) are deleted. 
¾ All scans must be repeated. 

Load exocad® project: 

In Aadva Scan you can also load exocad® projects. 

Changes to the project are possible if you open it in exocad® DentalDB. 
In most cases the scans have to be repeated. 

exocad® projects with scans contain two project files (.SOP and 
.dentalproject (exocad® project type)). 

1. Open the exocad® folder, by default C:\CAD-Data, and then the project
folder.

2. Select the desired file format (by default.dentalproject).

� The scan data is loaded. 

More 
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11.3 Save project as 

Finalized projects can be archived as ZIP files. 

1. Load the project that you want to archive. All scans must have been
matched.

2. Select Save project as.

� A ZIP file is saved in the project folder. 

3. Check the ZIP file. You can then delete the the scan data (PCM)
to free up disk space.

Load project 67 

Delete old PCM data 74 

11.4 Close project 

Projects can be closed while they are being processed. The current 
processing status is saved and Aadva Scan goes into the standby mode. 

Dental projects with the scan modes Impression, Baltic Denture, 
Triple Tray® and Twin Tray cannot be resumed after closing them. 

11.5 Scanning with exocad® DentalCAD 

exocad® DentalCAD and Aadva Scan are connected by means of an 
interface. Scan projects are created and processed in the 
exocad® DentalDB application. The workflows of Aadva Scan are adapted 
to exocad® projects. 

exocad® projects are saved in the work folder of exocad® DentalCAD. 
Up to version 2.2 Valletta: 
C:\Program Files (x86)\exocadFramework\CAD-Data\

As of version 2.3 Matera: 
C:\CAD-Data\

GC recommends installing exocad® Dental CAD with version 2.3 Matera or 
higher using the GC Setup. 

More 

11.4	 Close project
 
Projects can be closed while they are being processed. The current processing status is saved and Aadva 
Scan goes into the standby mode.

Dental projects with the scan modes Impression, Baltic Denture, Triple Tray® and Twin Tray cannot be 
resumed after closing them.

11.5	 Scanning with exocad® DentalCAD
exocad® DentalCAD and Aadva Scan are connected by means of an interface. 
Scan projects are created and processed in the exocad® DentalDB application. 
The workflows of Aadva Scan are adapted to exocad® projects.
exocad® projects are saved in the work folder of exocad® DentalCAD.

Up to version 2.2 Valletta:

C:\Program Files (x86)\exocadFramework\CAD-Data\

As of version 2.3 Matera:

C:\CAD-Data\
GC recommends installing exocad® Dental CAD with version 2.3 Matera or higher using the GC Setup.

Creating and loading an exocad® project
 

1.	 Create or edit your exocad® project in the DentalDB application (“exo”). Save the project.

2.	 Click on “Scan” to start Aadva Scan.

3.	 Follow the workflow. With existing projects, you can decide whether you want to resume or restart.
	 Æ	 Aadva Scan loads the corresponding data.

Correcting exocad® indications in projects

exocad® projects use the exocad® color codes and also the option symbols.
If you change the indications in an exocad® project, you have to scan again:

1.	 Correct the definition of the exocad® projects in the DentalDB application and save the project.

2.	 Click on Scan to start Aadva Scan.

3.	 Click on Restart in the first and second message Load Project.
	 Æ	 Measurements based on the old indication are deleted. 

4.	 Follow the workflow.
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Creating and loading an exocad® project 

1. Create or edit your exocad® project in the DentalDB application (“exo”).
Save the project.

2. Click on “Scan” to start Aadva Scan.

3. Follow the workflow. With existing projects, you can decide whether
you want to resume or restart.

� Aadva Scan loads the corresponding data. 

Correcting exocad® indications in projects 

exocad® projects use the exocad® color codes and also the option symbols. 

If you change the indications in an exocad® project, you have to scan again: 

1. Correct the definition of the exocad® projects in the DentalDB
application and save the project.

2. Click on Scan to start Aadva Scan.

3. Click on Restart in the first and second message Load Project.

� Measurements based on the old indication are deleted. 

4. Follow the workflow.

Correspondence of the scan modes of exocad® and Aadva Scan 

exocad® DentalDB  
(since v.2.3 Matera) 

Aadva Scan 

Two plaster models, in occlusion Options: 
Two models in occlusion 
Articulator 
Articulator Reference® 
Articulator Artist/Arto® 
Twin Tray 

Two plaster models, in articulator 
Options: 

A Articulator Artex® 
S Articulator SAM® 3 
S (alt) Articulator SAM® 1+2 
P Articulator PROTAR® 
Denar Articulator DENAR® 
Bio-Art Articulator* 
Panadent PCH Articulator* 
Panadent PSH Articulator* 
AD2 Articulator* 

 Scan with Aadva Scan 

Scan with Aadva Scan 

� Restart 
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9 View 

Under View, you find functions for controlling the view in the 3D viewer. 

9.1 Perspective 

The cube icons determine from which perspective the scan is displayed in 
the 3D viewer. 

¾ The default is the Top perspective (bird’s eye view).  
¾ Other perspectives are temporarily activated and not saved. 
¾ Changing the perspective is useful for visual control, cutting, and 

assigning. 

9.2 Representation 

The sphere icons determine the representation of the 3D data model. 

¾ A change applies to all tabs as long as Aadva Scan is open or in standby 
mode. 

¾ Points and Triangles show the geometric structures that make up the 
3D representation. These representations help to analyse a 3D 
measurement. 

¾ The best representation for scanning and editing is Gouraud shading 
(active by default when the software starts). 

The geometric structures (points and triangles): 

¾ are displayed correctly in matched scans, since Aadva Scan only 
calculates the 3D data model during matching, 

¾ are very delicate and can only be seen with a high magnification 
(zoom). 

Points Triangles (networks) Gouraud shading(default) 
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11.4	 Close project
 
Projects can be closed while they are being processed. The current processing status is saved and Aadva 
Scan goes into the standby mode.

Dental projects with the scan modes Impression, Baltic Denture, Triple Tray® and Twin Tray cannot be 
resumed after closing them.

11.5	 Scanning with exocad® DentalCAD
exocad® DentalCAD and Aadva Scan are connected by means of an interface. 
Scan projects are created and processed in the exocad® DentalDB application. 
The workflows of Aadva Scan are adapted to exocad® projects.
exocad® projects are saved in the work folder of exocad® DentalCAD.

Up to version 2.2 Valletta:

C:\Program Files (x86)\exocadFramework\CAD-Data\

As of version 2.3 Matera:

C:\CAD-Data\
GC recommends installing exocad® Dental CAD with version 2.3 Matera or higher using the GC Setup.

Creating and loading an exocad® project
 

1.	 Create or edit your exocad® project in the DentalDB application (“exo”). Save the project.

2.	 Click on “Scan” to start Aadva Scan.

3.	 Follow the workflow. With existing projects, you can decide whether you want to resume or restart.
	 Æ	 Aadva Scan loads the corresponding data.

Correcting exocad® indications in projects

exocad® projects use the exocad® color codes and also the option symbols.
If you change the indications in an exocad® project, you have to scan again:

1.	 Correct the definition of the exocad® projects in the DentalDB application and save the project.

2.	 Click on Scan to start Aadva Scan.

3.	 Click on Restart in the first and second message Load Project.
	 Æ	 Measurements based on the old indication are deleted. 

4.	 Follow the workflow.

dental Scan Software

Version: 3.4 10-2021 Error! Use the Home tab to apply Überschrift 1 to the text that you want to appear here.68 

11.3 Save project as 

Finalized projects can be archived as ZIP files. 

1. Load the project that you want to archive. All scans must have been
matched.

2. Select Save project as.

� A ZIP file is saved in the project folder. 

3. Check the ZIP file. You can then delete the the scan data (PCM)
to free up disk space.

Load project 67 

Delete old PCM data 74 

11.4 Close project 

Projects can be closed while they are being processed. The current 
processing status is saved and Aadva Scan goes into the standby mode. 

Dental projects with the scan modes Impression, Baltic Denture, 
Triple Tray® and Twin Tray cannot be resumed after closing them. 

11.5 Scanning with exocad® DentalCAD 

exocad® DentalCAD and Aadva Scan are connected by means of an 
interface. Scan projects are created and processed in the 
exocad® DentalDB application. The workflows of Aadva Scan are adapted 
to exocad® projects. 

exocad® projects are saved in the work folder of exocad® DentalCAD. 
Up to version 2.2 Valletta: 
C:\Program Files (x86)\exocadFramework\CAD-Data\

As of version 2.3 Matera: 
C:\CAD-Data\

GC recommends installing exocad® Dental CAD with version 2.3 Matera or 
higher using the GC Setup. 

More 
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Creating and loading an exocad® project 

1. Create or edit your exocad® project in the DentalDB application (“exo”).
Save the project.

2. Click on “Scan” to start Aadva Scan.

3. Follow the workflow. With existing projects, you can decide whether
you want to resume or restart.

� Aadva Scan loads the corresponding data. 

Correcting exocad® indications in projects 

exocad® projects use the exocad® color codes and also the option symbols. 

If you change the indications in an exocad® project, you have to scan again: 

1. Correct the definition of the exocad® projects in the DentalDB
application and save the project.

2. Click on Scan to start Aadva Scan.

3. Click on Restart in the first and second message Load Project.

� Measurements based on the old indication are deleted. 

4. Follow the workflow.

Correspondence of the scan modes of exocad® and Aadva Scan 

exocad® DentalDB  
(since v.2.3 Matera) 

Aadva Scan 

Two plaster models, in occlusion Options: 
Two models in occlusion 
Articulator 
Articulator Reference® 
Articulator Artist/Arto® 
Twin Tray 

Two plaster models, in articulator 
Options: 

A Articulator Artex® 
S Articulator SAM® 3 
S (alt) Articulator SAM® 1+2 
P Articulator PROTAR® 
Denar Articulator DENAR® 
Bio-Art Articulator* 
Panadent PCH Articulator* 
Panadent PSH Articulator* 
AD2 Articulator* 

 Scan with Aadva Scan 

Scan with Aadva Scan 

� Restart 
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Creating and loading an exocad® project 

1. Create or edit your exocad® project in the DentalDB application (“exo”).
Save the project.

2. Click on “Scan” to start Aadva Scan.

3. Follow the workflow. With existing projects, you can decide whether
you want to resume or restart.

� Aadva Scan loads the corresponding data. 

Correcting exocad® indications in projects 

exocad® projects use the exocad® color codes and also the option symbols. 

If you change the indications in an exocad® project, you have to scan again: 

1. Correct the definition of the exocad® projects in the DentalDB
application and save the project.

2. Click on Scan to start Aadva Scan.

3. Click on Restart in the first and second message Load Project.

� Measurements based on the old indication are deleted. 

4. Follow the workflow.

Correspondence of the scan modes of exocad® and Aadva Scan 

exocad® DentalDB  
(since v.2.3 Matera) 

Aadva Scan 

Two plaster models, in occlusion Options: 
Two models in occlusion 
Articulator 
Articulator Reference® 
Articulator Artist/Arto® 
Twin Tray 

Two plaster models, in articulator 
Options: 

A Articulator Artex® 
S Articulator SAM® 3 
S (alt) Articulator SAM® 1+2 
P Articulator PROTAR® 
Denar Articulator DENAR® 
Bio-Art Articulator* 
Panadent PCH Articulator* 
Panadent PSH Articulator* 
AD2 Articulator* 

 Scan with Aadva Scan 

Scan with Aadva Scan 

� Restart 

Scan with Aadva Scan 

 Scan with Aadva Scan 

� Restart 
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Correspondence of the scan modes of exocad® and Aadva Scan

exocad® DentalDB 
(since v.2.3 Matera)

Aadva Scan

Two plaster models, in occlusion Two models in occlusion 
Options:
Articulator
Articulator Reference®
Articulator Artist/Arto®
Twin Tray

Two plaster models, in articulator
Options:
A Articulator Artex®
S Articulator SAM® 3
S (alt) Articulator SAM® 1+2
P Articulator PROTAR®
Denar Articulator DENAR®
Bio-Art Articulator*
Panadent PCH Articulator*
Panadent PSH Articulator*
AD2 Articulator*
Digital impression Options:

Triple Tray®
Impression

* Data processing with medium quality articulation
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12	Extras
 

Calibration and Settings are important extra features.

12.1	 Calibration
Calibration is a prerequisite for performing correct measurements. Calibration is mandatory after 
installation or an upgrade.

Recommended repetitions: 

	 Once a month (with automatic reminder) with:
	 constant, normal operating temperatures,
	 normal production volumes.

	 Once daily with:
	 changing or high operating temperatures,
	 high production volumes,

	 after transporting the scanner.

You need:
	 a 3D calibration model,
	 the object holder recommended for your scanner.

The principle of calibration

Every 3D calibration model is measured on a 3D coordinate measuring machine. The reference values are 
therefore very accurate.

Reference values in millimetres

#1: Cylinder height (51.45 – 53.55)
#2: Distance between the hemispheres (9.8 – 10.2)

#1 

#2 

Aadva Scan compares the values: 
Measured values — Reference values = Correction values

The calibration is successful if the new measurement matches the reference values.

Procedure

NOTICE

	 A calibration results in inaccurate measurements if the entered values do not belong to  
the 3D calibration model. Enter the digits as on the label, with commas and decimal places.
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exocad® DentalDB  
(since v.2.3 Matera) 

Aadva Scan 

Digital impression Options: 
¾ Triple Tray® 
¾ Impression 

* Data processing with medium quality articulation

12 Extras 

Calibration and Settings are important extra features. 

12.1 Calibration 

Calibration is a prerequisite for performing correct measurements. 
Calibration is mandatory after installation or an upgrade. 

Recommended repetitions: 

¾ Once a month (with automatic reminder) with: 
constant, normal operating temperatures, 
normal production volumes. 

¾ Once daily with: 
changing or high operating temperatures, 
high production volumes, 

¾ after transporting the scanner. 

You need: 

¾ a 3D calibration model, 
¾ the object holder recommended for your scanner. 

The principle of calibration 

Every 3D calibration model is measured on a 3D coordinate measuring 
machine. The reference values are therefore very accurate. 

Reference values in millimetres 

#1: Cylinder height (51.45 – 53.55) 
#2: Distance between the hemispheres (9.8 – 10.2) 

 Insertion of the 
Calibration Model 

Insertion of 
the Calibration Model
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1.	 Confirm the binding instructions for calibration or select Calibration.
	 Æ	 The Calibration dialog shows the last entered values and when the last calibration was performed.

2.	 Enter the values indicated on the label of the 3D calibration model into fields #1 and #2:

3.	 Click on Start.
	 Æ	 Aadva Scan checks whether the entered values are permissible.

4.	 Wait for the process to finish.
	 Æ	 You are advised of its completion. If successful, you can start scanning.

Error message Possible cause
3D calibration failed. 	 The calibration was interrupted.

	 There is no 3D calibration model inside the scanner.
	 Incorrect values were entered.
	 The axes were not in the service position.

What to do after a failed calibration

	 Inaccurate measurement results are likely. Therefore, you should only scan for testing purposes. 
	 Restart Aadva Scan and the scanner and perform the calibration again.
	 If it fails again: Have the scanner checked by a GC sales partner.

12.2	 Adding an activation code
 

In addition to standard functions, Aadva Scan includes optional modules which can be activated:
	 Virtual articulator (for the articulator scan),
	 multiCase/multiDie,
	 secondDie,
	 Full Impression,
	 Twin Tray Fastmode.

You can see the already activated modules or those included in the scope of delivery of your Aadva Scan 
version in the info dialog.

An activation code consists of numbers and letters, e.g.:
ABCD-EFG12-34H5

Each code applies individually to a specific module and a specific scanner. Activation codes are saved as 
part of the calibration data, in the file Scanner.xml.

Module activation

You receive the activation code from your GC reseller.
  
1.	 Start Aadva Scan.

2.	 Select Extras | Add activation code.

3.	 Enter the code.

4.	 Restart Aadva Scan.
	 Æ	 The module is available for use.

Error message Possible cause
Module not available after the code has 
been entered.

	 Wrong code entered.
	 Softwarnoticee is not valid for the sensor number of the 

scanner*.
OK not active after the code has been 
entered.

	 More activation codes entered than allowed*.

Please contact your GC reseller with the following information:
Aadva Scan version number, sensor number and version number of the scanner.
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exocad® DentalDB  
(since v.2.3 Matera) 

Aadva Scan 

Digital impression Options: 
¾ Triple Tray® 
¾ Impression 

* Data processing with medium quality articulation

12 Extras 

Calibration and Settings are important extra features. 

12.1 Calibration 

Calibration is a prerequisite for performing correct measurements. 
Calibration is mandatory after installation or an upgrade. 

Recommended repetitions: 

¾ Once a month (with automatic reminder) with: 
constant, normal operating temperatures, 
normal production volumes. 

¾ Once daily with: 
changing or high operating temperatures, 
high production volumes, 

¾ after transporting the scanner. 

You need: 

¾ a 3D calibration model, 
¾ the object holder recommended for your scanner. 

The principle of calibration 

Every 3D calibration model is measured on a 3D coordinate measuring 
machine. The reference values are therefore very accurate. 

Reference values in millimetres 

#1: Cylinder height (51.45 – 53.55) 
#2: Distance between the hemispheres (9.8 – 10.2) 

 Insertion of the 
Calibration Model 

1 

2 

3 

4 
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7 5                   
5
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exocad® DentalDB  
(since v.2.3 Matera) 

Aadva Scan 

Digital impression Options: 
¾ Triple Tray® 
¾ Impression 

* Data processing with medium quality articulation

12 Extras 

Calibration and Settings are important extra features. 

12.1 Calibration 

Calibration is a prerequisite for performing correct measurements. 
Calibration is mandatory after installation or an upgrade. 

Recommended repetitions: 

¾ Once a month (with automatic reminder) with: 
constant, normal operating temperatures, 
normal production volumes. 

¾ Once daily with: 
changing or high operating temperatures, 
high production volumes, 

¾ after transporting the scanner. 

You need: 

¾ a 3D calibration model, 
¾ the object holder recommended for your scanner. 

The principle of calibration 

Every 3D calibration model is measured on a 3D coordinate measuring 
machine. The reference values are therefore very accurate. 

Reference values in millimetres 

#1: Cylinder height (51.45 – 53.55) 
#2: Distance between the hemispheres (9.8 – 10.2) 

 Insertion of the 
Calibration Model 
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12.2 Adding an activation code 

In addition to standard functions, Aadva Scan includes optional modules 
which can be activated: 

¾ Virtual articulator (for the articulator scan), 
¾ multiCase/multiDie, 
¾ secondDie, 
¾ Full Impression, 
¾ Twin Tray Fastmode. 

You can see the already activated modules or those included in the scope 
of delivery of your Aadva Scan version in the info dialog. 
An activation code consists of numbers and letters, e.g.: 

ABCD-EFG12-34H5 
Each code applies individually to a specific module and a specific scanner. 
Activation codes are saved as part of the calibration data, in the file 
Scanner.xml. 

Module activation 

You receive the activation code from your GC reseller. 

1. Start Aadva Scan.

2. Select Extras | Add activation code.

3. Enter the code.

4. Restart Aadva Scan.

� The module is available for use. 

Error Possible cause 

Module not available after the 
code has been entered. 

¾ Wrong code entered. 
¾ Software restart omitted. 
¾ The code is not valid for the sensor 

number of the scanner*. 

OK not active after the code has 
been entered. 

¾ More activation codes entered than 
allowed*. 

* Please contact your GC reseller with the following information:
Aadva Scan version number, sensor number and version number of the scanner.

�  Error! Bookmark not

defined. 

� 74
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12.3	 Deleting old PCM data
 
PCM files (single measurements) take up a lot of storage space in the work folder of Aadva Scan. 
Only the results of finalized projects are necessary (PLY, STL files).
PCM files older than 30 days can be deleted by Aadva Scan.

NOTICE

PCM files belonging to exocad® projects are not deleted.

12.4	 Info
 

Licence information and further information about your software version can be found in the info dialog.
Important for support cases:

	 external and internal version number,
	 commit (version control),
	 date and time of the version,
	 Activated modules.
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12.3 Deleting old PCM data 

PCM files (single measurements) take up a lot of storage space in the work 
folder of Aadva Scan. Only the results of finalized projects are necessary 
(PLY, STL files). 

PCM files older than 30 days can be deleted by Aadva Scan. 

PCM files belonging to exocad® projects are not deleted. 

12.4 Info 

Licence information and further information about your software version 
can be found in the info dialog. 

Important for support cases: 

¾ external and internal version number, 
¾ commit (version control), 
¾ date and time of the version, 
¾ Activated modules. 

Modules and hardware based functions Error! Bookmark not defined. 

Adding an activation code 73 

�

More 
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13	Settings
 

Settings can be found in context-related manner (bottom menu bar, project definition, tab dialogs). 
Most changes are effective immediately. 
Comprehensive changes such as the display language require a software restart.

TIP

After an upgrade or a new installation, you can continue to work with your personal settings.

13.1	 General

13.1.1	 Language

Concerns:	 Software texts (operating items, info line, messages).
Effect:	 Display in the selected language.
Comment:	 Changing the language requires the software to be restarted.

	 Select language and restart Aadva Scan.

Default value: Windows language

13.1.2	 Tooth numbering system

Concerns:	 “Patient” project definition
Effect:	 Labelling of the tooth chart:

	 FDI (Europe),
	 UNS (US).

Comment:	 The tooth numbering system of Aadva Scan can differ from the one in the CAD system.

	 Select your preferred tooth numbering system (dental chart).

Default value: FDI (Europe)

13.1.3	 Project mode

Concerns:	 Project definition
Effect:	 Suggested value for creating new projects: 
Patient, Universal, multiCase or Orthodontics.
Comment:	 “Patient” stands for dental projects.

	 Select the project mode that you use most often.

Default value: Patient

13.1.4	 Extended (general)

Standby mode

Concerns:	 Standby mode
Effect:	 Standby after project completion (workflow) and Close project (function).
Comment:	 Standby speeds up the software restart.

	 Disable if Aadva Scan should be closed after the project has been finalized. 
	 Useful if you rarely use Aadva Scan.

Default value: ✓  – enabled
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13 Settings 

Settings can be found in context-related manner (bottom menu bar, 
project definition, tab dialogs). Most changes are effective immediately. 
Comprehensive changes such as the display language require a software 
restart. 

TIP 
After an upgrade or a new installation, you can continue to work with 
your personal settings. 

General 75 
View 77 
Scanning 82 
Processing 84 
Export 87 

Restore default settings 90 

13.1 General 

13.1.1 Language 

Concerns: Software texts (operating items, info line, messages). 
Effect: Display in the selected language. 
Comment: Changing the language requires the software to be 

restarted. 

w Select language and restart Aadva Scan. 

Default value: Windows language 

13.1.2 Tooth numbering system 

Concerns: “Patient” project definition 
Effect: Labelling of the tooth chart: 

¾ FDI (Europe), 
¾ UNS (US). 

Comment: The tooth numbering system of Aadva Scan can differ from 
the one in the CAD system. 

w Select your preferred tooth numbering system (dental chart). 

Default value: FDI (Europe) 

�
� 90

More 

� 17
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Go to the removal position

Concerns:	 Presentation (singleDie, secondDie)
Effect:	 The stump to be presented is moved to the removal position.
Comment:	 When disabled: Start at the service position.

Default value: ✓  – enabled

Use standard mouse button configuration

Concerns:	 3D viewer
Effect:	 Moving, rotating and zooming the scan with the mouse.

Default value: ✓  – enabled

By default

Rotate the scan
Hold the right mouse button, 
move the mouse.

Move the scan
Hold both mouse buttons, 
move the mouse.

Assignment Left click.

Zooming Turn the mouse wheel.

When disabled

Rotate the scan
Hold the left mouse button, 
move the mouse.

Move the scan
Hold the right mouse button, 
move the mouse.

Assignment Left double click.

Zooming
Turn the mouse wheel 
(no change).

13.2	 Visualization

13.2.1	 Rendering

Smoothing

Concerns:	 3D viewer
Effect:	 Surface smoothing of the scan.
Comment:	 Optical effect, has no influence on the 3D measurement.

	 Select a value between 0 – 100.

Default value: 0 (OFF)
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Brightness reflection

Concerns:	 3D viewer
Effect:	 Brightness of the light reflection on the scan.
Comment:	 Optical effect, has no influence on the 3D measurement.

	 Select a value between 0 – 100.
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Brightness reflection 

Concerns: 3D viewer 
Effect: Brightness of the light reflection on the scan. 
Comment: Optical effect, has no influence on the 3D measurement. 

w Select a value between 0 – 100. 

Brightness 0 Brightness 100 

Default value: 0 (OFF) 

Reflectance 

Concerns: 3D viewer 
Effect: Intensity of the light reflection on the scan. 
Comment: Optical effect, has no influence on the 3D measurement. 

w Select a value between 0-100. 

Default value: 0 (OFF) 

Transparency 

Concerns: 3D viewer 
Effect: Transparency effect of the scan. 
Comment: Optical effect, has no influence on the 3D measurement. 

w Select a value between 0.1 and 1.0. 

Transparency 0.1 Transparency 1.0 

Default value: 1.0 
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Å Æ 

Brightness 0 Brightness 100

Default value: 0 (OFF)

Reflectance

Concerns:	 3D viewer
Effect:	 Intensity of the light reflection on the scan.
Comment:	 Optical effect, has no influence on the 3D measurement.

	 Select a value between 0-100.

Default value: 0 (OFF)

Transparency

Concerns:	 3D viewer
Effect:	 Transparency effect of the scan.
Comment:	 Optical effect, has no influence on the 3D measurement.

	 Select a value between 0.1 and 1.0.

 	

dental Scan Software

Version: 3.4 10-2021 Error! Use the Home tab to apply Überschrift 1 to the text that you want to appear here.78 

Brightness reflection 

Concerns: 3D viewer 
Effect: Brightness of the light reflection on the scan. 
Comment: Optical effect, has no influence on the 3D measurement. 

w Select a value between 0 – 100. 

Brightness 0 Brightness 100 

Default value: 0 (OFF) 

Reflectance 

Concerns: 3D viewer 
Effect: Intensity of the light reflection on the scan. 
Comment: Optical effect, has no influence on the 3D measurement. 

w Select a value between 0-100. 

Default value: 0 (OFF) 

Transparency 

Concerns: 3D viewer 
Effect: Transparency effect of the scan. 
Comment: Optical effect, has no influence on the 3D measurement. 

w Select a value between 0.1 and 1.0. 

Transparency 0.1 Transparency 1.0 

Default value: 1.0 
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Å Æ 
Transparancy 0,1 Transparancy 1,0

Default value: 1.0

13.2.2 Colors

Object | multiDie/multiCase | Rescan object | Rescan shadow

Concerns:	 3D viewer
Effect:	 Colors for a uniform, clear representation.

Option All scans.
multiDie/multiCase Single segments.
Rescan object Newly scanned areas in the rescan.
Rescan shadows Areas that cannot be scanned in the rescan.

Comment:	 Colors in the 3D viewer are not photorealistic and have no influence on the 3D measurement.

Texture scans change the color representation.
	 Shadow color: helps to find the right perspective during the rescan.
	 Object color rescan: applies to the following:
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12.2 Adding an activation code 

In addition to standard functions, Aadva Scan includes optional modules 
which can be activated: 

¾ Virtual articulator (for the articulator scan), 
¾ multiCase/multiDie, 
¾ secondDie, 
¾ Full Impression, 
¾ Twin Tray Fastmode. 

You can see the already activated modules or those included in the scope 
of delivery of your Aadva Scan version in the info dialog. 
An activation code consists of numbers and letters, e.g.: 

ABCD-EFG12-34H5 
Each code applies individually to a specific module and a specific scanner. 
Activation codes are saved as part of the calibration data, in the file 
Scanner.xml. 

Module activation 

You receive the activation code from your GC reseller. 

1. Start Aadva Scan.

2. Select Extras | Add activation code.

3. Enter the code.

4. Restart Aadva Scan.

� The module is available for use. 

Error Possible cause 

Module not available after the 
code has been entered. 

¾ Wrong code entered. 
¾ Software restart omitted. 
¾ The code is not valid for the sensor 

number of the scanner*. 

OK not active after the code has 
been entered. 

¾ More activation codes entered than 
allowed*. 

* Please contact your GC reseller with the following information:
Aadva Scan version number, sensor number and version number of the scanner.

�  Error! Bookmark not

defined. 

� 74
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Rescan (after launching), correction, matching.

	 Click on a color box and select a color from the Windows color scheme (please no dark or light colors, 
pay attention to the contrast to the background).

Comparison of display types (material: light brown)
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13.2.2 Colors 

Object | multiDie/multiCase | Rescan object | Rescan shadow 

Concerns: 3D viewer 
Effect: Colors for a uniform, clear representation. 

Option All scans. 
multiDie/multiCase Single segments. 
Rescan object Newly scanned areas in the rescan. 
Rescan shadows Areas that cannot be scanned in the 

rescan. 
Comment: Colors in the 3D viewer are not photorealistic and have 

no influence on the 3D measurement. 
Texture scans change the color representation. 

¾ Shadow color: helps to find the right perspective during 
the rescan. 

¾ Object color rescan: applies to the following: 
Rescan (after launching), correction, matching. 

w Click on a color box and select a color from the Windows color scheme 
(please no dark or light colors, pay attention to the contrast to the 
background). 

Comparison of display types (material: light brown) 
Object color Monochrome texture scan Color texture scan 

Default values: 

Option 

RGB 251, 188, 94 | Color hue 24, saturation 228, brightness 162 

multiDie/multiCase 

RGB 205, 170, 125 | Color hue 22, saturation 107, brightness 155 

Rescan object 

RGB 192, 192, 192 | Color hue 160, saturation 0, brightness 181 

Rescan shadows 

RGB 0, 0, 102 | Color hue 160, saturation 240, brightness 48 

� 11
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Object color Monochrome texture scan Color texture scan

Default values:
 
Option

RGB 251, 188, 94 | Color hue 24, saturation 228, brightness 162
 
multiDie/multiCase

RGB 205, 170, 125 | Color hue 22, saturation 107, brightness 155
 
Rescan object

RGB 192, 192, 192 | Color hue 160, saturation 0, brightness 181
 
Rescan shadows

RGB 0, 0, 102 | Color hue 160, saturation 240, brightness 48

13.2.3	Extended (View)

Show point cloud when moving objects

Concerns:	 3D viewer
Effect:	 Representation when moving the scan with the mouse.
Comment:	 Optimizes speed.
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13.2.3 Extended (View) 

Show point cloud when moving objects 

Concerns: 3D viewer 
Effect: Representation when moving the scan with the mouse. 
Comment: Optimizes speed. 

Default value: � – disabled 

Show point cloud in highest quality 

Concerns: 3D viewer 
Effect: Display in best resolution. 
Comment: Optical effect, has no influence on the 3D measurement. 

High performance of the graphics card is required. 

w Disable if it causes problems. 

Default value: � – enabled 

Show shadows in the rescan mode 

Concerns: Rescan mode. 
Effect: Shadows to highlight those areas that cannot be rescanned. 
Comment: ¾ Shadow: blue (the color can be changed); it disappears 

by changing the perspective of the camera. 
¾ After rescanning: grey areas were rescanned (the color 

can be changed but not disabled). 

� 11

� 11
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Default value: ✓  – enabled

Show point cloud in highest quality

Concerns:	 3D viewer
Effect:	 Display in best resolution.
Comment:	 Optical effect, has no influence on the 3D measurement.

High performance of the graphics card is required.

	 Disable if it causes problems.

Default value: ✓  – enabled
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Show shadows in the rescan mode

Concerns:	 Rescan mode.
Effect:	 Shadows to highlight those areas that cannot be rescanned.

Comment:	 	 	 Shadow: blue (the color can be changed); it disappears by changing 
			   the perspective of the camera.
		  	 After rescanning: grey areas were rescanned (the color can be changed but not disabled).
Example: 
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Example: Rescan areas  
With shadow Without shadow 

  

w Disable if you don’t need to highlight unscannable areas. 

Default value: � – enabled 

Show tooth numbers in the preview image 

Concerns: 2D viewer 
Effect: The tooth number is displayed next to the marking of a 

tooth position. 
Comment: If a cutting radius is also defined, circular cutting lines in the 

size of the cutting radius are displayed in the 2D viewer. 
 
Simple position markers UNS numbering FDI numbering with a 

12 mm cutting radius 

   

w Enable tooth numbering as a guide. 

Default value: � – disabled 
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Cutting Radius � 85 

Rescan areas 
With shadow

Without shadow

	 Disable if you don’t need to highlight unscannable areas.

Default value: ✓  – enabled

Show tooth numbers in the preview image

Concerns:	 2D viewer
Effect:	 The tooth number is displayed next to the marking of a tooth position.
Comment:	 If a cutting radius is also defined, circular cutting lines in the size 
		  of the cutting radius are displayed in the 2D viewer.
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Example: Rescan areas  
With shadow Without shadow 

  

w Disable if you don’t need to highlight unscannable areas. 

Default value: � – enabled 

Show tooth numbers in the preview image 

Concerns: 2D viewer 
Effect: The tooth number is displayed next to the marking of a 

tooth position. 
Comment: If a cutting radius is also defined, circular cutting lines in the 

size of the cutting radius are displayed in the 2D viewer. 
 
Simple position markers UNS numbering FDI numbering with a 

12 mm cutting radius 

   

w Enable tooth numbering as a guide. 

Default value: � – disabled 
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Cutting Radius � 85 
Simple position markers	 UNS numbering FDI numbering with a 12 

mm cutting radius

 
	 Enable tooth numbering as a guide.

Default value: ✓  – enabled
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13.3	 Scanning

		  13.3.1 Presentation mode

Concerns:	 Presentation of individual segments of a jaw model.
Effect:	 Suggested value for the presentation mode in new projects:

	 singleDie
Presentation of each individual tooth in the jaw model, one after the other,

	 secondDie
Presentation of every second tooth; reduces the scanning processes to a maximum of two,

	 multiDie
Presentation of all segments with the multiDie adapter.
Comment:	 	 The enabling of the presentation mode can also be done in the tab dialogs.
		  	 “Complete jaw” (no presentation) is not possible as a suggested value.

	 Select the presentation mode that you use most often.

Default value: secondDie

		  13.3.2 Plaster type

Bright | medium | dark

Concerns:	 Color of the scan object
Effect:	 Light intensity of the sensor during the 3D measurement.
Comment:	 The scanner measures the brightness of colors differently than the human eye.

	 Please test colorful materials before conducting productive scans.
	 Black items must always be scanned with a scan spray.

Default value: Medium

		  13.3.3 Texture mode

Disabled | monochrome | color

Concerns:	 Markings on the surface of a scan object.
Effect:	 Scans with markings, e.g. contour lines for model cast prostheses 
		  (manufactured using SilaPart® from SILADENT (CAD system)).

Comment:	 	 Color texture scans show markings in different colors; 
			   otherwise they have the same information value.
		  	 The enabling of texture scans can also be done in the tab dialogs.
		  	 Single color (monochrome) texture scans are possible with all scanners.

	 Select the suggested value Monochrome or Color to always start scans with texture scan.

Default value: Disabled

Optimization for markings (reduces edge sharpness)

Concerns:	 Markings on the surface of a scan object.
Effect:	 	 Optimizes texture scans to calculate marked contour lines in a particularly precise manner.
		  	 It is advantageous for the production of a model cast prosthesis.
Comment:	 Side effect: General smoothing of edges in the 3D data, 
		  e.g. also smoothing of fissures or sharp edges of the scan object. 

	 Enable if needed. Use texture scans without markings for full edge sharpness.

Default value: ✓  – enabled
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13.3.4 Extended (scanning)

Switch to the rescan mode after each presentation

Concerns:	 Presentation of single segments.
Effect:	 Enables the rescan mode after a presentation.
Comment:	 Can be useful if presented segments have to be rescanned on a regular basis.

Default value: ✓  – enabled

13.4	 Processing

		  13.4.1 Quality

Standard | opposing jaw | squeeze bite | impression scan | wax-up | gingiva | abutment | situ

Concerns:	 Dental indications, other scans (standard).
Effect:	 Sensor accuracy/resolution
		  Size of the 3D model dataset.
Comment:	 Four quality levels: Very high, high, normal, low.
		  The higher the resolution, the larger the data set.

	 Select the appropriate quality level, e.g. “very high” for complex dental constructions, “low” for archiving.

Default value: High, impression scan: Very high 

		  13.4.2 Cutting Tools

Enable the automatic cutting plane

Concerns:	 Automatic cutting plane.
Effect:	 Method to cut the model base.
Comment:	 The height of the cutting plane can be individually regulated; 
		  areas below the cutting plane are deleted during matching.

	 Disable if you do not use the cutting plane.

Default value: ✓  – enabled

Automatic cutting of the multiCase/multiDie adapter
 
Concerns:	 multiDie presentation mode
		  multiCase project definition.
Effect:	 Automatic cutting of the adapter and presentation of the segments.
Comment:	 Additional manual cutting is possible.

	 Disable if you do not use multiCase/multiDie.

Default value: ✓  – enabled

Cutting radius for the stump
Concerns:	 Automatic cutting in dental projects.
Effect:	 Data in the radius around indexed tooth positions is saved, everything else is cut.
Comment:	 	 2D viewer: The cutting radius becomes visible around the marked tooth positions 
			   (size of the circles = cutting radius).
		  	 Everything is scanned without a cutting radius.

Highest value
200 mm

Lowest value
12 mm

Default
200 mm
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Cutting radius for the stump 

Concerns: Automatic cutting in dental projects. 
Effect: Data in the radius around indexed tooth positions is saved, 

everything else is cut. 
Comment: ¾ 2D viewer: The cutting radius becomes visible around 

the marked tooth positions (size of the circles = cutting 
radius). 

¾ Everything is scanned without a cutting radius. 
 Highest value Lowest value Default 

200 mm 12 mm 200 mm 

  

w Test the size with typical jaw models. 

Default value: � – disabled 

13.4.3 Extended (Processing) 

Start matching immediately after the scan 

Concerns:  Automatic matching. 
Effect: Forces matching directly after scanning; applies to suitable 

projects, e.g. complete jaws individually. 
Comment: No pause in the workflow for manual mesh processing 

before matching; the cutting filters and the automatic 
cutting plane are taken into account. 

w Enable if you don’t need to manually edit scans. 

Default value: � – disabled 

Cutting Radius 
2D and 3D viewers 

� 48 

 	  
	 Test the size with typical jaw models.

Default value: ✓  – enabled

13.4.3	Extended (Processing)

Start matching immediately after the scan

Concerns:	
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All tabs can be matched in a single step 

Concerns:  Manual matching. 
Effect: Matching is performed simultaneously on all unmatched 

tabs (otherwise individually). 
Comment: Not relevant for vestibular scans (the following always 

applies for these: Matching in one step). 

w Disable if you wish to always check the scan data before matching. 

Default value: � – enabled 

Allow cutting of PCMs 

Concerns: Manual cutting (Mesh processing). 
Effect: Allows cutting of single images (PCM) instead of 3D data 

(PLY, STL). 
Comment: ¾ Accelerates subsequent processes. 

¾ It has no influence on the automatic cutting plane. 

w Disable if manual cutting should only be possible after matching. 

Default value: � – enabled 

Background matching 

Concerns:  Automatic matching. 
Effect: Matching while the scanning process is running. 
Comment: Accelerates the subsequent data processing. 

w Disable if you wish to always check the scan data before matching. 

Default value: � – enabled 

 

� 48 

� 52 

� 48 

  Automatic matching.
Effect:	 Forces matching directly after scanning; applies to suitable projects, 
		  e.g. complete jaws individually.
Comment:	 No pause in the workflow for manual mesh processing before matching; t
		  he cutting filters and the automatic cutting plane are taken into account.

	 Enable if you don’t need to manually edit scans.

Default value: ✓  – enabled

All tabs can be matched in a single step

Concerns:	
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All tabs can be matched in a single step 

Concerns:  Manual matching. 
Effect: Matching is performed simultaneously on all unmatched 

tabs (otherwise individually). 
Comment: Not relevant for vestibular scans (the following always 

applies for these: Matching in one step). 

w Disable if you wish to always check the scan data before matching. 

Default value: � – enabled 

Allow cutting of PCMs 

Concerns: Manual cutting (Mesh processing). 
Effect: Allows cutting of single images (PCM) instead of 3D data 

(PLY, STL). 
Comment: ¾ Accelerates subsequent processes. 

¾ It has no influence on the automatic cutting plane. 

w Disable if manual cutting should only be possible after matching. 

Default value: � – enabled 

Background matching 

Concerns:  Automatic matching. 
Effect: Matching while the scanning process is running. 
Comment: Accelerates the subsequent data processing. 

w Disable if you wish to always check the scan data before matching. 

Default value: � – enabled 

 

� 48 

� 52 

� 48 

 Manual matching.
Effect:	 Matching is performed simultaneously on all unmatched tabs (otherwise individually).
Comment:	 Not relevant for vestibular scans (the following always applies for these: Matching in one step).

	 Disable if you wish to always check the scan data before matching.

Default value: ✓  – enabled

Allow cutting of PCMs

Concerns:	 Manual cutting (Mesh processing).
Effect:	 Allows cutting of single images (PCM) instead of 3D data (PLY, STL).
Comment:	 	 Accelerates subsequent processes.
		  	 It has no influence on the automatic cutting plane.

	 Disable if manual cutting should only be possible after matching.

Default value: ✓  – enabled

Background matching

Concerns:	
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All tabs can be matched in a single step 

Concerns:  Manual matching. 
Effect: Matching is performed simultaneously on all unmatched 

tabs (otherwise individually). 
Comment: Not relevant for vestibular scans (the following always 

applies for these: Matching in one step). 

w Disable if you wish to always check the scan data before matching. 

Default value: � – enabled 

Allow cutting of PCMs 

Concerns: Manual cutting (Mesh processing). 
Effect: Allows cutting of single images (PCM) instead of 3D data 

(PLY, STL). 
Comment: ¾ Accelerates subsequent processes. 

¾ It has no influence on the automatic cutting plane. 

w Disable if manual cutting should only be possible after matching. 

Default value: � – enabled 

Background matching 

Concerns:  Automatic matching. 
Effect: Matching while the scanning process is running. 
Comment: Accelerates the subsequent data processing. 

w Disable if you wish to always check the scan data before matching. 

Default value: � – enabled 
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 Automatic matching.
Effect:	 Matching while the scanning process is running.
Comment:	 Accelerates the subsequent data processing.

	 Disable if you wish to always check the scan data before matching.

Default value: ✓  – enabled

Cutting Radius
2D and 3D viewers
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13.5	 Export

13.5.1	 Work folder

Concerns:	 Saving location.
Effect:	 Path specification for Aadva Scan projects.

Comment:	 The following applies to the [YYYY] subfolders:
		  	 automatic change to the current year after a software upgrade,
		  	 no automatic change at the turn of the year.
 			   When scanning with a CAD system, its work directory applies. 
			   For exocad®:
			   C:\CAD-Data (depending on the exocad® version).

	 Change the path specification to organize the scan data (local shared folder, network path for shared 
use). Enter the path or select it from the folder structure using the … button.

A cache directory can be useful for a network path.

Default value:
C:\Users\[Username]\Documents\3D-Scanner\Work\[YYYY]

13.5.2	 Cache directory

Concerns:	 Network work directory.
Effect:	 Specifying the path to a fast cache directory results in scan projects being processed 
		  in the cache directory and loaded into the work directory when the project is finalized.
Comment:	 	 It makes sense if scan data is saved in the network and it takes 
			   too long to save/load data there.
		  	 Must be located on a fast drive (SSD).

	 Enter the path or select it from the folder structure using the … button.

Default value: ✓  – enabled

When enabled C:\Users\[User]\AppData\Local\Temp\3D-Scanner\

13.5.3	Data alignment

Save scan data with transformed coordinates
 
Concerns:	 Scan data
Effect:	 		 Transformation of the XYZ coordinates.
		  		 Aadva Scan saves two PLY or STL files, one as “custom_transform”, 
			   e.g.2019-05-14-150913-upperjaw_custom_transform.ply
Comment:	 		 Each point of the scan data is located in the 3D data network using 
			   3 coordinates (standard orthogonal coordinate system XYZ (latitude, longitude, height)).
		  		 Aadva Scan and the CAD software must use the same coordinate system.

	 Enable if an adjustment to the CAD software is necessary.
	 Assign the X, Y and Z coordinates (positive or negative, i.e. mirror or rotate). Aadva Scan automatically 

corrects geometrically impossible combinations.

Default value: ✓  – enabled
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13.5 Export 

13.5.1 Work folder 

Concerns: Saving location. 
Effect: Path specification for Aadva Scan projects. 
Comment: The following applies to the [YYYY] subfolders: 

¾ automatic change to the current year after a software 
upgrade, 

¾ no automatic change at the turn of the year. 

 
When scanning with a CAD system, its work directory 
applies. For exocad®: 
C:\CAD-Data (depending on the exocad® version). 

w Change the path specification to organize the scan data (local shared 
folder, network path for shared use). Enter the path or select it from 
the folder structure using the … button. 

A cache directory can be useful for a network path. 

Default value: 
C:\Users\[Username]\Documents\3D-Scanner\Work\[YYYY] 

13.5.2 Cache directory 

Concerns: Network work directory. 
Effect: Specifying the path to a fast cache directory results in scan 

projects being processed in the cache directory and loaded 
into the work directory when the project is finalized. 

Comment: ¾ It makes sense if scan data is saved in the network and 
it takes too long to save/load data there. 

¾ Must be located on a fast drive (SSD). 

w Enter the path or select it from the folder structure using the … button. 

Default value: � – disabled 
When enabled C:\Users\[User]\AppData\Local\Temp\3D-Scanner\ 
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13.5.3 Data alignment 

Save scan data with transformed coordinates 

Concerns: Scan data 
Effect: ¾ Transformation of the XYZ coordinates. 

¾ Aadva Scan saves two PLY or STL files, one as 
“custom_transform”, e.g.2019-05-14-150913-
upperjaw_custom_transform.ply 

Comment: ¾ Each point of the scan data is located in the 3D data 
network using 3 coordinates (standard orthogonal 
coordinate system XYZ (latitude, longitude, height)). 

¾ Aadva Scan and the CAD software must use the same 
coordinate system. 

w Enable if an adjustment to the CAD software is necessary. 

w Assign the X, Y and Z coordinates (positive or negative, i.e. mirror or 
rotate). Aadva Scan automatically corrects geometrically impossible 
combinations. 

Default value: � – disabled 

13.5.4 Extended (export) 

Also save the scan data in STL format 

Concerns: Project completion 
Effect: Combination of all scan data (individual images in PCM 

format) to form an STL file (in addition to the standard 
PLY format). 

Comment: PLY: Polygon File Format (with texture information) 
STL: Standard Triangulation Language (without texture 
information) 

w Enable if your CAD system requires data in STL format. 

 
NOTICE 

w If you close the project after matching all tabs, a PLY file is saved. End 
projects with “Finalize project” to create STL files. 

Default value: � – disabled (only PLY) 
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13.5.4	 Extended (export)

Also save the scan data in STL format

Concerns:	 Project completion
Effect:	 Combination of all scan data (individual images in PCM format) 
		  to form an STL file (in addition to the standard PLY format).
Comment:	 PLY: Polygon File Format (with texture information)
STL: 	 Standard Triangulation Language (without texture information)

	 Enable if your CAD system requires data in STL format.
 

NOTICE

	 If you close the project after matching all tabs, a PLY file is saved. 
	 End projects with “Finalize project” to create STL files.

Default value: ✓  – enabled

Additionally create vestibular mesh

Concerns:	 Vestibular scan.
Effect:	 A 3D data file (PLY, STL - optional) is created for the vestibular scan.
Comment:	 This setting is not required for vestibular scans that are created with Add Scan.

Default value: ✓  – enabled

Use patient names in the project name

Concerns:	 Projec tdefinition   Project ID.
Effect:	 	 Default naming (unique ID:
			   Timestamp YYYY-MM-DD-hhmmss, 
			   e.g. 2019-05-10-135720
		  	 Naming with patient or project names:
			   The name is added, 
			   e.g. 2019-05-10-135720-Smith,Jane
Comment:	 Project folders and project files are also named using the timestamp.

	 Enable to generate names with patient or project names.

Default value: ✓  – enabled

13.5.5	 Diagnosis data

Export stripe images (service folder)

Concerns:	 Technical support,
		  not for users.
Effect:	 Creation of stripe photos (black and white photos with the stripe projection of the scanner).
		  Saving location:
		  C:\ProgramData\3D-Scanner\DeviceCharacteristics\Service
		  This setting is not saved.
Comment:	 Stripe images are used to analyse technical problems.

	 Enable in consultation with the technical support and scan immediately.
	 Send the PGN files to the technical support. 

Default value (cannot be changed):  ✓  – enabled
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13.5.3 Data alignment 

Save scan data with transformed coordinates 

Concerns: Scan data 
Effect: ¾ Transformation of the XYZ coordinates. 

¾ Aadva Scan saves two PLY or STL files, one as 
“custom_transform”, e.g.2019-05-14-150913-
upperjaw_custom_transform.ply 

Comment: ¾ Each point of the scan data is located in the 3D data 
network using 3 coordinates (standard orthogonal 
coordinate system XYZ (latitude, longitude, height)). 

¾ Aadva Scan and the CAD software must use the same 
coordinate system. 

w Enable if an adjustment to the CAD software is necessary. 

w Assign the X, Y and Z coordinates (positive or negative, i.e. mirror or 
rotate). Aadva Scan automatically corrects geometrically impossible 
combinations. 

Default value: � – disabled 

13.5.4 Extended (export) 

Also save the scan data in STL format 

Concerns: Project completion 
Effect: Combination of all scan data (individual images in PCM 

format) to form an STL file (in addition to the standard 
PLY format). 

Comment: PLY: Polygon File Format (with texture information) 
STL: Standard Triangulation Language (without texture 
information) 

w Enable if your CAD system requires data in STL format. 

 
NOTICE 

w If you close the project after matching all tabs, a PLY file is saved. End 
projects with “Finalize project” to create STL files. 

Default value: � – disabled (only PLY) 
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Extended logging

Concerns:	 Technical support,
		  not for users.
Effect:	 Creation of log files.
		  Saving location:
		  C:\Users\[Name]\AppData\Local\3D-Scanner\Sessions
		  Subfolder with timestamp (project start and completion)
Comment:	 Log files are used to analyse technical issues. Enabling is saved until Aadva Scan is closed.

	 Enable in consultation with the technical support, scan immediately and sent the log files to the technical 
support.

Default value: ✓  – enabled

13.6	 Restore default settings
Aadva Scan saves:

	 the default settings in the installation folder,
	 a work copy in the local user folder:

	 C:\Users\[Username]\AppData\Local\3D-Scanner.

The file UserSettings.xml:
	 contains the user settings (Settings dialog).
	 It must be deleted to restore the default settings.

TIP
Make a backup copy of the file UserSettings.xml so that you can restore your old personal settings if 
necessary.

1.	 Exit Aadva Scan.
2.	 Open Windows Explorer
3.	 Under View, activate the checkbox Hidden Elements.
4.	 Open the folder: 
	 C:\Users\[Username]\AppData\Local\3D-Scanner.
5.	 Delete the file UserSettings.xml.
6.	 Start Aadva Scan.

Æ	The default settings apply again. Personal settings are saved in a new User
	 Settings.xml file.
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14	Indexes
14.1	 Icons

Dialogs

Icon Meaning Page
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14 Indexes 

 

14.1 Icons 

Dialogs 

Icon Meaning � 
   

 
Show and hide info area 10 

 Matched scan 14 

 Unmatched scan 14 

 Delete an indication 20 

  Globalscan strategy ON/ OFF (“Enhanced mode”) 29 

 Cancel 30 

 Start 30 

  HR mode ON/OFF 30 

 Skip scan 31 

 
Repeat scan 31 

 Check scan and rescan 31 

 Smart occlusion Error! 
Bookmark 
not 
defined. 

 
Determine starting scan height (with Z axis) 31 

  Rotate view (scan height) (Z axis) 31 

 Set scan height to default (Z axis) 31 

 Manual matching 48 

 Check matching (3D) 49 

 Service position 66 

 Settings 75 

Scan tabs 

Icons \Scans 

  
Aesthetic template 

  Upper jaw, lower jaw (toothed or toothless) 

   

Vestibular, toothed – toothless 
Baltic Denture  

Show and hide info area

dental Scan Software
   

Version: 3.4 10-2021 Error! Use the Home tab to apply Überschrift 1 to the text that you want to appear here.92 

14 Indexes 
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Dialogs 

Icon Meaning � 
   

 
Show and hide info area 10 

 Matched scan 14 

 Unmatched scan 14 

 Delete an indication 20 

  Globalscan strategy ON/ OFF (“Enhanced mode”) 29 

 Cancel 30 

 Start 30 

  HR mode ON/OFF 30 

 Skip scan 31 

 
Repeat scan 31 

 Check scan and rescan 31 

 Smart occlusion Error! 
Bookmark 
not 
defined. 

 
Determine starting scan height (with Z axis) 31 

  Rotate view (scan height) (Z axis) 31 

 Set scan height to default (Z axis) 31 

 Manual matching 48 

 Check matching (3D) 49 

 Service position 66 

 Settings 75 

Scan tabs 

Icons \Scans 

  
Aesthetic template 

  Upper jaw, lower jaw (toothed or toothless) 

   

Vestibular, toothed – toothless 
Baltic Denture  

Matched scan
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Show and hide info area 10 

 Matched scan 14 

 Unmatched scan 14 

 Delete an indication 20 

  Globalscan strategy ON/ OFF (“Enhanced mode”) 29 

 Cancel 30 

 Start 30 

  HR mode ON/OFF 30 

 Skip scan 31 

 
Repeat scan 31 

 Check scan and rescan 31 
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Bookmark 
not 
defined. 

 
Determine starting scan height (with Z axis) 31 

  Rotate view (scan height) (Z axis) 31 

 Set scan height to default (Z axis) 31 

 Manual matching 48 

 Check matching (3D) 49 
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 Settings 75 

Scan tabs 

Icons \Scans 
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Baltic Denture  

Unmatched scan
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 Check matching (3D) 49 
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 Settings 75 

Scan tabs 

Icons \Scans 

  
Aesthetic template 
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Vestibular, toothed – toothless 
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Delete an indication
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Show and hide info area 10 

 Matched scan 14 

 Unmatched scan 14 

 Delete an indication 20 

  Globalscan strategy ON/ OFF (“Enhanced mode”) 29 

 Cancel 30 

 Start 30 

  HR mode ON/OFF 30 

 Skip scan 31 

 
Repeat scan 31 

 Check scan and rescan 31 
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Bookmark 
not 
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Scan tabs 

Icons \Scans 

  
Aesthetic template 
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Baltic Denture  
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  Globalscan strategy ON/ OFF (“Enhanced mode”) 29 

 Cancel 30 

 Start 30 

  HR mode ON/OFF 30 

 Skip scan 31 

 
Repeat scan 31 

 Check scan and rescan 31 

 Smart occlusion Error! 
Bookmark 
not 
defined. 

 
Determine starting scan height (with Z axis) 31 

  Rotate view (scan height) (Z axis) 31 

 Set scan height to default (Z axis) 31 

 Manual matching 48 

 Check matching (3D) 49 

 Service position 66 

 Settings 75 

Scan tabs 

Icons \Scans 

  
Aesthetic template 

  Upper jaw, lower jaw (toothed or toothless) 

   

Vestibular, toothed – toothless 
Baltic Denture  

Cancel

dental Scan Software
   

Version: 3.4 10-2021 Error! Use the Home tab to apply Überschrift 1 to the text that you want to appear here.92 

14 Indexes 

 

14.1 Icons 

Dialogs 

Icon Meaning � 
   

 
Show and hide info area 10 

 Matched scan 14 

 Unmatched scan 14 

 Delete an indication 20 

  Globalscan strategy ON/ OFF (“Enhanced mode”) 29 

 Cancel 30 

 Start 30 

  HR mode ON/OFF 30 

 Skip scan 31 

 
Repeat scan 31 

 Check scan and rescan 31 

 Smart occlusion Error! 
Bookmark 
not 
defined. 

 
Determine starting scan height (with Z axis) 31 

  Rotate view (scan height) (Z axis) 31 

 Set scan height to default (Z axis) 31 

 Manual matching 48 

 Check matching (3D) 49 

 Service position 66 

 Settings 75 

Scan tabs 

Icons \Scans 

  
Aesthetic template 

  Upper jaw, lower jaw (toothed or toothless) 

   

Vestibular, toothed – toothless 
Baltic Denture  

Start

dental Scan Software
   

Version: 3.4 10-2021 Error! Use the Home tab to apply Überschrift 1 to the text that you want to appear here.92 

14 Indexes 

 

14.1 Icons 

Dialogs 

Icon Meaning � 
   

 
Show and hide info area 10 

 Matched scan 14 

 Unmatched scan 14 

 Delete an indication 20 

  Globalscan strategy ON/ OFF (“Enhanced mode”) 29 

 Cancel 30 

 Start 30 

  HR mode ON/OFF 30 

 Skip scan 31 

 
Repeat scan 31 

 Check scan and rescan 31 

 Smart occlusion Error! 
Bookmark 
not 
defined. 

 
Determine starting scan height (with Z axis) 31 

  Rotate view (scan height) (Z axis) 31 

 Set scan height to default (Z axis) 31 

 Manual matching 48 

 Check matching (3D) 49 

 Service position 66 

 Settings 75 

Scan tabs 

Icons \Scans 

  
Aesthetic template 

  Upper jaw, lower jaw (toothed or toothless) 

   

Vestibular, toothed – toothless 
Baltic Denture  

HR mode ON/OFF

dental Scan Software
   

Version: 3.4 10-2021 Error! Use the Home tab to apply Überschrift 1 to the text that you want to appear here.92 

14 Indexes 

 

14.1 Icons 

Dialogs 

Icon Meaning � 
   

 
Show and hide info area 10 

 Matched scan 14 

 Unmatched scan 14 

 Delete an indication 20 

  Globalscan strategy ON/ OFF (“Enhanced mode”) 29 

 Cancel 30 

 Start 30 

  HR mode ON/OFF 30 

 Skip scan 31 

 
Repeat scan 31 

 Check scan and rescan 31 

 Smart occlusion Error! 
Bookmark 
not 
defined. 

 
Determine starting scan height (with Z axis) 31 

  Rotate view (scan height) (Z axis) 31 

 Set scan height to default (Z axis) 31 

 Manual matching 48 

 Check matching (3D) 49 

 Service position 66 

 Settings 75 

Scan tabs 

Icons \Scans 

  
Aesthetic template 

  Upper jaw, lower jaw (toothed or toothless) 

   

Vestibular, toothed – toothless 
Baltic Denture  

Skip scan

dental Scan Software
   

Version: 3.4 10-2021 Error! Use the Home tab to apply Überschrift 1 to the text that you want to appear here.92 

14 Indexes 

 

14.1 Icons 

Dialogs 

Icon Meaning � 
   

 
Show and hide info area 10 

 Matched scan 14 

 Unmatched scan 14 

 Delete an indication 20 

  Globalscan strategy ON/ OFF (“Enhanced mode”) 29 

 Cancel 30 

 Start 30 

  HR mode ON/OFF 30 

 Skip scan 31 

 
Repeat scan 31 

 Check scan and rescan 31 

 Smart occlusion Error! 
Bookmark 
not 
defined. 

 
Determine starting scan height (with Z axis) 31 

  Rotate view (scan height) (Z axis) 31 

 Set scan height to default (Z axis) 31 

 Manual matching 48 

 Check matching (3D) 49 

 Service position 66 

 Settings 75 

Scan tabs 

Icons \Scans 

  
Aesthetic template 

  Upper jaw, lower jaw (toothed or toothless) 

   

Vestibular, toothed – toothless 
Baltic Denture  

Repeat scan

dental Scan Software
   

Version: 3.4 10-2021 Error! Use the Home tab to apply Überschrift 1 to the text that you want to appear here.92 

14 Indexes 

 

14.1 Icons 

Dialogs 

Icon Meaning � 
   

 
Show and hide info area 10 

 Matched scan 14 

 Unmatched scan 14 

 Delete an indication 20 

  Globalscan strategy ON/ OFF (“Enhanced mode”) 29 

 Cancel 30 

 Start 30 

  HR mode ON/OFF 30 

 Skip scan 31 

 
Repeat scan 31 

 Check scan and rescan 31 

 Smart occlusion Error! 
Bookmark 
not 
defined. 

 
Determine starting scan height (with Z axis) 31 

  Rotate view (scan height) (Z axis) 31 

 Set scan height to default (Z axis) 31 

 Manual matching 48 

 Check matching (3D) 49 

 Service position 66 

 Settings 75 

Scan tabs 

Icons \Scans 

  
Aesthetic template 

  Upper jaw, lower jaw (toothed or toothless) 

   

Vestibular, toothed – toothless 
Baltic Denture  

Check scan and rescan

dental Scan Software
   

Version: 3.4 10-2021 Error! Use the Home tab to apply Überschrift 1 to the text that you want to appear here.92 

14 Indexes 

 

14.1 Icons 

Dialogs 

Icon Meaning � 
   

 
Show and hide info area 10 

 Matched scan 14 

 Unmatched scan 14 

 Delete an indication 20 

  Globalscan strategy ON/ OFF (“Enhanced mode”) 29 

 Cancel 30 

 Start 30 

  HR mode ON/OFF 30 

 Skip scan 31 

 
Repeat scan 31 

 Check scan and rescan 31 

 Smart occlusion Error! 
Bookmark 
not 
defined. 

 
Determine starting scan height (with Z axis) 31 

  Rotate view (scan height) (Z axis) 31 

 Set scan height to default (Z axis) 31 

 Manual matching 48 

 Check matching (3D) 49 

 Service position 66 

 Settings 75 

Scan tabs 

Icons \Scans 

  
Aesthetic template 

  Upper jaw, lower jaw (toothed or toothless) 

   

Vestibular, toothed – toothless 
Baltic Denture  

Smart occlusion

dental Scan Software
   

Version: 3.4 10-2021 Error! Use the Home tab to apply Überschrift 1 to the text that you want to appear here.92 

14 Indexes 

 

14.1 Icons 

Dialogs 

Icon Meaning � 
   

 
Show and hide info area 10 

 Matched scan 14 

 Unmatched scan 14 

 Delete an indication 20 

  Globalscan strategy ON/ OFF (“Enhanced mode”) 29 

 Cancel 30 

 Start 30 

  HR mode ON/OFF 30 

 Skip scan 31 

 
Repeat scan 31 

 Check scan and rescan 31 

 Smart occlusion Error! 
Bookmark 
not 
defined. 

 
Determine starting scan height (with Z axis) 31 

  Rotate view (scan height) (Z axis) 31 

 Set scan height to default (Z axis) 31 

 Manual matching 48 

 Check matching (3D) 49 

 Service position 66 

 Settings 75 

Scan tabs 

Icons \Scans 

  
Aesthetic template 

  Upper jaw, lower jaw (toothed or toothless) 

   

Vestibular, toothed – toothless 
Baltic Denture  

Determine starting scan height (with Z axis)

dental Scan Software
   

Version: 3.4 10-2021 Error! Use the Home tab to apply Überschrift 1 to the text that you want to appear here.92 

14 Indexes 

 

14.1 Icons 

Dialogs 

Icon Meaning � 
   

 
Show and hide info area 10 

 Matched scan 14 

 Unmatched scan 14 

 Delete an indication 20 

  Globalscan strategy ON/ OFF (“Enhanced mode”) 29 

 Cancel 30 

 Start 30 

  HR mode ON/OFF 30 

 Skip scan 31 

 
Repeat scan 31 

 Check scan and rescan 31 

 Smart occlusion Error! 
Bookmark 
not 
defined. 

 
Determine starting scan height (with Z axis) 31 

  Rotate view (scan height) (Z axis) 31 

 Set scan height to default (Z axis) 31 

 Manual matching 48 

 Check matching (3D) 49 

 Service position 66 

 Settings 75 

Scan tabs 

Icons \Scans 

  
Aesthetic template 

  Upper jaw, lower jaw (toothed or toothless) 

   

Vestibular, toothed – toothless 
Baltic Denture  

Rotate view (scan height) (Z axis)

dental Scan Software
   

Version: 3.4 10-2021 Error! Use the Home tab to apply Überschrift 1 to the text that you want to appear here.92 

14 Indexes 

 

14.1 Icons 

Dialogs 

Icon Meaning � 
   

 
Show and hide info area 10 

 Matched scan 14 

 Unmatched scan 14 

 Delete an indication 20 

  Globalscan strategy ON/ OFF (“Enhanced mode”) 29 

 Cancel 30 

 Start 30 

  HR mode ON/OFF 30 

 Skip scan 31 

 
Repeat scan 31 

 Check scan and rescan 31 

 Smart occlusion Error! 
Bookmark 
not 
defined. 

 
Determine starting scan height (with Z axis) 31 

  Rotate view (scan height) (Z axis) 31 

 Set scan height to default (Z axis) 31 

 Manual matching 48 

 Check matching (3D) 49 

 Service position 66 

 Settings 75 

Scan tabs 

Icons \Scans 

  
Aesthetic template 

  Upper jaw, lower jaw (toothed or toothless) 

   

Vestibular, toothed – toothless 
Baltic Denture  

Set scan height to default (Z axis)

dental Scan Software
   

Version: 3.4 10-2021 Error! Use the Home tab to apply Überschrift 1 to the text that you want to appear here.92 

14 Indexes 

 

14.1 Icons 

Dialogs 

Icon Meaning � 
   

 
Show and hide info area 10 

 Matched scan 14 

 Unmatched scan 14 

 Delete an indication 20 

  Globalscan strategy ON/ OFF (“Enhanced mode”) 29 

 Cancel 30 

 Start 30 

  HR mode ON/OFF 30 

 Skip scan 31 

 
Repeat scan 31 

 Check scan and rescan 31 

 Smart occlusion Error! 
Bookmark 
not 
defined. 

 
Determine starting scan height (with Z axis) 31 

  Rotate view (scan height) (Z axis) 31 

 Set scan height to default (Z axis) 31 

 Manual matching 48 

 Check matching (3D) 49 

 Service position 66 

 Settings 75 

Scan tabs 

Icons \Scans 

  
Aesthetic template 

  Upper jaw, lower jaw (toothed or toothless) 

   

Vestibular, toothed – toothless 
Baltic Denture  

Manual matching

dental Scan Software
   

Version: 3.4 10-2021 Error! Use the Home tab to apply Überschrift 1 to the text that you want to appear here.92 

14 Indexes 

 

14.1 Icons 

Dialogs 

Icon Meaning � 
   

 
Show and hide info area 10 

 Matched scan 14 

 Unmatched scan 14 

 Delete an indication 20 

  Globalscan strategy ON/ OFF (“Enhanced mode”) 29 

 Cancel 30 

 Start 30 

  HR mode ON/OFF 30 

 Skip scan 31 

 
Repeat scan 31 

 Check scan and rescan 31 

 Smart occlusion Error! 
Bookmark 
not 
defined. 

 
Determine starting scan height (with Z axis) 31 

  Rotate view (scan height) (Z axis) 31 

 Set scan height to default (Z axis) 31 

 Manual matching 48 

 Check matching (3D) 49 

 Service position 66 

 Settings 75 

Scan tabs 

Icons \Scans 

  
Aesthetic template 

  Upper jaw, lower jaw (toothed or toothless) 

   

Vestibular, toothed – toothless 
Baltic Denture  

Check matching (3D)

dental Scan Software
   

Version: 3.4 10-2021 Error! Use the Home tab to apply Überschrift 1 to the text that you want to appear here.92 

14 Indexes 

 

14.1 Icons 

Dialogs 

Icon Meaning � 
   

 
Show and hide info area 10 

 Matched scan 14 

 Unmatched scan 14 

 Delete an indication 20 

  Globalscan strategy ON/ OFF (“Enhanced mode”) 29 

 Cancel 30 

 Start 30 

  HR mode ON/OFF 30 

 Skip scan 31 

 
Repeat scan 31 

 Check scan and rescan 31 

 Smart occlusion Error! 
Bookmark 
not 
defined. 

 
Determine starting scan height (with Z axis) 31 

  Rotate view (scan height) (Z axis) 31 

 Set scan height to default (Z axis) 31 

 Manual matching 48 

 Check matching (3D) 49 

 Service position 66 

 Settings 75 

Scan tabs 

Icons \Scans 

  
Aesthetic template 

  Upper jaw, lower jaw (toothed or toothless) 

   

Vestibular, toothed – toothless 
Baltic Denture  

Service position

dental Scan Software
   

Version: 3.4 10-2021 Error! Use the Home tab to apply Überschrift 1 to the text that you want to appear here.92 

14 Indexes 

 

14.1 Icons 

Dialogs 

Icon Meaning � 
   

 
Show and hide info area 10 

 Matched scan 14 

 Unmatched scan 14 

 Delete an indication 20 

  Globalscan strategy ON/ OFF (“Enhanced mode”) 29 

 Cancel 30 

 Start 30 

  HR mode ON/OFF 30 

 Skip scan 31 

 
Repeat scan 31 

 Check scan and rescan 31 

 Smart occlusion Error! 
Bookmark 
not 
defined. 

 
Determine starting scan height (with Z axis) 31 

  Rotate view (scan height) (Z axis) 31 

 Set scan height to default (Z axis) 31 

 Manual matching 48 

 Check matching (3D) 49 

 Service position 66 

 Settings 75 

Scan tabs 

Icons \Scans 

  
Aesthetic template 

  Upper jaw, lower jaw (toothed or toothless) 

   

Vestibular, toothed – toothless 
Baltic Denture  

Settings



68

Scan tabs
Icons \Scans

dental Scan Software
   

Version: 3.4 10-2021 Error! Use the Home tab to apply Überschrift 1 to the text that you want to appear here.92 

14 Indexes 

 

14.1 Icons 

Dialogs 

Icon Meaning � 
   

 
Show and hide info area 10 

 Matched scan 14 

 Unmatched scan 14 

 Delete an indication 20 

  Globalscan strategy ON/ OFF (“Enhanced mode”) 29 

 Cancel 30 

 Start 30 

  HR mode ON/OFF 30 

 Skip scan 31 

 
Repeat scan 31 

 Check scan and rescan 31 

 Smart occlusion Error! 
Bookmark 
not 
defined. 

 
Determine starting scan height (with Z axis) 31 

  Rotate view (scan height) (Z axis) 31 

 Set scan height to default (Z axis) 31 

 Manual matching 48 

 Check matching (3D) 49 

 Service position 66 

 Settings 75 

Scan tabs 

Icons \Scans 

  
Aesthetic template 

  Upper jaw, lower jaw (toothed or toothless) 

   

Vestibular, toothed – toothless 
Baltic Denture  

Aesthetic template

dental Scan Software
   

Version: 3.4 10-2021 Error! Use the Home tab to apply Überschrift 1 to the text that you want to appear here.92 

14 Indexes 

 

14.1 Icons 

Dialogs 

Icon Meaning � 
   

 
Show and hide info area 10 

 Matched scan 14 

 Unmatched scan 14 

 Delete an indication 20 

  Globalscan strategy ON/ OFF (“Enhanced mode”) 29 

 Cancel 30 

 Start 30 

  HR mode ON/OFF 30 

 Skip scan 31 

 
Repeat scan 31 

 Check scan and rescan 31 

 Smart occlusion Error! 
Bookmark 
not 
defined. 

 
Determine starting scan height (with Z axis) 31 

  Rotate view (scan height) (Z axis) 31 

 Set scan height to default (Z axis) 31 

 Manual matching 48 

 Check matching (3D) 49 

 Service position 66 

 Settings 75 

Scan tabs 

Icons \Scans 

  
Aesthetic template 

  Upper jaw, lower jaw (toothed or toothless) 

   

Vestibular, toothed – toothless 
Baltic Denture  

Upper jaw, lower jaw (toothed or toothless)

dental Scan Software
   

Version: 3.4 10-2021 Error! Use the Home tab to apply Überschrift 1 to the text that you want to appear here.92 

14 Indexes 

 

14.1 Icons 

Dialogs 

Icon Meaning � 
   

 
Show and hide info area 10 

 Matched scan 14 

 Unmatched scan 14 

 Delete an indication 20 

  Globalscan strategy ON/ OFF (“Enhanced mode”) 29 

 Cancel 30 

 Start 30 

  HR mode ON/OFF 30 

 Skip scan 31 

 
Repeat scan 31 

 Check scan and rescan 31 

 Smart occlusion Error! 
Bookmark 
not 
defined. 

 
Determine starting scan height (with Z axis) 31 

  Rotate view (scan height) (Z axis) 31 

 Set scan height to default (Z axis) 31 

 Manual matching 48 

 Check matching (3D) 49 

 Service position 66 

 Settings 75 

Scan tabs 

Icons \Scans 

  
Aesthetic template 

  Upper jaw, lower jaw (toothed or toothless) 

   

Vestibular, toothed – toothless 
Baltic Denture  

Vestibular, toothed – toothless Baltic Denture 

dental Scan Software
   

Version: 3.4 10-2021 Error! Use the Home tab to apply Überschrift 1 to the text that you want to appear here.93 

Icons \Scans 

  
Wax-up of upper and lower jaw 

  
Situ of upper and lower jaw 

  
Scanbody in upper and lower jaw 

  
Gingiva of upper and lower jaw 

  
Squeeze bite of upper and lower jaw 

  Triple Tray® impression of upper and lower jaw 

  
Impression of upper and lower jaw 

  

Twin tray upper and lower jaw, 
with and without occlusion 

  
Additional scan and mesh combination 

 
 Correction scan 

 
 multiCase/multiDie 

 
 Calibration 

 

14.2 Menus and key combinations 

 �   

NumLock 

� 
 

 

Mesh processing  Add Scan Visualization  Service position 

Cut inside 
 

Single object Front 
 

— 

Cut outside 
 

Several objects Back 
 

 

Cut the surface 
 

Occlusion Left 
 

 

Save 
�  

Articulator Right 
 

 

Rescan 
 

 Top 
 

 

Trigger scan 
 

 Bottom 
 

 

Trigger scan sequence 
�  

 Points   

Undo  
Rescan, Cut �  

 Triangles   

Wax-up of upper and lower jaw

dental Scan Software
   

Version: 3.4 10-2021 Error! Use the Home tab to apply Überschrift 1 to the text that you want to appear here.93 

Icons \Scans 

  
Wax-up of upper and lower jaw 

  
Situ of upper and lower jaw 

  
Scanbody in upper and lower jaw 

  
Gingiva of upper and lower jaw 

  
Squeeze bite of upper and lower jaw 

  Triple Tray® impression of upper and lower jaw 

  
Impression of upper and lower jaw 

  

Twin tray upper and lower jaw, 
with and without occlusion 

  
Additional scan and mesh combination 

 
 Correction scan 

 
 multiCase/multiDie 

 
 Calibration 

 

14.2 Menus and key combinations 

 �   

NumLock 

� 
 

 

Mesh processing  Add Scan Visualization  Service position 

Cut inside 
 

Single object Front 
 

— 

Cut outside 
 

Several objects Back 
 

 

Cut the surface 
 

Occlusion Left 
 

 

Save 
�  

Articulator Right 
 

 

Rescan 
 

 Top 
 

 

Trigger scan 
 

 Bottom 
 

 

Trigger scan sequence 
�  

 Points   

Undo  
Rescan, Cut �  

 Triangles   

Situ of upper and lower jaw

dental Scan Software
   

Version: 3.4 10-2021 Error! Use the Home tab to apply Überschrift 1 to the text that you want to appear here.93 

Icons \Scans 

  
Wax-up of upper and lower jaw 

  
Situ of upper and lower jaw 

  
Scanbody in upper and lower jaw 

  
Gingiva of upper and lower jaw 

  
Squeeze bite of upper and lower jaw 

  Triple Tray® impression of upper and lower jaw 

  
Impression of upper and lower jaw 

  

Twin tray upper and lower jaw, 
with and without occlusion 

  
Additional scan and mesh combination 

 
 Correction scan 

 
 multiCase/multiDie 

 
 Calibration 

 

14.2 Menus and key combinations 

 �   

NumLock 

� 
 

 

Mesh processing  Add Scan Visualization  Service position 

Cut inside 
 

Single object Front 
 

— 

Cut outside 
 

Several objects Back 
 

 

Cut the surface 
 

Occlusion Left 
 

 

Save 
�  

Articulator Right 
 

 

Rescan 
 

 Top 
 

 

Trigger scan 
 

 Bottom 
 

 

Trigger scan sequence 
�  

 Points   

Undo  
Rescan, Cut �  

 Triangles   

Scanbody in upper and lower jaw

dental Scan Software
   

Version: 3.4 10-2021 Error! Use the Home tab to apply Überschrift 1 to the text that you want to appear here.93 

Icons \Scans 

  
Wax-up of upper and lower jaw 

  
Situ of upper and lower jaw 

  
Scanbody in upper and lower jaw 

  
Gingiva of upper and lower jaw 

  
Squeeze bite of upper and lower jaw 

  Triple Tray® impression of upper and lower jaw 

  
Impression of upper and lower jaw 

  

Twin tray upper and lower jaw, 
with and without occlusion 

  
Additional scan and mesh combination 

 
 Correction scan 

 
 multiCase/multiDie 

 
 Calibration 

 

14.2 Menus and key combinations 

 �   

NumLock 

� 
 

 

Mesh processing  Add Scan Visualization  Service position 

Cut inside 
 

Single object Front 
 

— 

Cut outside 
 

Several objects Back 
 

 

Cut the surface 
 

Occlusion Left 
 

 

Save 
�  

Articulator Right 
 

 

Rescan 
 

 Top 
 

 

Trigger scan 
 

 Bottom 
 

 

Trigger scan sequence 
�  

 Points   

Undo  
Rescan, Cut �  

 Triangles   

Gingiva of upper and lower jaw

dental Scan Software
   

Version: 3.4 10-2021 Error! Use the Home tab to apply Überschrift 1 to the text that you want to appear here.93 

Icons \Scans 

  
Wax-up of upper and lower jaw 

  
Situ of upper and lower jaw 

  
Scanbody in upper and lower jaw 

  
Gingiva of upper and lower jaw 

  
Squeeze bite of upper and lower jaw 

  Triple Tray® impression of upper and lower jaw 

  
Impression of upper and lower jaw 

  

Twin tray upper and lower jaw, 
with and without occlusion 

  
Additional scan and mesh combination 

 
 Correction scan 

 
 multiCase/multiDie 

 
 Calibration 

 

14.2 Menus and key combinations 

 �   

NumLock 

� 
 

 

Mesh processing  Add Scan Visualization  Service position 

Cut inside 
 

Single object Front 
 

— 

Cut outside 
 

Several objects Back 
 

 

Cut the surface 
 

Occlusion Left 
 

 

Save 
�  

Articulator Right 
 

 

Rescan 
 

 Top 
 

 

Trigger scan 
 

 Bottom 
 

 

Trigger scan sequence 
�  

 Points   

Undo  
Rescan, Cut �  

 Triangles   

Squeeze bite of upper and lower jaw

dental Scan Software
   

Version: 3.4 10-2021 Error! Use the Home tab to apply Überschrift 1 to the text that you want to appear here.93 

Icons \Scans 

  
Wax-up of upper and lower jaw 

  
Situ of upper and lower jaw 

  
Scanbody in upper and lower jaw 

  
Gingiva of upper and lower jaw 

  
Squeeze bite of upper and lower jaw 

  Triple Tray® impression of upper and lower jaw 

  
Impression of upper and lower jaw 

  

Twin tray upper and lower jaw, 
with and without occlusion 

  
Additional scan and mesh combination 

 
 Correction scan 

 
 multiCase/multiDie 

 
 Calibration 

 

14.2 Menus and key combinations 

 �   

NumLock 

� 
 

 

Mesh processing  Add Scan Visualization  Service position 

Cut inside 
 

Single object Front 
 

— 

Cut outside 
 

Several objects Back 
 

 

Cut the surface 
 

Occlusion Left 
 

 

Save 
�  

Articulator Right 
 

 

Rescan 
 

 Top 
 

 

Trigger scan 
 

 Bottom 
 

 

Trigger scan sequence 
�  

 Points   

Undo  
Rescan, Cut �  

 Triangles   

Triple Tray® impression of upper and lower jaw

dental Scan Software
   

Version: 3.4 10-2021 Error! Use the Home tab to apply Überschrift 1 to the text that you want to appear here.93 

Icons \Scans 

  
Wax-up of upper and lower jaw 

  
Situ of upper and lower jaw 

  
Scanbody in upper and lower jaw 

  
Gingiva of upper and lower jaw 

  
Squeeze bite of upper and lower jaw 

  Triple Tray® impression of upper and lower jaw 

  
Impression of upper and lower jaw 

  

Twin tray upper and lower jaw, 
with and without occlusion 

  
Additional scan and mesh combination 

 
 Correction scan 

 
 multiCase/multiDie 

 
 Calibration 

 

14.2 Menus and key combinations 

 �   

NumLock 

� 
 

 

Mesh processing  Add Scan Visualization  Service position 

Cut inside 
 

Single object Front 
 

— 

Cut outside 
 

Several objects Back 
 

 

Cut the surface 
 

Occlusion Left 
 

 

Save 
�  

Articulator Right 
 

 

Rescan 
 

 Top 
 

 

Trigger scan 
 

 Bottom 
 

 

Trigger scan sequence 
�  

 Points   

Undo  
Rescan, Cut �  

 Triangles   

Impression of upper and lower jaw

dental Scan Software
   

Version: 3.4 10-2021 Error! Use the Home tab to apply Überschrift 1 to the text that you want to appear here.93 

Icons \Scans 

  
Wax-up of upper and lower jaw 

  
Situ of upper and lower jaw 

  
Scanbody in upper and lower jaw 

  
Gingiva of upper and lower jaw 

  
Squeeze bite of upper and lower jaw 

  Triple Tray® impression of upper and lower jaw 

  
Impression of upper and lower jaw 

  

Twin tray upper and lower jaw, 
with and without occlusion 

  
Additional scan and mesh combination 

 
 Correction scan 

 
 multiCase/multiDie 

 
 Calibration 

 

14.2 Menus and key combinations 

 �   

NumLock 

� 
 

 

Mesh processing  Add Scan Visualization  Service position 

Cut inside 
 

Single object Front 
 

— 

Cut outside 
 

Several objects Back 
 

 

Cut the surface 
 

Occlusion Left 
 

 

Save 
�  

Articulator Right 
 

 

Rescan 
 

 Top 
 

 

Trigger scan 
 

 Bottom 
 

 

Trigger scan sequence 
�  

 Points   

Undo  
Rescan, Cut �  

 Triangles   

Twin tray upper and lower jaw, with and without occlusion

dental Scan Software
   

Version: 3.4 10-2021 Error! Use the Home tab to apply Überschrift 1 to the text that you want to appear here.93 

Icons \Scans 

  
Wax-up of upper and lower jaw 

  
Situ of upper and lower jaw 

  
Scanbody in upper and lower jaw 

  
Gingiva of upper and lower jaw 

  
Squeeze bite of upper and lower jaw 

  Triple Tray® impression of upper and lower jaw 

  
Impression of upper and lower jaw 

  

Twin tray upper and lower jaw, 
with and without occlusion 

  
Additional scan and mesh combination 

 
 Correction scan 

 
 multiCase/multiDie 

 
 Calibration 

 

14.2 Menus and key combinations 

 �   

NumLock 

� 
 

 

Mesh processing  Add Scan Visualization  Service position 

Cut inside 
 

Single object Front 
 

— 

Cut outside 
 

Several objects Back 
 

 

Cut the surface 
 

Occlusion Left 
 

 

Save 
�  

Articulator Right 
 

 

Rescan 
 

 Top 
 

 

Trigger scan 
 

 Bottom 
 

 

Trigger scan sequence 
�  

 Points   

Undo  
Rescan, Cut �  

 Triangles   

Additional scan and mesh combination

dental Scan Software
   

Version: 3.4 10-2021 Error! Use the Home tab to apply Überschrift 1 to the text that you want to appear here.93 

Icons \Scans 

  
Wax-up of upper and lower jaw 

  
Situ of upper and lower jaw 

  
Scanbody in upper and lower jaw 

  
Gingiva of upper and lower jaw 

  
Squeeze bite of upper and lower jaw 

  Triple Tray® impression of upper and lower jaw 

  
Impression of upper and lower jaw 

  

Twin tray upper and lower jaw, 
with and without occlusion 

  
Additional scan and mesh combination 

 
 Correction scan 

 
 multiCase/multiDie 

 
 Calibration 

 

14.2 Menus and key combinations 

 �   

NumLock 

� 
 

 

Mesh processing  Add Scan Visualization  Service position 

Cut inside 
 

Single object Front 
 

— 

Cut outside 
 

Several objects Back 
 

 

Cut the surface 
 

Occlusion Left 
 

 

Save 
�  

Articulator Right 
 

 

Rescan 
 

 Top 
 

 

Trigger scan 
 

 Bottom 
 

 

Trigger scan sequence 
�  

 Points   

Undo  
Rescan, Cut �  

 Triangles   

Correction scan

dental Scan Software
   

Version: 3.4 10-2021 Error! Use the Home tab to apply Überschrift 1 to the text that you want to appear here.93 

Icons \Scans 

  
Wax-up of upper and lower jaw 

  
Situ of upper and lower jaw 

  
Scanbody in upper and lower jaw 

  
Gingiva of upper and lower jaw 

  
Squeeze bite of upper and lower jaw 

  Triple Tray® impression of upper and lower jaw 

  
Impression of upper and lower jaw 

  

Twin tray upper and lower jaw, 
with and without occlusion 

  
Additional scan and mesh combination 

 
 Correction scan 

 
 multiCase/multiDie 

 
 Calibration 

 

14.2 Menus and key combinations 

 �   

NumLock 

� 
 

 

Mesh processing  Add Scan Visualization  Service position 

Cut inside 
 

Single object Front 
 

— 

Cut outside 
 

Several objects Back 
 

 

Cut the surface 
 

Occlusion Left 
 

 

Save 
�  

Articulator Right 
 

 

Rescan 
 

 Top 
 

 

Trigger scan 
 

 Bottom 
 

 

Trigger scan sequence 
�  

 Points   

Undo  
Rescan, Cut �  

 Triangles   

multiCase/multiDie

dental Scan Software
   

Version: 3.4 10-2021 Error! Use the Home tab to apply Überschrift 1 to the text that you want to appear here.93 

Icons \Scans 

  
Wax-up of upper and lower jaw 

  
Situ of upper and lower jaw 

  
Scanbody in upper and lower jaw 

  
Gingiva of upper and lower jaw 

  
Squeeze bite of upper and lower jaw 

  Triple Tray® impression of upper and lower jaw 

  
Impression of upper and lower jaw 

  

Twin tray upper and lower jaw, 
with and without occlusion 

  
Additional scan and mesh combination 

 
 Correction scan 

 
 multiCase/multiDie 

 
 Calibration 

 

14.2 Menus and key combinations 

 �   

NumLock 

� 
 

 

Mesh processing  Add Scan Visualization  Service position 

Cut inside 
 

Single object Front 
 

— 

Cut outside 
 

Several objects Back 
 

 

Cut the surface 
 

Occlusion Left 
 

 

Save 
�  

Articulator Right 
 

 

Rescan 
 

 Top 
 

 

Trigger scan 
 

 Bottom 
 

 

Trigger scan sequence 
�  

 Points   

Undo  
Rescan, Cut �  

 Triangles   

Calibration



69

Aadva Scan

14.2	 Menus and key combinations
 

dental Scan Software
   

Version: 3.4 10-2021 Error! Use the Home tab to apply Überschrift 1 to the text that you want to appear here.93 

Icons \Scans 

  
Wax-up of upper and lower jaw 

  
Situ of upper and lower jaw 

  
Scanbody in upper and lower jaw 

  
Gingiva of upper and lower jaw 

  
Squeeze bite of upper and lower jaw 

  Triple Tray® impression of upper and lower jaw 

  
Impression of upper and lower jaw 

  

Twin tray upper and lower jaw, 
with and without occlusion 

  
Additional scan and mesh combination 

 
 Correction scan 

 
 multiCase/multiDie 

 
 Calibration 

 

14.2 Menus and key combinations 

 �   

NumLock 

� 
 

 

Mesh processing  Add Scan Visualization  Service position 

Cut inside 
 

Single object Front 
 

— 

Cut outside 
 

Several objects Back 
 

 

Cut the surface 
 

Occlusion Left 
 

 

Save 
�  

Articulator Right 
 

 

Rescan 
 

 Top 
 

 

Trigger scan 
 

 Bottom 
 

 

Trigger scan sequence 
�  

 Points   

Undo  
Rescan, Cut �  

 Triangles   

dental Scan Software
   

Version: 3.4 10-2021 Error! Use the Home tab to apply Überschrift 1 to the text that you want to appear here.93 

Icons \Scans 

  
Wax-up of upper and lower jaw 

  
Situ of upper and lower jaw 

  
Scanbody in upper and lower jaw 

  
Gingiva of upper and lower jaw 

  
Squeeze bite of upper and lower jaw 

  Triple Tray® impression of upper and lower jaw 

  
Impression of upper and lower jaw 

  

Twin tray upper and lower jaw, 
with and without occlusion 

  
Additional scan and mesh combination 

 
 Correction scan 

 
 multiCase/multiDie 

 
 Calibration 

 

14.2 Menus and key combinations 

 �   

NumLock 

� 
 

 

Mesh processing  Add Scan Visualization  Service position 

Cut inside 
 

Single object Front 
 

— 

Cut outside 
 

Several objects Back 
 

 

Cut the surface 
 

Occlusion Left 
 

 

Save 
�  

Articulator Right 
 

 

Rescan 
 

 Top 
 

 

Trigger scan 
 

 Bottom 
 

 

Trigger scan sequence 
�  

 Points   

Undo  
Rescan, Cut �  

 Triangles   

dental Scan Software
   

Version: 3.4 10-2021 Error! Use the Home tab to apply Überschrift 1 to the text that you want to appear here.93 

Icons \Scans 

  
Wax-up of upper and lower jaw 

  
Situ of upper and lower jaw 

  
Scanbody in upper and lower jaw 

  
Gingiva of upper and lower jaw 

  
Squeeze bite of upper and lower jaw 

  Triple Tray® impression of upper and lower jaw 

  
Impression of upper and lower jaw 

  

Twin tray upper and lower jaw, 
with and without occlusion 

  
Additional scan and mesh combination 

 
 Correction scan 

 
 multiCase/multiDie 

 
 Calibration 

 

14.2 Menus and key combinations 

 �   

NumLock 

� 
 

 

Mesh processing  Add Scan Visualization  Service position 

Cut inside 
 

Single object Front 
 

— 

Cut outside 
 

Several objects Back 
 

 

Cut the surface 
 

Occlusion Left 
 

 

Save 
�  

Articulator Right 
 

 

Rescan 
 

 Top 
 

 

Trigger scan 
 

 Bottom 
 

 

Trigger scan sequence 
�  

 Points   

Undo  
Rescan, Cut �  

 Triangles   

NumLock

dental Scan Software
   

Version: 3.4 10-2021 Error! Use the Home tab to apply Überschrift 1 to the text that you want to appear here.93 

Icons \Scans 

  
Wax-up of upper and lower jaw 

  
Situ of upper and lower jaw 

  
Scanbody in upper and lower jaw 

  
Gingiva of upper and lower jaw 

  
Squeeze bite of upper and lower jaw 

  Triple Tray® impression of upper and lower jaw 

  
Impression of upper and lower jaw 

  

Twin tray upper and lower jaw, 
with and without occlusion 

  
Additional scan and mesh combination 

 
 Correction scan 

 
 multiCase/multiDie 

 
 Calibration 

 

14.2 Menus and key combinations 

 �   

NumLock 

� 
 

 

Mesh processing  Add Scan Visualization  Service position 

Cut inside 
 

Single object Front 
 

— 

Cut outside 
 

Several objects Back 
 

 

Cut the surface 
 

Occlusion Left 
 

 

Save 
�  

Articulator Right 
 

 

Rescan 
 

 Top 
 

 

Trigger scan 
 

 Bottom 
 

 

Trigger scan sequence 
�  

 Points   

Undo  
Rescan, Cut �  

 Triangles   

Mesh processing Add Scan Visualization Service 
position

Cut inside

dental Scan Software
   

Version: 3.4 10-2021 Error! Use the Home tab to apply Überschrift 1 to the text that you want to appear here.93 

Icons \Scans 

  
Wax-up of upper and lower jaw 

  
Situ of upper and lower jaw 

  
Scanbody in upper and lower jaw 

  
Gingiva of upper and lower jaw 

  
Squeeze bite of upper and lower jaw 

  Triple Tray® impression of upper and lower jaw 

  
Impression of upper and lower jaw 

  

Twin tray upper and lower jaw, 
with and without occlusion 

  
Additional scan and mesh combination 

 
 Correction scan 

 
 multiCase/multiDie 

 
 Calibration 

 

14.2 Menus and key combinations 

 �   

NumLock 

� 
 

 

Mesh processing  Add Scan Visualization  Service position 

Cut inside 
 

Single object Front 
 

— 

Cut outside 
 

Several objects Back 
 

 

Cut the surface 
 

Occlusion Left 
 

 

Save 
�  

Articulator Right 
 

 

Rescan 
 

 Top 
 

 

Trigger scan 
 

 Bottom 
 

 

Trigger scan sequence 
�  

 Points   

Undo  
Rescan, Cut �  

 Triangles   

Single 
object

Front

dental Scan Software
   

Version: 3.4 10-2021 Error! Use the Home tab to apply Überschrift 1 to the text that you want to appear here.93 

Icons \Scans 

  
Wax-up of upper and lower jaw 

  
Situ of upper and lower jaw 

  
Scanbody in upper and lower jaw 

  
Gingiva of upper and lower jaw 

  
Squeeze bite of upper and lower jaw 

  Triple Tray® impression of upper and lower jaw 

  
Impression of upper and lower jaw 

  

Twin tray upper and lower jaw, 
with and without occlusion 

  
Additional scan and mesh combination 

 
 Correction scan 

 
 multiCase/multiDie 

 
 Calibration 

 

14.2 Menus and key combinations 

 �   

NumLock 

� 
 

 

Mesh processing  Add Scan Visualization  Service position 

Cut inside 
 

Single object Front 
 

— 

Cut outside 
 

Several objects Back 
 

 

Cut the surface 
 

Occlusion Left 
 

 

Save 
�  

Articulator Right 
 

 

Rescan 
 

 Top 
 

 

Trigger scan 
 

 Bottom 
 

 

Trigger scan sequence 
�  

 Points   

Undo  
Rescan, Cut �  

 Triangles   

—

Cut outside

dental Scan Software
   

Version: 3.4 10-2021 Error! Use the Home tab to apply Überschrift 1 to the text that you want to appear here.93 

Icons \Scans 

  
Wax-up of upper and lower jaw 

  
Situ of upper and lower jaw 

  
Scanbody in upper and lower jaw 

  
Gingiva of upper and lower jaw 

  
Squeeze bite of upper and lower jaw 

  Triple Tray® impression of upper and lower jaw 

  
Impression of upper and lower jaw 

  

Twin tray upper and lower jaw, 
with and without occlusion 

  
Additional scan and mesh combination 

 
 Correction scan 

 
 multiCase/multiDie 

 
 Calibration 

 

14.2 Menus and key combinations 

 �   

NumLock 

� 
 

 

Mesh processing  Add Scan Visualization  Service position 

Cut inside 
 

Single object Front 
 

— 

Cut outside 
 

Several objects Back 
 

 

Cut the surface 
 

Occlusion Left 
 

 

Save 
�  

Articulator Right 
 

 

Rescan 
 

 Top 
 

 

Trigger scan 
 

 Bottom 
 

 

Trigger scan sequence 
�  

 Points   

Undo  
Rescan, Cut �  

 Triangles   

Several 
objects

Back

dental Scan Software
   

Version: 3.4 10-2021 Error! Use the Home tab to apply Überschrift 1 to the text that you want to appear here.93 

Icons \Scans 

  
Wax-up of upper and lower jaw 

  
Situ of upper and lower jaw 

  
Scanbody in upper and lower jaw 

  
Gingiva of upper and lower jaw 

  
Squeeze bite of upper and lower jaw 

  Triple Tray® impression of upper and lower jaw 

  
Impression of upper and lower jaw 

  

Twin tray upper and lower jaw, 
with and without occlusion 

  
Additional scan and mesh combination 

 
 Correction scan 

 
 multiCase/multiDie 

 
 Calibration 

 

14.2 Menus and key combinations 

 �   

NumLock 

� 
 

 

Mesh processing  Add Scan Visualization  Service position 

Cut inside 
 

Single object Front 
 

— 

Cut outside 
 

Several objects Back 
 

 

Cut the surface 
 

Occlusion Left 
 

 

Save 
�  

Articulator Right 
 

 

Rescan 
 

 Top 
 

 

Trigger scan 
 

 Bottom 
 

 

Trigger scan sequence 
�  

 Points   

Undo  
Rescan, Cut �  

 Triangles   

 Cut the surface

dental Scan Software
   

Version: 3.4 10-2021 Error! Use the Home tab to apply Überschrift 1 to the text that you want to appear here.93 

Icons \Scans 

  
Wax-up of upper and lower jaw 

  
Situ of upper and lower jaw 

  
Scanbody in upper and lower jaw 

  
Gingiva of upper and lower jaw 

  
Squeeze bite of upper and lower jaw 

  Triple Tray® impression of upper and lower jaw 

  
Impression of upper and lower jaw 

  

Twin tray upper and lower jaw, 
with and without occlusion 

  
Additional scan and mesh combination 

 
 Correction scan 

 
 multiCase/multiDie 

 
 Calibration 

 

14.2 Menus and key combinations 

 �   

NumLock 

� 
 

 

Mesh processing  Add Scan Visualization  Service position 

Cut inside 
 

Single object Front 
 

— 

Cut outside 
 

Several objects Back 
 

 

Cut the surface 
 

Occlusion Left 
 

 

Save 
�  

Articulator Right 
 

 

Rescan 
 

 Top 
 

 

Trigger scan 
 

 Bottom 
 

 

Trigger scan sequence 
�  

 Points   

Undo  
Rescan, Cut �  

 Triangles   

Occlusion Left

dental Scan Software
   

Version: 3.4 10-2021 Error! Use the Home tab to apply Überschrift 1 to the text that you want to appear here.93 

Icons \Scans 

  
Wax-up of upper and lower jaw 

  
Situ of upper and lower jaw 

  
Scanbody in upper and lower jaw 

  
Gingiva of upper and lower jaw 

  
Squeeze bite of upper and lower jaw 

  Triple Tray® impression of upper and lower jaw 

  
Impression of upper and lower jaw 

  

Twin tray upper and lower jaw, 
with and without occlusion 

  
Additional scan and mesh combination 

 
 Correction scan 

 
 multiCase/multiDie 

 
 Calibration 

 

14.2 Menus and key combinations 

 �   

NumLock 

� 
 

 

Mesh processing  Add Scan Visualization  Service position 

Cut inside 
 

Single object Front 
 

— 

Cut outside 
 

Several objects Back 
 

 

Cut the surface 
 

Occlusion Left 
 

 

Save 
�  

Articulator Right 
 

 

Rescan 
 

 Top 
 

 

Trigger scan 
 

 Bottom 
 

 

Trigger scan sequence 
�  

 Points   

Undo  
Rescan, Cut �  

 Triangles   

Save

dental Scan Software
   

Version: 3.4 10-2021 Error! Use the Home tab to apply Überschrift 1 to the text that you want to appear here.93 

Icons \Scans 

  
Wax-up of upper and lower jaw 

  
Situ of upper and lower jaw 

  
Scanbody in upper and lower jaw 

  
Gingiva of upper and lower jaw 

  
Squeeze bite of upper and lower jaw 

  Triple Tray® impression of upper and lower jaw 

  
Impression of upper and lower jaw 

  

Twin tray upper and lower jaw, 
with and without occlusion 

  
Additional scan and mesh combination 

 
 Correction scan 

 
 multiCase/multiDie 

 
 Calibration 

 

14.2 Menus and key combinations 

 �   

NumLock 

� 
 

 

Mesh processing  Add Scan Visualization  Service position 

Cut inside 
 

Single object Front 
 

— 

Cut outside 
 

Several objects Back 
 

 

Cut the surface 
 

Occlusion Left 
 

 

Save 
�  

Articulator Right 
 

 

Rescan 
 

 Top 
 

 

Trigger scan 
 

 Bottom 
 

 

Trigger scan sequence 
�  

 Points   

Undo  
Rescan, Cut �  

 Triangles   

 Articulator Right

dental Scan Software
   

Version: 3.4 10-2021 Error! Use the Home tab to apply Überschrift 1 to the text that you want to appear here.93 

Icons \Scans 

  
Wax-up of upper and lower jaw 

  
Situ of upper and lower jaw 

  
Scanbody in upper and lower jaw 

  
Gingiva of upper and lower jaw 

  
Squeeze bite of upper and lower jaw 

  Triple Tray® impression of upper and lower jaw 

  
Impression of upper and lower jaw 

  

Twin tray upper and lower jaw, 
with and without occlusion 

  
Additional scan and mesh combination 

 
 Correction scan 

 
 multiCase/multiDie 

 
 Calibration 

 

14.2 Menus and key combinations 

 �   

NumLock 

� 
 

 

Mesh processing  Add Scan Visualization  Service position 

Cut inside 
 

Single object Front 
 

— 

Cut outside 
 

Several objects Back 
 

 

Cut the surface 
 

Occlusion Left 
 

 

Save 
�  

Articulator Right 
 

 

Rescan 
 

 Top 
 

 

Trigger scan 
 

 Bottom 
 

 

Trigger scan sequence 
�  

 Points   

Undo  
Rescan, Cut �  

 Triangles   

Rescan

dental Scan Software
   

Version: 3.4 10-2021 Error! Use the Home tab to apply Überschrift 1 to the text that you want to appear here.93 

Icons \Scans 

  
Wax-up of upper and lower jaw 

  
Situ of upper and lower jaw 

  
Scanbody in upper and lower jaw 

  
Gingiva of upper and lower jaw 

  
Squeeze bite of upper and lower jaw 

  Triple Tray® impression of upper and lower jaw 

  
Impression of upper and lower jaw 

  

Twin tray upper and lower jaw, 
with and without occlusion 

  
Additional scan and mesh combination 

 
 Correction scan 

 
 multiCase/multiDie 

 
 Calibration 

 

14.2 Menus and key combinations 

 �   

NumLock 

� 
 

 

Mesh processing  Add Scan Visualization  Service position 

Cut inside 
 

Single object Front 
 

— 

Cut outside 
 

Several objects Back 
 

 

Cut the surface 
 

Occlusion Left 
 

 

Save 
�  

Articulator Right 
 

 

Rescan 
 

 Top 
 

 

Trigger scan 
 

 Bottom 
 

 

Trigger scan sequence 
�  

 Points   

Undo  
Rescan, Cut �  

 Triangles   

Top

dental Scan Software
   

Version: 3.4 10-2021 Error! Use the Home tab to apply Überschrift 1 to the text that you want to appear here.93 

Icons \Scans 

  
Wax-up of upper and lower jaw 

  
Situ of upper and lower jaw 

  
Scanbody in upper and lower jaw 

  
Gingiva of upper and lower jaw 

  
Squeeze bite of upper and lower jaw 

  Triple Tray® impression of upper and lower jaw 

  
Impression of upper and lower jaw 

  

Twin tray upper and lower jaw, 
with and without occlusion 

  
Additional scan and mesh combination 

 
 Correction scan 

 
 multiCase/multiDie 

 
 Calibration 

 

14.2 Menus and key combinations 

 �   

NumLock 

� 
 

 

Mesh processing  Add Scan Visualization  Service position 

Cut inside 
 

Single object Front 
 

— 

Cut outside 
 

Several objects Back 
 

 

Cut the surface 
 

Occlusion Left 
 

 

Save 
�  

Articulator Right 
 

 

Rescan 
 

 Top 
 

 

Trigger scan 
 

 Bottom 
 

 

Trigger scan sequence 
�  

 Points   

Undo  
Rescan, Cut �  

 Triangles   

Trigger scan

dental Scan Software
   

Version: 3.4 10-2021 Error! Use the Home tab to apply Überschrift 1 to the text that you want to appear here.93 

Icons \Scans 

  
Wax-up of upper and lower jaw 

  
Situ of upper and lower jaw 

  
Scanbody in upper and lower jaw 

  
Gingiva of upper and lower jaw 

  
Squeeze bite of upper and lower jaw 

  Triple Tray® impression of upper and lower jaw 

  
Impression of upper and lower jaw 

  

Twin tray upper and lower jaw, 
with and without occlusion 

  
Additional scan and mesh combination 

 
 Correction scan 

 
 multiCase/multiDie 

 
 Calibration 

 

14.2 Menus and key combinations 

 �   

NumLock 

� 
 

 

Mesh processing  Add Scan Visualization  Service position 

Cut inside 
 

Single object Front 
 

— 

Cut outside 
 

Several objects Back 
 

 

Cut the surface 
 

Occlusion Left 
 

 

Save 
�  

Articulator Right 
 

 

Rescan 
 

 Top 
 

 

Trigger scan 
 

 Bottom 
 

 

Trigger scan sequence 
�  

 Points   

Undo  
Rescan, Cut �  

 Triangles   

Bottom

dental Scan Software
   

Version: 3.4 10-2021 Error! Use the Home tab to apply Überschrift 1 to the text that you want to appear here.93 

Icons \Scans 

  
Wax-up of upper and lower jaw 

  
Situ of upper and lower jaw 

  
Scanbody in upper and lower jaw 

  
Gingiva of upper and lower jaw 

  
Squeeze bite of upper and lower jaw 

  Triple Tray® impression of upper and lower jaw 

  
Impression of upper and lower jaw 

  

Twin tray upper and lower jaw, 
with and without occlusion 

  
Additional scan and mesh combination 

 
 Correction scan 

 
 multiCase/multiDie 

 
 Calibration 

 

14.2 Menus and key combinations 

 �   

NumLock 

� 
 

 

Mesh processing  Add Scan Visualization  Service position 

Cut inside 
 

Single object Front 
 

— 

Cut outside 
 

Several objects Back 
 

 

Cut the surface 
 

Occlusion Left 
 

 

Save 
�  

Articulator Right 
 

 

Rescan 
 

 Top 
 

 

Trigger scan 
 

 Bottom 
 

 

Trigger scan sequence 
�  

 Points   

Undo  
Rescan, Cut �  

 Triangles   

Trigger scan sequence

dental Scan Software
   

Version: 3.4 10-2021 Error! Use the Home tab to apply Überschrift 1 to the text that you want to appear here.93 

Icons \Scans 

  
Wax-up of upper and lower jaw 

  
Situ of upper and lower jaw 

  
Scanbody in upper and lower jaw 

  
Gingiva of upper and lower jaw 

  
Squeeze bite of upper and lower jaw 

  Triple Tray® impression of upper and lower jaw 

  
Impression of upper and lower jaw 

  

Twin tray upper and lower jaw, 
with and without occlusion 

  
Additional scan and mesh combination 

 
 Correction scan 

 
 multiCase/multiDie 

 
 Calibration 

 

14.2 Menus and key combinations 

 �   

NumLock 

� 
 

 

Mesh processing  Add Scan Visualization  Service position 

Cut inside 
 

Single object Front 
 

— 

Cut outside 
 

Several objects Back 
 

 

Cut the surface 
 

Occlusion Left 
 

 

Save 
�  

Articulator Right 
 

 

Rescan 
 

 Top 
 

 

Trigger scan 
 

 Bottom 
 

 

Trigger scan sequence 
�  

 Points   

Undo  
Rescan, Cut �  

 Triangles   Undo

dental Scan Software
   

Version: 3.4 10-2021 Error! Use the Home tab to apply Überschrift 1 to the text that you want to appear here.93 

Icons \Scans 

  
Wax-up of upper and lower jaw 

  
Situ of upper and lower jaw 

  
Scanbody in upper and lower jaw 

  
Gingiva of upper and lower jaw 

  
Squeeze bite of upper and lower jaw 

  Triple Tray® impression of upper and lower jaw 

  
Impression of upper and lower jaw 

  

Twin tray upper and lower jaw, 
with and without occlusion 

  
Additional scan and mesh combination 

 
 Correction scan 

 
 multiCase/multiDie 

 
 Calibration 

 

14.2 Menus and key combinations 

 �   

NumLock 

� 
 

 

Mesh processing  Add Scan Visualization  Service position 

Cut inside 
 

Single object Front 
 

— 

Cut outside 
 

Several objects Back 
 

 

Cut the surface 
 

Occlusion Left 
 

 

Save 
�  

Articulator Right 
 

 

Rescan 
 

 Top 
 

 

Trigger scan 
 

 Bottom 
 

 

Trigger scan sequence 
�  

 Points   

Undo  
Rescan, Cut �  

 Triangles    Points

Rescan, Cut Triangles

Correction scan Gouraud shading

Close holes  X Y Z

Combine mesh All axes

Delete matching

dental Scan Software
   

Version: 3.4 10-2021 Error! Use the Home tab to apply Überschrift 1 to the text that you want to appear here.94 

Correction scan   Gouraud shading   

Close holes   X Y Z   

Combine mesh   All axes   

Delete matching      
 

   

Project Extras Settings 

New project 
Load project 
Save project as 
Close project 

Calibration 
Add an activation code 
Delete old PCM data 
Info 

 

 

 

14.3 Glossary 

Definition of important terms 

Activation Code Code to activate: 
¾ a chargeable module, 
¾ a free upgrade period (up to 3.4.2). 

Work folder Folder in which scan projects are saved. 

Export data 3D data generated from the scan data. Basis for 
the CAD software, open file format (PLY, optionally 
STL) for many applications. 

IndepenDent mode Any desired order of the scans in a project. 

Calibration data Data to perform the calibration of a scanner 
(specific). The sensor number of the scanner 
(� type plate/sticker) matches the name of the 
calibration data folder (e.g. SO-20242.01-13-062). 

Calibration A metrological term: 
¾ Alignment of the scanner to the values of an 

industrially calibrated model. 
¾ Alignment of the motion axes based on the 

individual calibration data. 

Matching Calculation that generates a data set in PLY or STL 
format (3D model data set) based on individual 
images and measured values (scan data). 

Scan Measurement in 3D, based on individual images 
(PCMs), converted into a 3D model data set by 
means of matching. 

Project
New project
Load project
Save project as
Close project
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14.3	 Glossary

Definition of important terms
Activation Code Code to activate:

	 a chargeable module,
	 a free upgrade period (up to 3.4.2).

Work folder Folder in which scan projects are saved.
Export data 3D data generated from the scan data. Basis for the CAD 

software, open file format (PLY, optionally STL) for many 
applications.

IndepenDent mode Any desired order of the scans in a project.
Calibration data Data to perform the calibration of a scanner (specific). The 

sensor number of the scanner ( type plate/sticker) matches 
the name of the calibration data folder (e.g. SO-20242.01-13-
062).

Calibration A metrological term:
	 Alignment of the scanner to the values of an industrially 

calibrated model.
	 Alignment of the motion axes based on the individual 

calibration data.
Matching Calculation that generates a data set in PLY or STL format (3D 

model data set) based on individual images and measured 
values (scan data).

Scan Measurement in 3D, based on individual images (PCMs), 
converted into a 3D model data set by means of matching.

Scan object Object to be scanned:
Universal object (item), dental model or dental impression.

Vestibular scan Scan of jaw models in occlusion.
	 Its purpose is to align the upper and lower jaw scans.
	 It is the basis of an anatomically correct reconstruction in 

the CAD system.

14.4	 File Paths
How to find protected Windows folders using a placeholder

	 Replace unknown parts of a path with %. 
The search terms are independent of the Windows language:

%appdata%	 ª C:\Users\[Username]\AppData\Roaming
%programfiles%	 ª C:\Program Files
%programdata%	 ª C:\ProgramData

Default file paths
Folder Path

Target folder 
(setup)

C:\Program Files\3D-Scanner\Aadva Scan

Work folder 
(standalone)

C:\Users\[Username]\Documents\3D-Scanner\Work\[YYYY]

Work folder 
(with exocad® v.2.3 Matera or higher)

C:\CAD-Data

Calibration data C:\ProgramData\3D-Scanner\DeviceCharacteristics\Sensors

User settings, log files C:\Users\[Username]\AppData\Local\3D-Scanner
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Aadva Scan

	 Manufacturer
GC Sensortechnik GmbH
Lise-Meitner-Allee 10
D-44801 Bochum, Germany

www.smartoptics.de
#smartOptics 
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Technical  
Specifications
Measurement field ( X × Y × Z ) mm
85,2 × 58,1 × 82
5MP Camera 
4 µm Accuracy according to ISO 12836
Sensor technology
Stripe light triangulation 
Blue-light LED
Monochrome texture scan
Colour texture scan
Touchscreen
Fully automated Z-axis
Articulator scan
Multi die scan 
TripleTray scan 
Impression scan

Recommended computer specifications  
ALS 2 and Aadva Scan:

Windows 10 or 11 64-bit
i7 with 6× 4.7 GHz
32 GB RAM
USB 3.0 Port
100 – 250 GB SSD
Graphics card with 6 GB RAM

GC EUROPE N.V.

Head Office
Researchpark
Haasrode-Leuven 1240
Interleuvenlaan 33
B-3001 Leuven
Tel. +32.16.74.10.00
Fax. +32.16.40.48.32
info.gce@gc.dental
www.gceurope.com

GC UNITED KINGDOM Ltd.

Coopers Court
Newport Pagnell
UK-Bucks. MK16 8JS
Tel. +44.1908.218.999
Fax. +44.1908.218.900
info.uk@gc.dental
uk.gceurope.com


